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CLP- 845
CLP-835
CLP-895GP
CLP-865GP

NL

Bedankt dat u deze Yamaha digitale piano hebt gekocht!

Met dit instrument kunt u genieten van bijzonder goede geluidskwaliteit en extra controle voor meer 
speelplezier. Haal alles uit de prestaties en functies van Clavinova door deze gebruikershandleiding 
grondig door te lezen en veilig op te bergen om later opnieuw te raadplegen.
Lees het gedeelte 'VOORZICHTIG' op pagina 4−5 voordat u het instrument gebruikt.

Raadpleeg de instructies op pagina 63 voor informatie over hoe u het instrument installeert.
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Het modelnummer, het serienummer, de stroomvereisten, enz. 
worden vermeld op of in de nabijheid van het naamplaatje, dat zich 
aan de onderzijde van het toestel bevindt. Het is raadzaam dit 
serienummer in de hieronder gereserveerde ruimte te noteren. 
Bewaar ook deze handleiding als permanent aankoopbewijs om 
identificatie in geval van diefstal te vergemakkelijken.

Modelnummer

Serienummer

(1003-M06 plate bottom nl 01)

Informatie over ophalen en weggooien van oude apparatuur
Dit symbool op de apparaten, verpakking en/of meegeleverde documenten betekent dat gebruikte 
elektrische en elektronische apparaten niet met het gewone huishoudelijke afval mogen worden 
gemengd.
Voor juist behandelen, hergebruik of recyclen van oude apparatuur brengt u deze naar de 
desbetreffende ophaalpunten in overeenstemming met de nationale wetgeving.

Door deze apparatuur op de juiste manier weg te gooien, helpt u waardevolle bronnen te sparen en 
mogelijk negatieve effecten op de gezondheid van de mens en op het milieu te voorkomen, die het 
gevolg kunnen zijn van niet-aangepaste afvalverwerking.

Voor meer informatie over ophalen en recyclen van oude apparatuur neemt u contact op met de 
lokale overheid, uw afvalophaalmaatschappij of het verkooppunt waar u de items hebt gekocht. 

Voor zakelijke gebruikers in de Europese Unie:
Als u elektrische en elektronische apparatuur wilt weggooien, neemt u voor meer informatie contact 
op met uw dealer of leverancier.

Informatie over weggooien in landen buiten de Europese Unie:
Dit symbool is alleen geldig in de Europese Unie. Als u deze items wilt weggooien, neemt u contact 
op met de lokale overheid of een lokale dealer en vraagt u om instructies voor het correct weggooien.

(58-M02 WEEE nl 01) 

Het naamplaatje bevindt zich aan 
de onderkant van het product.
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LEES DIT ZORGVULDIG DOOR 
VOORDAT U VERDERGAAT
Vooral in het geval van kinderen moet een begeleider 
vóór het eigenlijke gebruik aanwijzingen geven voor 
het juiste gebruik en hanteren van het product.
Bewaar deze gebruikershandleiding op een veilige 
en handige plaats voor eventuele toekomstige 
raadpleging.

 WAARSCHUWING
Volg altijd de hierna vermelde algemene 
voorzorgsmaatregelen op om ernstig of zelfs dodelijk 
letsel als gevolg van elektrische schokken, kortsluiting, 
beschadiging, brand of andere gevaren te voorkomen. 
Deze voorzorgsmaatregelen houden in, maar zijn niet 
beperkt tot:

Spanningsvoorziening

• Plaats het netsnoer niet in de buurt van warmtebronnen 
zoals verwarming en kachels. Verbuig of beschadig het 
snoer ook niet en plaats geen zware voorwerpen op 
het snoer. 

• Raak het product of de stekker niet aan tijdens onweer. 
• Gebruik het product uitsluitend op de voorgeschreven 

elektrische spanning. De vereiste spanning wordt vermeld 
op het naamplaatje van het product. 

• Gebruik alleen de meegeleverde of aangegeven netadapter 
(pagina 79, 82) / het meegeleverde of aangegeven /
netsnoer. Gebruik de netadapter/het netsnoer niet voor 
andere apparaten. 

• Controleer de stekker regelmatig en verwijder vuil of stof 
dat zich erop heeft verzameld.

• Steek de stekker stevig helemaal in het stopcontact. Als 
u het product gebruikt wanneer de stekker niet voldoende 
in het stopcontact is gestoken, kan er stof op de stekker 
ophopen, met mogelijk brand of brandwonden tot gevolg.

• Let tijdens het opstellen van het instrument op dat het te 
gebruiken stopcontact gemakkelijk bereikbaar is. Als er een 
storing optreedt of het instrument niet correct werkt, 
schakelt u de POWER-schakelaar onmiddellijk uit en 
verwijdert u de stekker uit het stopcontact. Zelfs als de 
aan/uit-schakelaar is uitgeschakeld, wordt het product niet 
losgekoppeld van de stroombron zolang het netsnoer niet 
uit het stopcontact is gehaald. 

• Sluit het product niet via een stekkerdoos aan op het 
stopcontact. Dit kan leiden tot een verminderde 
geluidskwaliteit of oververhitting in het stopcontact.

• Houd als u de stekker uit het stopcontact haalt altijd de 
stekker zelf vast en niet het snoer. Trekken aan het snoer 
kan het beschadigen en elektrische schokken of brand 
veroorzaken.

• Trek de stekker uit het stopcontact als u het product 
gedurende langere tijd niet gebruikt.

Niet uit elkaar halen

• Dit product bevat geen door de gebruiker te repareren 
onderdelen. Probeer de interne onderdelen niet uit 
elkaar te halen of op enigerlei wijze te wijzigen.

Waarschuwing voor water

• Stel het product niet bloot aan regen en gebruik het niet 
in de buurt van water of in een vochtige omgeving. Plaats 
nooit voorwerpen (zoals vazen, flessen of glazen) die 
vloeistof bevatten op het product en plaats het niet ergens 
waar er water op kan vallen. Een vloeistof zoals water die 
in het product komt, kan brand, elektrische schokken of 
storingen veroorzaken. 

• Gebruik de netadapter alleen binnenshuis. Niet gebruiken 
in vochtige omgevingen. 

• Steek/verwijder nooit een stekker in/uit het stopcontact als 
u natte handen hebt. 

Waarschuwing voor brand

• Plaats geen brandende voorwerpen of open vuur in de 
buurt van het product, aangezien deze brand kunnen 
veroorzaken. 

Draadloze eenheid

• Radiogolven van dit product kunnen elektromedische 
apparaten, zoals een geïmplanteerde pacemaker of 
geïmplanteerde defibrillator, beïnvloeden. 
- Gebruik het product niet in de buurt van medische 

apparatuur of in medische instellingen. Radiogolven van 
dit product kunnen elektronische medische apparatuur 
beïnvloeden. 

- Gebruik het product niet binnen een afstand van 15 cm 
van personen met een geïmplanteerde pacemaker of 
geïmplanteerde defibrillator. 

Aansluitingen

• Lees de handleiding van het aan te sluiten apparaat en volg 
de instructies. Als u zich hier niet aan houdt, kan dit leiden 
tot brand, oververhitting, explosie of storing. 

De kruk gebruiken (indien meegeleverd)

• Plaats de kruk niet in een onstabiele positie waarin het per 
ongeluk kan omvallen. 

• Ga niet onzorgvuldig om met de kruk en ga nooit op de 
kruk staan. Gebruik van de kruk als opstapje of voor enig 
ander onjuist doel kan leiden tot ongevallen en letsel. 

• Ter voorkoming van ongevallen en letsel mag er slechts 
één persoon tegelijk op de kruk zitten. 

• De schroeven van de kruk kunnen losraken door langdurig 
gebruik. Draai ze daarom regelmatig aan met het 
meegeleverde gereedschap om schade of ongelukken te 
voorkomen.

• Let goed op kleine kinderen, zodat ze niet achterover van 
de kruk vallen. De kruk heeft geen rugleuning, dus gebruik 
zonder toezicht kan ongelukken of letsel tot gevolg hebben. 

VOORZICHTIG
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Als u een defect opmerkt

• Als een van de volgende storingen optreedt, schakelt u de 
aan/uit-schakelaar onmiddellijk uit en haalt u de stekker uit 
het stopcontact. 
Laat het instrument ten slotte nakijken door bevoegd 
Yamaha-servicepersoneel. 
- Het netsnoer of de stekker raakt versleten of beschadigd.
- Het product verspreidt een ongebruikelijke geur of er 

komt rook uit het product.
- Er is een voorwerp of water in het product gevallen.
- Het geluid valt plotseling weg tijdens het gebruik van 

het product.
- Het product vertoont barsten of andere zichtbare schade.

 VOORZICHTIG
Volg altijd de hierna vermelde algemene 
voorzorgsmaatregelen op om lichamelijk letsel bij uzelf 
en anderen of beschadiging van het product en andere 
eigendommen te voorkomen. Deze voorzorgsmaatregelen 
houden in, maar zijn niet beperkt tot:

Montage

• Monteer het product in de juiste volgorde door de 
montage-instructies in deze handleiding te volgen. Zorg 
ook dat u de schroeven regelmatig vastdraait. Als u dat niet 
doet, kan het product beschadigd raken of kan persoonlijk 
letsel worden veroorzaakt.

Locatie

• Plaats het product niet in een onstabiele positie of op een 
locatie met overmatige trillingen, waar het per ongeluk kan 
omvallen en letsel kan veroorzaken. 

• Zorg dat u tijdens een aardbeving niet in de buurt van het 
product bent. Door hevige schokken tijdens een aardbeving 
kan het product verschuiven of omvallen, wat tot 
beschadiging van het product of onderdelen ervan kan 
leiden en mogelijk persoonlijk letsel kan veroorzaken. 

• (CLP-885, CLP-875, CLP-845, CLP-835) Transporteer of 
verplaats het product altijd met twee of meer personen. Als 
u probeert het product alleen op te tillen kan dat letsel, 
bijvoorbeeld rugletsel, veroorzaken of kan het product 
vallen en kapot gaan, wat kan leiden tot ander letsel.

• (CLP-895GP, CLP-865GP) Omdat dit product erg zwaar is, 
moet u ervoor zorgen dat er voldoende mensen bij de hand 
zijn om te helpen, zodat u het veilig en gemakkelijk kunt 
optillen en verplaatsen. Pogingen om het instrument met 
veel kracht op te tillen of te verplaatsen kunnen leiden tot 
rugletsel, ander letsel of schade aan het instrument zelf.

• Verwijder voordat u het product verplaatst alle aangesloten 
snoeren, om beschadiging van de snoeren en letsel bij 
personen die erover zouden kunnen struikelen te 
voorkomen. 

Aansluitingen

• Voordat u het product aansluit op andere elektronische 
componenten, moet u alle betreffende apparatuur 
uitschakelen. Stel alle volumeniveaus in op het laagste 
niveau voordat u de stroomtoevoer naar alle apparaten 
in- of uitschakelt.

• Zorg dat het volume van alle apparaten is ingesteld op het 
laagste niveau en voer het volume tijdens het bespelen van 
het product geleidelijk op tot het gewenste niveau. 

Hanteren

• Steek uw vingers of handen niet in de openingen van de 
toetsenklep of het product. Let er ook op dat uw vingers 
niet bekneld raken onder de toetsenklep. 

• Steek geen vreemde materialen zoals metaal of papier in 
openingen of gaten van het product. Als u zich hier niet aan 
houdt, kan dit leiden tot elektrische schokken of storingen. 

• (CLP-885) Oefen geen grote druk uit bij het sluiten van de 
toetsenklep. Het SOFT-CLOSE™-mechanisme zorgt 
ervoor dat de toetsenklep langzaam wordt gesloten. 
Als u grote druk uitoefent bij het sluiten van de toetsenklep, 
kan het SOFT-CLOSE™-mechanisme beschadigd raken 
en kunt u uw handen en vingers bezeren doordat ze onder 
de toetsenklep terecht komen. 

• Leun niet op het product, plaats er geen zware voorwerpen 
op en ga voorzichtig om met de knoppen, schakelaars en 
aansluitingen. 

• Houd kleine onderdelen buiten het bereik van kleine 
kinderen. Uw kinderen kunnen ze per ongeluk inslikken. 

• Gebruik het product of een hoofdtelefoon niet te lang op 
een hoog of oncomfortabel geluidsniveau, aangezien dit 
blijvend gehoorverlies kan veroorzaken. Consulteer een 
KNO-arts als u ruis in uw oren of gehoorverlies constateert. 

• Haal de stekker uit het stopcontact voordat u het apparaat 
reinigt. Als u dat niet doet, kan dat elektrische schokken 
veroorzaken. 

De kruk gebruiken (indien meegeleverd)

• Probeer bij verstelbare krukken niet de hoogte van de kruk 
aan te passen terwijl u er op zit, aangezien er hierdoor 
buitensporige krachten op het aanpassingsmechanisme 
worden uitgeoefend, wat mogelijk kan resulteren in 
beschadiging van het mechanisme of zelfs verwonding. 

• Steek uw hand niet tussen bewegende onderdelen. Uw 
hand kan anders klem komen te zitten tussen de 
onderdelen, wat letsel kan veroorzaken. 

Schakel het instrument altijd uit als u het niet gebruikt. 
Zelfs als de schakelaar [ ] (Standby/On) op stand-by staat 
(aan/uit-lampje is uit), loopt er nog een minimale hoeveelheid 
stroom door het product.
Verwijder de stekker uit het stopcontact als u het product 
gedurende langere tijd niet gebruikt.

(DMI-11)

Yamaha is niet aansprakelijk voor ontstane schade door 
oneigenlijk gebruik of modificatie van het product, noch 
voor verlies of beschadiging van gegevens.
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LET OP
Houd u aan onderstaande waarschuwingen om 
storingen/schade aan het apparaat en schade aan de 
gegevens of andere eigendommen te voorkomen.

 Hanteren
• Verbind dit product niet direct met een openbare 

wifi- en/of internetdienst. Verbind dit product alleen via 
een sterk beveiligde router met het internet. Raadpleeg 
de producent van de router voor informatie over 
optimale beveiligingsmaatregelen. 

• Gebruik dit product niet in de nabijheid van een tv, 
radio, stereoapparatuur, mobiele telefoon of andere 
elektrische apparaten. Anders kan dit product of het 
andere apparaat bijgeluiden veroorzaken. 

• Als u het product samen met een app op uw 
smartapparaat zoals een smartphone of tablet gebruikt, 
adviseren we u om de 'vliegtuigmodus' op dat apparaat 
in te schakelen, om bijgeluiden als gevolg van 
communicatie te vermijden. Als u een smartapparaat 
draadloos verbindt met dit product, moet u ervoor 
zorgen dat de wifi- of Bluetooth®-instelling op het 
apparaat is ingeschakeld.

• Stel het product niet bloot aan grote hoeveelheden 
stof of trillingen of aan extreme koude of hitte 
(zoals in direct zonlicht, bij een verwarming of overdag 
in een auto), om eventuele vervorming, beschadiging 
van de interne componenten of instabiele werking te 
voorkomen. (Gecontroleerd bedrijfstemperatuurbereik: 
5° C – 40 °C of 41 °F – 104 °F.)

• Plaats geen vinyl, plastic of rubberen voorwerpen op 
het product, aangezien dit verkleuring van het product 
tot gevolg kan hebben.

• In het geval van een model met een gepolijste 
afwerking, kan de afwerking gaan barsten of schilferen 
wanneer het oppervlak van het product tegen metaal, 
porselein of andere harde voorwerpen stoot. Wees 
voorzichtig.

 Onderhoud
• Gebruik bij het schoonmaken van het product een 

zachte en droge of licht bevochtigde doek. Gebruik 
geen verfverdunners, oplosmiddelen, alcohol, 
schoonmaakmiddelen of met chemicaliën 
geïmpregneerde schoonmaakdoekjes.

• Verwijder stof en vuil voorzichtig met een zachte 
doek, in het geval van een model met een gepolijste 
afwerking. Wrijf niet te hard, aangezien ook kleine 
vuildeeltjes krassen kunnen veroorzaken in de 
afwerking van het instrument.

• Bij extreme veranderingen in temperatuur of vochtigheid 
kan condensatie ontstaan en kan zich water verzamelen 
op het oppervlak van het product. Als er water 
achterblijft, kan het worden geabsorbeerd door houten 
onderdelen, die daardoor beschadigd kunnen raken. 
Veeg water altijd onmiddellijk weg met een zachte doek.

 Data opslaan
• Een opgenomen song gaat verloren als u het product 

uitschakelt zonder de gegevens op te slaan. Dit gebeurt 
ook wanneer de stroom wordt uitgeschakeld door de 
functie Automatisch uitschakelen (pagina 17). Sla de 
gegevens op in het product of op een USB-stick 
(pagina 38). 

• Enkele van de instellingsgegevens van dit product 
blijven behouden wanneer de stroom wordt 
uitgeschakeld. U kunt een back-up maken van de 
instellingen op een USB-stick als een back-upbestand, 
maar u kunt ze ook terugzetten op het product. 
Raadpleeg de naslaggids voor meer informatie.

• De data die op het product zijn opgeslagen, kunnen 
verloren gaan door een storing, een foutieve bediening 
enz. Sla belangrijke data op een USB-stick of een 
extern apparaat, zoals een computer, op. 

• Lees pagina 49 voordat u een USB-stick gebruikt. Om 
te voorkomen dat u data kwijtraakt als gevolg van een 
beschadigd USB-stick, adviseren wij u een back-up van 
belangrijke data op te slaan op een extra USB-stick of 
een extern apparaat, bijvoorbeeld een computer.

 De USB [TO DEVICE]-aansluiting 
gebruiken

• Compatibele USB-apparaten voor de USB 
[TO DEVICE]-aansluiting van dit product zijn 
alleen een USB-stick of een draadloze 
USB-netwerkadapter (UD-WL01; afzonderlijk 
verkrijgbaar). Andere USB-apparaten, zoals een 
USB-hub of smartapparaat, kunnen niet worden 
gebruikt. Zorg dat u de juiste aansluiting op het 
apparaat gebruikt en het apparaat in de juiste richting 
aansluit als u een USB-apparaat aansluit. Gebruik 
geen verlengsnoer als u een USB-apparaat aansluit. 
Ga voor een lijst met compatibele USB-apparaten 
naar de onderstaande website van Yamaha:  
https://download.yamaha.com/

• De USB [TO DEVICE]-aansluiting heeft een maximaal 
nominaal vermogen van 5 V/500 mA. Sluit geen 
USB-apparaten met een hogere spanning op het 
instrument aan, want dat kan het instrument zelf 
beschadigen.

• Sluit het USB-apparaat niet aan en koppel het niet 
los tijdens afspelen/opnemen en bestandsbeheer 
(zoals opslaan, kopiëren en verwijderen) of wanneer 
het USB-apparaat wordt gebruikt. Anders kan het 
instrument 'blijven hangen' of kunnen het 
USB-apparaat en de data beschadigd raken.
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Informatie
 Auteursrechten
• Het auteursrecht van de 'inhoud'*1 die in dit product is 

geïnstalleerd, behoort toe aan Yamaha Corporation of de 
houder van het auteursrecht. Behalve zoals toegestaan 
door de auteursrechtwetgeving en andere relevante 
wetten, zoals kopiëren voor persoonlijk gebruik, is het 
verboden om te 'reproduceren of divergeren'*2 zonder 
toestemming van de houder van het auteursrecht. 
Raadpleeg een deskundige op het gebied van 
auteursrechten als u de inhoud wilt gebruiken.  
Als u muziek maakt of optreedt met de inhoud door 
het oorspronkelijke gebruik van het product en deze 
vervolgens opneemt en distribueert, is de toestemming 
van Yamaha Corporation niet vereist, ongeacht of de 
distributiemethode betaald of gratis is.
*1: Het woord 'inhoud' omvat een computerprogramma, 

geluidsdata, begeleidingsstijlgegevens, MIDI-data, 
golfvormdata, voice-opnamegegevens, bladmuziek en 
notatiegegevens enz.

*2: De uitdrukking 'reproduceren of divergeren' omvat het 
overnemen van de inhoud zelf in dit product, of het 
opnemen en verspreiden ervan zonder wijzigingen 
op een vergelijkbare manier.

 Functies/data die bij het product zijn 
meegeleverd

• Sommige vooraf ingestelde songs zijn ingekort of bewerkt 
en zijn daarom niet precies hetzelfde als het origineel.

• (CLP-885/ CLP-895GP) Dit product kan muziekdata van 
verschillende typen en indelingen gebruiken door deze van 
tevoren naar de juiste muziekdata-indeling voor gebruik 
met het instrument te optimaliseren. Hierdoor wordt op dit 
apparaat muziek mogelijk niet exact zo afgespeeld als de 
componist het oorspronkelijk heeft bedoeld.

• De in dit product gebruikte bitmapfonts zijn geleverd door 
en zijn eigendom van Ricoh Co., Ltd.

 Opensourcesoftware
• De firmware van dit product bevat opensourcesoftware. 

Ga voor informatie over auteursrechten en 
gebruiksvoorwaarden voor elke opensourcesoftware 
naar de onderstaande website van Yamaha:  
Yamaha Downloads: https://download.yamaha.com/

 Deze handleiding
• De afbeeldingen en lcd-schermen zoals in deze 

handleiding te zien zijn, zijn uitsluitend bedoeld voor 
instructiedoeleinden.

• Windows is een geregistreerd handelsmerk van Microsoft® 
Corporation in de Verenigde Staten en andere landen.

• wifi is een geregistreerd handelsmerk van wifi Alliance®.
• Het woordmerk en de logo's van Bluetooth® zijn 

gedeponeerde handelsmerken van Bluetooth SIG, Inc. en 
worden gebruikt door Yamaha Corporation overeenkomstig 
een licentieovereenkomst. 

• De namen van bedrijven en producten die in deze handleiding 
worden genoemd, zijn handelsmerken of gedeponeerde 
handelsmerken van hun respectieve eigenaars.

 Stemmen
• In tegenstelling tot een akoestische piano hoeft dit 

instrument niet te worden gestemd door een expert 
(hoewel de toonhoogte door de gebruiker kan worden 
aangepast zodat deze bij andere instrumenten past). 
De reden hiervoor is dat de toonhoogte van digitale 
instrumenten altijd perfect behouden blijft. 

 Afvoer
• Neem bij het afvoeren van dit product contact op met de 

betreffende lokale autoriteiten.

 Bluetooth®

Bluetooth is een technologie voor draadloze 
communicatie tussen apparatuur die zich binnen een 
straal van ongeveer 10 meter van elkaar bevindt via de 
frequentieband van 2,4 GHz.

• Omgaan met Bluetooth-communicatie
- De 2,4GHz-band die gebruikt wordt door 

Bluetooth-toestellen is een radioband die gebruikt 
wordt door allerlei soorten apparatuur. Hoewel 
Bluetooth-toestellen gebruikmaken van een technologie 
die de invloed van andere apparatuur die dezelfde 
radioband gebruikt zoveel mogelijk minimaliseert, kan 
een dergelijke invloed de snelheid van de verbinding of 
het bereik ervan verminderen en in sommige gevallen de 
verbinding zelfs volledig verstoren.

- De snelheid van de signaaloverdracht en de afstand over 
welke de communicatie nog mogelijk is hangen mede af 
van de afstand tussen de betrokken toestellen, de 
aanwezigheid van obstakels, de omstandigheden 
voor de radiogolven en het type apparatuur.

- Yamaha kan niet garanderen dat alle draadloze 
verbindingen tussen dit toestel en andere 
Bluetooth-apparatuur naar behoren zullen functioneren.
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Het verplaatsen en plaatsen van het 
instrument 
Verplaats het instrument horizontaal. Stel het instrument niet 
bloot aan overmatige trillingen of schokken. Aangezien dit 
product erg zwaar is, moet u ervoor zorgen dat er voldoende 
mensen bij de hand zijn om u te helpen, zodat u het veilig en 
gemakkelijk kunt tillen en verplaatsen. Controleer na het 
verplaatsen van het instrument of alle schroeven nog goed 
vastzitten en niet zijn losgeraakt. 
Als u verhuist, kunt u het instrument samen met uw andere 
bezittingen transporteren. U kunt het instrument in zijn geheel 
(gemonteerd) vervoeren of demonteren en de onderdelen apart 
vervoeren.

VOORZICHTIG
Als u het instrument wilt verplaatsen, houdt u het altijd vast aan 
de onderkant van het hoofdapparaat. Als u een ander deel van 
het instrument vasthoudt, kan het beschadigd raken of persoonlijk 
letsel veroorzaken.

LET OP
Draai voordat u het instrument verplaatst aan de stabilisator onder 
het pedaal tot deze loskomt van de vloer. Als u dit niet doet, kan het 
vloeroppervlak beschadigd raken.

De CLP-885 en CLP-895GP zijn compatibel met de volgende indelingen.

GM System Level 2
GM (General MIDI) is een van de meest voorkomende voice-toewijzingsindelingen. De standaardspecificatie GM System 
Level 2 is een verbetering ten opzichte van de originele GM, waarbij ook de songdatacompatibiliteit is verbeterd. GM System 
Level 2 voorziet in een grotere polyfonie, uitgebreidere voiceselectie, uitgebreide voiceparameters en geïntegreerde 
effectverwerking.

XG
XG is een enorme verbetering van de GM System Level 1-indeling en is speciaal door Yamaha ontwikkeld om in meer voices 
en variaties, alsook in een grotere expressieve besturing van de voices en effecten te voorzien en om een goede 
datacompatibiliteit in de toekomst veilig te stellen.

GS
GS is door de Roland Corporation ontwikkeld. Op dezelfde manier als Yamaha XG is GS een belangrijke verbetering van de 
GM-specificatie om in meer voices en drumkits en hun variaties te voorzien, evenals in een grotere expressieve besturing van 
voices en effecten.

Niet hier vasthouden.

Hier vasthouden.

Op de vloer Van de vloer

OPMERKING
(Alleen CLP-885/CLP-875) Plaats het instrument minimaal 
10 cm van de muur om het geluidseffect te optimaliseren en 
te versterken.
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De handleidingen

Voor dit instrument bestaan de volgende documenten en instructiehandleidingen. 

Meegeleverd met het instrument

• Gebruikershandleiding (dit boek)
Geeft uitleg over de basisbediening en -functies van dit instrument. Lees eerst deze handleiding door.

Beschikbaar op de website

• Reference Manual (Naslaggids)
Geeft uitleg over de verschillende instellingen en functies die worden bediend via het menu (pagina 51). 
Lees deze handleiding na het lezen van de gebruikershandleiding.

• Data List (Datalijst)
Bevat MIDI-gerelateerde informatie over het instrument, evenals lijsten met XG-voices en XG-drumkits die u kunt 
selecteren met de CLP-885 en CLP-895GP.

• Smart Pianist User Guide (Gebruikershandleiding Smart Pianist)
Geeft uitleg over het instellen en gebruiken van de smartapparaat-app 'Smart Pianist' (pagina 46) voor het 
bedienen van dit instrument.

Meegeleverde accessoires

 Gebruikershandleiding (dit boek)
 '50 Classical Music Masterpieces' (muziekboek)
 Online Member Product Registration (Online productregistratie)
 Kruk*
 Netsnoer*, netadapter*

* Wordt mogelijk niet meegeleverd in uw regio. Neem hiervoor contact op met uw Yamaha-dealer.

Regels voor de opmerkingen

WAARSCHUWING
Belangrijke informatie om ernstig of zelfs dodelijk letsel als gevolg van elektrische 
schokken, kortsluiting, beschadiging, brand of andere gevaren te voorkomen.

VOORZICHTIG
Belangrijke informatie om lichamelijk letsel bij uzelf en anderen of beschadiging van het 
instrument en andere eigendommen te voorkomen.

LET OP Belangrijke informatie om storingen/schade aan het product en schade aan de gegevens 
of andere eigendommen te voorkomen.

OPMERKING Nuttige informatie en tips.

Als u deze handleidingen wilt downloaden, gaat u naar de onderstaande website:

Yamaha Downloads (Downloads van Yamaha) 
https://download.yamaha.com/

* Voer de modelnaam in om de 
gewenste handleidingen te zoeken.
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Mogelijkheden van uw CLP

Verschillende voices als aanvulling op uw muziek pagina 26

Dit instrument bevat pianoklanken die zijn gemaakt op basis van samples van de concertvleugel CFX, het vlaggenschip 
van Yamaha en de beroemde in Wenen gemaakte Bösendorfer-vleugel. Naast deze twee prachtige pianoklanken zijn er 
verschillende andere voices zoals piano, orgel en strijkers beschikbaar, zodat u het instrumentgeluid kunt kiezen dat het 
beste past bij de muziek die u wilt spelen. U kunt ook twee voices in lagen plaatsen, of verschillende voices spelen in het 
rechter- en linkergedeelte van het toetsenbord. 

* Bösendorfer is een dochteronderneming van Yamaha.

Handige oefenhulpen met songdata pagina 30

Een verscheidenheid aan bekende klassieke songs en lessongs, waaronder 'The Virtuoso Pianist' zijn vooraf geïnstalleerd op 
het instrument en helpen u om efficiënt te oefenen. U kunt gewoon genieten van het luisteren naar deze songs, of alleen de 
linkerhandpartij (of rechterhandpartij) afspelen en elke partij afzonderlijk oefenen. Het afspeeltempo of de afspeelsnelheid 
kan naar wens worden aangepast, zodat u in een langzaam tempo kunt beginnen en dit kunt verhogen naarmate u het stuk 
onder de knie krijgt. Compatibele commercieel verkrijgbare songs kunnen ook op dit instrument worden gebruikt. 

Uw spel opnemen en afspelen pagina 37

U kunt uw spel opnemen in het interne geheugen van het instrument of op een USB-stick. Het terugluisteren van uw 
opnames helpt enorm bij het verbeteren van uw spel. Met dit instrument kunt u ook meerdere delen onafhankelijk opnemen 
en opslaan als één song. Dit kan ook helpen bij het oefenen; neem bijvoorbeeld eerst de rechterhandpartij op en dan die 
van de linkerhand terwijl u luistert naar de al opgenomen rechterhandpartij. Songs die met deze methode zijn opgenomen, 
kunnen worden afgespeeld met onafhankelijke partijen – een effectief hulpmiddel voor kinderen om te oefenen met één 
hand door de rechter- en linkerpartij van het spel van de ouder onafhankelijk op te nemen.

Lekker meespelen met ritmes pagina 29

Er wordt een verscheidenheid aan ritmepatronen (drum- en basbegeleiding) in verschillende genres zoals pop en jazz 
meegeleverd, zodat u kunt genieten van het pianospelen terwijl het ritme dynamisch wordt afgespeeld. Het begeleidende 
basgeluid verandert automatisch op basis van uw spel en zorgt ervoor dat het dynamisch en professioneel klinkt.

Luister naar muziek via de ingebouwde luidsprekers (Bluetooth-audio) pagina 43

Door een met Bluetooth uitgeruste audiospeler zoals een smartphone via Bluetooth aan te sluiten, kunt u naar 
muziek luisteren die op de aangesloten audiospeler wordt afgespeeld via de luidsprekers van dit instrument.

Haal meer plezier uit uw piano met de Smart Pianist-app pagina 46

Door de Smart Pianist-app te installeren op uw smartapparaat, zoals een smartphone of tablet, kunt u het instrument 
verbinden met het apparaat en meer voordeel halen uit dit instrument. De eenvoudig te begrijpen display helpt u om het 
instrument te bedienen terwijl u de status van de instellingen controleert. U kunt het instrument bespelen terwijl u de 
bladmuziek op het apparaat bekijkt, en uw uitvoeringen opnemen op het apparaat enz.
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Bedieningspaneel en aansluitingen

 CLP-885/CLP-875/CLP-845/CLP-835 
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CLP-875

CLP-845

CLP-835

4
5

6

6

4

5

%

7

#

$

Toetsenklep

Bedieningspaneel

Muziekstandaard

Muzieksteunen

[P]-schakelaar (stand-by/aan)

[VOLUME]-schuif

Pedalen

USB [TO DEVICE]-
aansluiting

[AUX IN]-
aansluiting

USB [TO HOST]-
aansluiting

[PHONES]-
aansluitingen

[PEDAL]-connector

Bedieningspaneel

Muziekstandaard

Klep

Muzieksteunen

Toetsenklep

4, 5 en 6 
bevinden zich hier.

Pedalen

 CLP-895GP/CLP-865GP

[P]-schakelaar (stand-by/aan)

[VOLUME]-schuif

USB [TO DEVICE]-
aansluiting

[AUX IN]-
aansluiting

USB [TO HOST]-
aansluiting

[PHONES]-
aansluitingen

AUX OUT 
[L/L+R] [R]-

aansluitingen

AUX OUT 
[L/L+R] [R]-

aansluitingen

(CLP-845/CLP-835) DC IN-aansluiting

(CLP-885/CLP-875) DC IN-aansluiting

[DC IN]-aansluiting

[PEDAL]-connector

* Op deze afbeelding wordt de CLP-885 getoond.

* Op deze afbeelding wordt de CLP-895GP getoond.

Toetsenklep
Muziekstandaard

Muziek-
steunen
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1 [P]-schakelaar (stand-by/aan) (pagina 17)
Om het instrument aan te zetten of op stand-by.

2 [VOLUME]-schuif (pagina 18)
Voor het aanpassen van het totaalvolume.

3 Bedieningspaneel (pagina 20)
Voor de bediening van het instrument, het gebruik van de verschillende functies en het wijzigen van de 
instellingen.

4 Toetsenklep (pagina 14)
Om het toetsenbord schoon te houden en te beschermen tegen stof of vuil.

5 Muziekstandaard (pagina 15)
Voor het opstellen van muziekboeken enz.

6 Muzieksteunen (pagina 15)
Voor het stevig vasthouden van de pagina's van muziekboeken op de muziekstandaard.

7 Pedalen (pagina 19)
Te gebruiken als demperpedaal (rechts), sostenutopedaal (midden) of softpedaal (links). (Dit zijn 
standaardinstellingen).

8 USB [TO DEVICE]-aansluiting (pagina 47, 49)
Voor het aansluiten van een USB-stick of de draadloze USB netwerkadapter UD-WL01 (afzonderlijk 
verkrijgbaar). Lees eerst 'De USB [TO DEVICE]-aansluiting gebruiken' op pagina 6 voordat u de USB 
[TO DEVICE]-aansluiting gaat gebruiken.

9 USB [TO HOST]-aansluiting (pagina 47, 48)
Voor het verbinden met een computer of smartapparaat zoals smartphone of tablet.

) [AUX IN]-aansluiting (pagina 45)
Voor het verbinden met een audiospeler en invoer van geluid van dat apparaat naar dit instrument.

! [PHONES]-aansluitingen (×2) (pagina 18)
Voor het aansluiten van hoofdtelefoons.

@ AUX OUT [L/L+R][R]-aansluitingen (pagina 50)
Voor het verbinden met een audioapparaat zoals een luidsprekersysteem en uitvoer van geluid van dit 
instrument naar dat apparaat.

# DC IN-aansluiting (pagina 16)
Voor het aansluiten van het netsnoer en de netadapter.

$ [PEDAL]-connector (pagina 19)
Voor het aansluiten van het pedaalsnoer van het voorgeïnstalleerde pedaal of de apart verkrijgbare 
FC35-pedaaleenheid.

% Klep (pagina 15)
Om de resonantie van het geluid te veranderen zoals op een echte vleugel door deze te openen of te sluiten.
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Opstarten

Raadpleeg de instructies op pagina 63 voor informatie over hoe u het instrument installeert.

Om het toetsenbord en de binnenkant van het instrument te beschermen tegen stof of vuil, moet u de toetsenklep 
sluiten wanneer u het instrument niet gebruikt. 

VOORZICHTIG
• Houd de toetsenklep met beide handen vast als u deze opent of sluit. Let op dat er geen vingers (van u of van anderen, vooral die 

van kinderen) knel komen te zitten tussen de klep en de kast.
• Plaats geen voorwerpen (zoals metaal of stukken papier) op de toetsenklep. Kleine voorwerpen die op de toetsenklep worden 

geplaatst, kunnen in het apparaat vallen als de klep wordt geopend en zijn soms bijna onmogelijk te verwijderen. Dit kan 
elektrische schokken, kortsluiting, brand of ernstige schade aan het instrument veroorzaken.

 CLP-885 
Houd de handgreep met beide handen vast om 
de toetsenklep te openen en til deze vervolgens 
op om deze te openen. Vouw zodra de klep open 
is het voorste gedeelte van de toetsenklep dicht.
Om het toetsenklep te sluiten, klapt u eerst 
de muziekstandaard terug (pagina 15). Open 
vervolgens de neergeklapte bovenkant van 
de toetsenklep en sluit de klep voorzichtig met 
beide handen.

VOORZICHTIG
Oefen geen te grote druk uit bij het sluiten van de 
toetsenklep. Hierdoor kan het SOFT-CLOSE™-
mechanisme beschadigen en letsel aan uw handen en 
vingers veroorzaken doordat deze bekneld raken onder 
de sluitende toetsenklep.

 CLP-875/CLP-845/CLP-835/CLP-895GP/CLP-865GP 
Om de toetsenklep te openen tilt u deze een klein 
stukje op en schuift u de klep naar binnen. Om de 
toetsenklep te sluiten, schuift u deze naar u toe 
en laat u de klep voorzichtig zakken. 

De toetsenklep openen/sluiten

VOORZICHTIG
Let op dat uw vingers niet klem komen te zitten tijdens 
het openen en sluiten van de klep.

VOORZICHTIG
Let op dat uw vingers niet klem komen te zitten tijdens 
het openen en sluiten van de klep.
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 CLP-885 
Om de muziekstandaard te gebruiken, 
vouwt u deze open aan de binnenkant van de 
toetsenklep. De muzieksteunen kunnen omhoog 
worden gezet om de pagina's van muziekboeken 
stevig op de muziekstandaard te houden.
Om de muziekstandaard te sluiten, klapt u eerst 
de muzieksteunen in vouwt u vervolgens de 
muziekstandaard terug in de richting van de 
toetsenklep.

 CLP-875/CLP-845/CLP-835/CLP-895GP/CLP-865GP 
Om de muziekstandaard te gebruiken, trekt 
u deze naar u toe tot aan de aanslag (1) en klapt 
u de twee metalen steunen aan de achterkant 
van de muziekstandaard naar beneden (2). Laat 
vervolgens de muziekstandaard zakken zodat 
de metalen steuntjes op hun plaats klikken. 
De muzieksteunen kunnen omhoog worden 
gezet om de pagina's van muziekboeken 
stevig op de muziekstandaard te houden. 
Om de muziekstandaard te sluiten, trekt u deze 
naar zich toe (1) en tilt u de twee metalen 
steunen omhoog (2). Laat vervolgens de 
muziekstandaard nu langzaam helemaal naar 
beneden zakken.

VOORZICHTIG
Gebruik de muziekstandaard niet in een half opgezette positie. Laat de muziekstandaard bij het opzetten of neerklappen pas los 
wanneer de standaard helemaal omhoog staat of helemaal vlak ligt. 

WAARSCHUWING
• Kinderen mogen de klep niet openen of sluiten. Let ook op dat er geen vingers (van u of van anderen, vooral die van kinderen) 

knel komen te zitten als u de klep opent of sluit.
• Zorg dat het uiteinde van de steun veilig in de uitsparing van de klep past. Als de steun niet op de juiste manier in de uitsparing 

zit, kan de klep eventueel vallen, wat schade of letsel tot gevolg heeft.
• Pas op dat u of anderen niet tegen de steun stoten als de vleugelklep omhoog staat. De steun kan uit de uitsparing springen 

waardoor de klep omlaag valt.

De klep openen:

1 Til de rechterkant van de klep 
(gezien vanaf de toetsenbordkant van het 
instrument) op en houd deze omhoog.

2 Zet de klepsteun op en laat de klep 
langzaam zo zakken dat het uiteinde van 
de steun in de uitsparing in de klep valt.

De muziekstandaard gebruiken

De klep openen/sluiten (alleen CLP-895GP/CLP-865GP)

Muzieksteunen

1

2

Muzieksteunen

1

2
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De klep sluiten:

1 Houd de klepsteun vast en til de klep 
iets omhoog.

2 Houd de klep omhoog en klap de steun neer.

3 Laat de klep langzaam zakken.

Sluit de stekkers van de netadapter en het netsnoer aan in de volgorde die wordt getoond in de afbeelding. 
Raadpleeg pagina 12 om de locatie van de DC IN-aansluiting te bevestigen.

WAARSCHUWING
• Gebruik alleen de meegeleverde of de/het gespecificeerd(e) netadapter (pagina 79 of pagina 82)/netsnoer. Gebruik de netadapter/het 

netsnoer niet voor andere apparaten. Gebruik van een ander(e) netadapter/netsnoer kan beschadiging of oververhitting veroorzaken. 
• Zorg er bij het opstellen van het product voor dat de AC-uitgang makkelijk toegankelijk is. Schakel het instrument bij storingen of een 

slechte werking onmiddellijk uit en trek de stekker uit het stopcontact.

OPMERKING
Wanneer u het netsnoer of de netadapter loskoppelt, schakelt u eerst het instrument uit en daarna volgt u deze procedure in omgekeerde volgorde.

Alleen CLP-895GP
Gebruik de binnenste uitsparing voor de langere steun en de buitenste uitsparing om met de kortere steun de klep te 
ondersteunen.

WAARSCHUWING
Gebruik de buitenste uitsparing niet voor de langere steun. Als u deze uitsparing gebruikt, wordt de klep instabiel en kan ze vallen 
wat tot schade of letsel kan leiden.

Spanningsvoorziening

Langere steun Kortere steun

1

3

2

1

2

3

DC IN-aansluiting  
(DC IN 24 V of DC IN 16 V)

Gelijkstroomstekker

Netadapter

Netsnoer Netstekker

Stopcontact

De uitvoering van de stekker 
en het stopcontact kan per 
locatie verschillen.
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1. Zet de [VOLUME]-schuif op 'MIN'.

2. Druk op de [P]-schakelaar (stand-by/aan) om het instrument in te schakelen.
De display aan de linkerkant van het toetsenbord en de spanningsindicator op de [P]-schakelaar 
(stand-by/aan) gaan beide branden.

LET OP
Druk enkel op de [P]-schakelaar (stand-by/aan) wanneer u het instrument inschakelt. Andere handelingen zoals de toetsen, 
knoppen of pedalen indrukken, kan ertoe leiden dat het instrument defect raakt.

3. Schakel het instrument na gebruik uit door de [P]-schakelaar (stand-by/aan) een 
seconde ingedrukt te houden.

VOORZICHTIG
Zelfs als de [P]-schakelaar (stand-by/aan) in de stand-bystand staat, loopt er nog een minimale hoeveelheid stroom door het 
instrument. Verwijder de stekker uit het stopcontact tijdens onweer of als u het instrument gedurende langere tijd niet gebruikt.

Automatische uitschakelfunctie

De functie Automatisch uitschakelen schakelt de stroom automatisch uit als het instrument gedurende een 
bepaalde tijd niet wordt gebruikt (standaard 15 minuten). Dit voorkomt onnodig stroomverbruik. De tijd die verstrijkt 
voordat de voeding automatisch wordt uitgeschakeld, kan worden gewijzigd via 'Utility' > 'Auto Power Off' in het 
menu System (pagina 51). Raadpleeg de naslaggids voor meer informatie.

LET OP
Opgenomen data die niet worden opgeslagen, gaan verloren als het instrument automatisch wordt uitgeschakeld. Zorg dat u uw 
data opslaat alvorens dit gebeurt.

Het instrument aan- of uitzetten

De automatische uitschakelfunctie 
uitschakelen 
Zet het instrument aan terwijl u de laagste toets op het 
toetsenbord ingedrukt houdt. Er verschijnt kort een bericht 
'Auto power off disabled' en het instrument start op met de 
functie Automatisch uitschakelen uitgeschakeld.

1

2
Spanningsindicator

+
De laagste toets
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Gebruik de [VOLUME]-schuif om het volume van het volledige toetsenbordgeluid aan te 
passen. Speel op het toetsenbord om het geluid te controleren terwijl u het volume instelt. 

VOORZICHTIG
Gebruik het instrument niet te lang op een hoog of oncomfortabel geluidsniveau, aangezien dit 
permanent gehoorverlies kan veroorzaken.

OPMERKING
U kunt de functie Volumebegrenzer gebruiken om te harde geluiden van het instrument te voorkomen. Deze functie 
is standaard uitgeschakeld; u kunt deze echter in-/uitschakelen via 'Sound' > 'Volume Limiter' in het menu System 
(pagina 51). Raadpleeg de naslaggids voor meer informatie. 

U kunt twee paar hoofdtelefoons aansluiten op de [PHONES]-
aansluitingen. Als u slechts één paar gebruikt, steekt u de stekker in een 
van deze aansluitingen. Als u een hoofdtelefoon met een ministekker 
gebruikt, hebt u een geschikte adapterstekker nodig zoals getoond op 
de afbeelding. 

VOORZICHTIG
Gebruik de hoofdtelefoon niet te lang op een hoog of oncomfortabel 
geluidsniveau, aangezien dit permanent gehoorverlies kan veroorzaken.

OPMERKING
• Om een te luid volume te voorkomen, kan de volumebegrenzerfunctie worden gebruikt om 

het maximale volume te beperken. Deze functie is standaard uitgeschakeld; u kunt deze 
echter in-/uitschakelen via 'Sound' > 'Volume Limiter' in het menu System (pagina 51). 
Raadpleeg de naslaggids voor meer informatie. 

• Wanneer een stekker wordt aangesloten op de [PHONES]-aansluiting, komt er geen geluid 
uit de luidsprekers van het instrument. Als u een adapteraansluiting gebruikt, verwijder deze 
dan ook als u de hoofdtelefoon verwijdert.

• Als een van de voices met VRM-effecten is geselecteerd (pagina 52), kunt u dankzij de Binaural Sampling- of Stereophonic Optimizer-technologie 
genieten van een uitzonderlijk realistisch, natuurlijk pianogeluid, zelfs als u met een hoofdtelefoon luistert. Deze functie is standaard ingeschakeld; 
u kunt deze echter in-/uitschakelen via 'Sound' > 'Binaural' in het menu System (pagina 51). Raadpleeg de naslaggids voor meer informatie.

Bevestig de ophangbeugel voor de hoofdtelefoon

In de verpakking van het instrument zit een ophangbeugel voor de 
hoofdtelefoon, zodat u de hoofdtelefoon aan het instrument kunt 
hangen. Bevestig de ophangbeugel voor de hoofdtelefoon met behulp 
van de twee meegeleverde schroeven (4 × 10 mm) aan de linker 
voorkant, zoals weergegeven in de afbeelding. 

LET OP
Hang niets anders aan de beugel dan een hoofdtelefoon. Als u dat wel doet, kan 
het instrument of de beugel beschadigd raken.

Het mastervolume aanpassen 

Een hoofdtelefoon gebruiken 

Het geluid 
wordt harder.

Het geluid 
wordt zachter.

Standaardaansluiting voor stereohoofdtelefoon

Adapterstekker 
(3,5 mm  
6,3 mm)

Stereo 
ministekker 
(3,5 mm)

* De vorm van de beugel verschilt 
per model
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De onderstaande functie is standaard toegewezen aan elk pedaal. 
Draai voordat u de pedalen gebruikt aan de stelschroef totdat deze 
stevig contact maakt met het vloeroppervlak, zodat de pedalen niet 
rammelen of meegeven wanneer u erop stapt. 

LET OP
Draai voordat u het instrument verplaatst aan de stabilisator onder het pedaal 
tot deze loskomt van de vloer. Als u dit niet doet, kan het vloeroppervlak 
beschadigd raken.

OPMERKING
• De pedalen zijn bij levering van de fabriek beschermd met kunststof hoezen. 

Verwijder de hoezen van de pedalen voor gebruik om optimaal gebruik van de 
pedaaleffecten te garanderen.

• De pedaalfuncties kunnen worden gewijzigd via 'Pedal Assign' in het menu Voice 
(pagina 51). Raadpleeg de naslaggids voor meer informatie.

 Demperpedaal (rechts) 
Als u het demperpedaal indrukt, worden de noten die u speelt langer aangehouden 
(sustain). Als u een pianovoice met VRM-effecten (pagina 52) selecteert, wordt door 
het indrukken van het demperpedaal de VRM geactiveerd om de unieke resonantie 
nauwkeurig na te bootsen.

OPMERKING
Het demperpedaal van de CLP-885, CLP-875 en CLP-895GP is voorzien van de GP Response-
demperpedaal. Dit pedaal is ontworpen om voor een geavanceerde tactiele ervaring te zorgen en voelt bij 
indrukken veel meer aan als het pedaal van een vleugel. Hiermee wordt het makkelijker om het 
halfpedaalpunt te ervaren, waardoor halfpedaal makkelijker kan worden toegepast dan met andere pedalen.

 Sostenutopedaal (midden) 
Als u een noot of akkoord op het toetsenbord speelt en het sostenutopedaal indrukt 
terwijl u de noten aanhoudt, blijven de noten klinken zolang u het pedaal ingedrukt 
houdt. Alle daaropvolgende tonen worden niet langer aangehouden.

OPMERKING
Als u het middelste pedaal ingedrukt houdt, kan een aangehouden (niet-wegstervende) soort voice in de 
categorie STRINGS of ORGAN doorklinken nadat u de toetsen hebt losgelaten.

 Softpedaal (links)
Het softpedaal vermindert het volume en wijzigt de klankkleur van de gespeelde noten enigszins wanneer het pedaal 
wordt ingedrukt. Het softpedaal heeft geen invloed op de noten die al worden gespeeld op het moment dat het pedaal 
wordt ingedrukt.
Als 'Jazz Organ 1', 'Jazz Organ 2' of 'Rock Organ' is geselecteerd, schakelt u met het indrukken en loslaten van dit pedaal 
tussen de instelling 'snel' en 'langzaam' voor de snelheid van de roterende luidspreker. Als 'Vibraphone' is geselecteerd, 
schakelt u met dit pedaal het vibrato in of uit.

De pedalen gebruiken 

[PEDAL]-connector 
Zorg ervoor dat u de stekker van het pedaalsnoer stevig en in de juiste richting in de 
[PEDAL]-connector steekt. Anders werkt het pedaal mogelijk niet goed. De FC35-pedaaleenheid 
(afzonderlijk verkrijgbaar) kan ook op deze aansluiting worden aangesloten. U kunt de FC35 
vervangen door de pedalen van het instrument en de pedalen op een voor u geschikte hoogte 
gebruiken door de eenheid op een standaard te plaatsen.

VOORZICHTIG
Zorg ervoor dat wanneer u de FC35 op een standaard plaatst, de standaard voldoende groot, vlak en 
stabiel is om te voorkomen dat de pedalen wiebelen of vallen wanneer ze worden ingedrukt.

LET OP
Zorg ervoor dat u de stekker in de juiste richting aansluit. Aansluiten in de verkeerde richting kan leiden tot schade aan het instrument.

OPMERKING
• Bij de CLP-895GP/CLP-865GP wijkt de vorm van de stekker af van de bovenstaande afbeelding.
• Zorg ervoor dat de voeding is uitgeschakeld wanneer u de stekker van het pedaal aansluit of loskoppelt.

Softpedaal

Sostenutopedaal

Demperpedaal

Tegen de vloer Van de vloer

Als u hier op het demperpedaal 
drukt, krijgen de noten die 
u speelt voordat u het pedaal 
loslaat een langere sustain en 
blijven ze langer klinken.

Als u hier het sostenutopedaal 
indrukt terwijl u een toets ingedrukt 
houdt, krijgt de noot sustain zolang 
u het pedaal ingedrukt houdt.

Steek de stekker in de 
aansluiting tot het metalen 
gedeelte van de stekker 
niet meer zichtbaar is.
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Basisbediening

Omdat dit instrument in de fabriek is geoptimaliseerd voor nieuwe gebruikers, kunt u het eenvoudig gebruiken met 
de standaardinstellingen. 
Naarmate u meer vertrouwd raakt met het instrument, kunt u enkele van de verschillende functies uitproberen of 
enkele instellingen naar wens wijzigen. Gebruik het bedieningspaneel om het instrument te bedienen en controleer 
de status van het instrument op de display. 

Bedieningspaneel 

OPMERKING
• De CLP-885/CLP-875/CLP-895GP en de CLP-845/CLP-835/CLP-865GP hebben verschillende bedieningspanelen. Illustratieve voorbeelden van 

panelen worden hierna aangeduid met pictogrammen om aan te geven welke modellen over het betreffende paneel beschikken.

• Op de CLP-885/CLP-875/CLP-895GP licht het bedieningspaneel op wanneer de voeding wordt ingeschakeld, en wordt automatisch uitgeschakeld als 
u het bedieningspaneel gedurende een bepaalde tijd niet aanraakt (standaard 30 seconden). De tijd die verstrijkt voordat het licht uitgaat en het 
geluid van de bedieningstoetsen aan/uit gaat kunnen worden ingesteld via 'Utility' in het menu System (pagina 51). Raadpleeg de naslaggids voor 
meer informatie.

1 [CFX GRAND]/[BÖSENDORFER]/[PIANO ROOM]-knoppen
Om dit instrument als een piano te bespelen (pagina 23). U kunt de piano bespelen met de door u gewenste 
instellingen, zoals aanslaggevoeligheid en resonantie.

2 [VOICE]/[DUAL/SPLIT]-knoppen
Om te spelen met verschillende instrumentale voices, waaronder piano, orgel en meer (pagina 26). U kunt ook 
twee voices in lagen plaatsen, of verschillende voices spelen in het rechter- en linkerhandgedeelte van het 
toetsenbord.

3 [SONG/DEMO]/[REC]/[PLAY/PAUSE]-knoppen
Voor het afspelen en beluisteren van de vooraf ingestelde of commercieel verkrijgbare songs (pagina 30), of 
voor het opnemen van uw spel (pagina 37). U kunt ook elk deel afzonderlijk afspelen of opnemen, zodat u de 
rechterhandpartij kunt oefenen terwijl u de linkerhandpartij afspeelt.

4 [METRONOME]/[RHYTHM]-knoppen
Voor het oefenen van spelen in een nauwkeurig tempo met metronoom (pagina 25) of meespelen met 
dynamische ritmeweergave (pagina 29).

5 [TEMPO]-knop
Voor het aanpassen van het tempo voor metronoom (pagina 25), ritme (pagina 29) of song (pagina 33) afspelen.

 

885 875 895GP 845 835 865GP

1
1

2 2

3 3

4 45 5

Display

[MENU]-knop

[u]/[d]/[l]/[r]-
knoppen

[EXIT]-knop

Bluetooth-knop

Display

[u]/[d]/[l]/[r]-
knoppen

[MENU]-knop

[EXIT]-knop
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• [u]/[d]/[l]/[r]-knoppen
Voor het selecteren van een item op de display of het instellen van een waarde. Raadpleeg de onderstaande 
voorbeelden als leidraad voor het gebruik van deze knoppen.

• [ ]/[EXIT]-knoppen
Om de display te verlaten. 

• [≡]/[MENU]-knoppen (pagina 51)
Om gedetailleerde instellingen voor elke functie te maken. Op de CLP-845, CLP-835 en CLP-865GP wordt dit ook 
gebruikt om met een Bluetooth-apparaat zoals een smartphone te koppelen (pagina 44).

• (Alleen CLP-885/CLP-875/CLP-895GP) Bluetooth-knop (pagina 44)
Voor het koppelen met een Bluetooth-apparaat zoals een smartphone.

Beschikbaarheid van Bluetooth
Het instrument beschikt mogelijk niet over de functie, afhankelijk van het land waarin u het product kocht. Als 
het Bluetooth-logo op het bedieningspaneel wordt getoond of is aangebracht, betekent dit dat het product is 
voorzien van de Bluetooth-functie.

De [ ]-knop wordt in deze handleiding hierna [EXIT]-knop genoemd en de [≡]-knop wordt [MENU]-knop genoemd.

Druk op de knop 
[u] om een hoger 
niveau (lijst) op te 
roepen.

Gebruik de 
knoppen [l]/[r] 
om een item te 
selecteren.

Druk op de knop 
[l] om een hoger 
niveau (lijst) op te 
roepen.

Gebruik de 
knoppen [u]/[d] 
om een item te 
selecteren.

Druk op de knop 
[r] om een 
instelling te openen, 
een bewerking uit te 
voeren of een lager 
niveau op te roepen.

Gebruik de 
knoppen [u]/[d] 
om de waarde te 
wijzigen.

Gebruik de knoppen [l]/[r] 
om een item te selecteren. Gebruik de knoppen [l]/[r] 

om de waarde te wijzigen.

Gebruik de knoppen [u]/[d] om door 
het scherm te scrollen. (De scrollbalk 
wordt weergegeven als de items niet 
op één pagina passen.)

885 875 845895GP 835 865GP

Bluetooth-logo

Bluetooth-logo
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De in de fabriek geprogrammeerde instellingen herstellen

De instellingen van het instrument blijven bewaard, zelfs als de voeding wordt 
uitgeschakeld, zodat u het instrument met dezelfde instellingen kunt gebruiken 
wanneer u de volgende keer de voeding inschakelt. Om de instellingen te 
herstellen naar de fabrieksinstellingen, drukt u op de schakelaar [P] (stand-by/
aan) om de voeding in te schakelen terwijl u de hoogste toets ingedrukt houdt. 

OPMERKING
• Raadpleeg het gedeelte 'Backup' in het menu System in de naslaggids voor meer informatie over de 

gegevens die worden bewaard, zelfs als de voeding is uitgeschakeld.

• De songs die zijn opgeslagen op het instrument (pagina 37) en Bluetooth-koppelingsinformatie 
(pagina 44) gaan niet verloren, zelfs niet wanneer er wordt geïnitialiseerd.

De waarde van het geselecteerde item resetten naar de standaardwaarde

U kunt de instellingswaarde voor een geselecteerd item, zoals in de display Tempo en de display Menu, resetten 
naar de oorspronkelijke standaardwaarde.

De instellingen initialiseren

Hoogste toets

[P]-schakelaar (stand-by/aan) 

885 875 845 835895GP 865GP

Terwijl de insteldisplay wordt getoond, 
houdt u de knop [MENU] ingedrukt tot 
de waarde wordt gereset.

Druk tegelijkertijd op de knoppen 
[l] en [r] terwijl de insteldisplay 
wordt weergegeven.

OPMERKING
Op de display waarin u de waarde hebt ingesteld 
met de knoppen [u]/[d], drukt u tegelijkertijd op 
de knoppen [u] en [d] om te resetten. 
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Genieten van pianospelen

Met dit instrument kunt u met verschillende soorten pianoklanken spelen. Druk eerst op de knop [CFX GRAND] of 
[BÖSENDORFER] om met een authentieke vleugel te spelen.

• [CFX GRAND]-knop: 
Roept de klanken van de concertvleugel CFX van Yamaha op ('CFX Grand'-voice) met een breed dynamisch 
bereik voor maximale expressieve controle. Geschikt voor het spelen in alle muziekgenres en stijlen.

• [BÖSENDORFER]-knop: 
Roept de befaamde klanken van de in Wenen gemaakte Bösendorfer Imperial-concertvleugel 
('Bösendorfer'-voice) op. Zijn warme, ruimtelijke geluid roept de grootte van het instrument op 
en is ideaal voor de expressie van emotie in composities.

OPMERKING
Als u op de knop [CFX GRAND] of [BÖSENDORFER] drukt, worden de functies Dual, Split of Duo uitgeschakeld (pagina 27).

In Piano Room kunt u gedetailleerde instellingen aanpassen, zoals de resonantie van het pianogeluid en de 
aanraakgevoeligheid om de piano naar uw wensen in te stellen. Selecteer 'CFX Grand', 'Bösendorfer' of een 
andere categorie PIANO-voices met VRM-effecten om de instellingen toe te passen.

OPMERKING
Zie de 'Voicelijst' op pagina 52 om te bekijken welke categorie PIANO-voices VRM-effecten hebben.

Andere pianovoices selecteren
Gebruik de knoppen [l][r] om andere pianovoices dan 'CFX Grand' en 'Bösendorfer' te selecteren. U kunt de 
andere voices ook selecteren door op de knop [VOICE] te drukken (pagina 26).

Het geluid en de aanslaggevoeligheid van pianovoices 
aanpassen (Piano Room)

885 875 845 835895GP 865GP

Display Voice
Voicenaam

Display Voice
Voicenaam
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1. Druk op de knop [PIANO ROOM] om de display Piano Room op te roepen.

OPMERKING
Druk op de knop [EXIT] de display Piano Room te verlaten.

2. Gebruik de knoppen [u]/[d] om een item te selecteren en druk daarna op de knoppen 
[l][r] om de waarde in te stellen.

Optie Omschrijving

Lid Position 
(Kleppositie)

Reproduceert de verschillen in geluid afhankelijk van de positie van de (virtuele) klep van de 
concertvleugel.

 Brightness 
(Helderheid)

Past de helderheid van het geluid aan.

Touch 
(Aanslagsterkte)

Bepaalt hoe het geluid reageert op uw speelsterkte. 

Reverb Hiermee wordt het type reverb van een specifieke kamer of locatie gesimuleerd, waardoor u het 
gevoel krijgt dat u zich in de geselecteerde ruimte bevindt. De reverbdiepte kan ook worden 
aangepast.Reverb Depth 

(Reverbdiepte)

Master Tune 
(Hoofdstemming)

Hiermee stemt u de toonhoogte van het gehele instrument nauwkeurig af. Deze functie is handig 
als u op dit instrument met andere instrumenten of cd-muziek wilt meespelen.

VRM Schakelt het VRM-effect (Virtual Resonance Modeling), dat een echte akoestische piano nabootst, 
in of uit. Als u op de knop [PLAY/PAUSE] drukt terwijl deze display wordt weergegeven, wordt de 
demo afgespeeld. U kunt de demo met of zonder effect (VRM in- of uitgeschakeld) beluisteren. 
De onderstaande parameters kunnen worden ingesteld wanneer VRM is ingesteld op 'On'.
• Damper Resonance (Demperresonantie): Stelt de diepte van het snaarresonantie-effect in dat 

wordt toegepast wanneer het demperpedaal (rechterpedaal) wordt ingedrukt.
• Damper Noise (Dempergeluid): Schakelt het dempergeluid in of uit dat het geluid van een 

akoestische piano nabootst wanneer het demperpedaal wordt ingedrukt.
• String Resonance (Snaarresonantie): Stelt de diepte van het snaarresonantie-effect in dat 

wordt toegepast wanneer een noot op het toetsenbord wordt gespeeld.
• Duplex Scale Resonance (Duplexscalingresonantie): Past de spontane trillingen van het 

duplexscalingresonantie-effect aan.
• Body Resonance (Klankkastresonantie): Past de resonantie van de piano zelf aan 

(de zangbodem, de zijkanten, het frame enzovoort).

885 875 845 835

1

2

1

2

895GP 865GP

Display Piano 
Room

Display Piano 
Room
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OPMERKING
• De instellingen in de Piano Room komen overeen met die in de display Menu (pagina 51). 'Touch', 'Master Tune' en 'Half Pedal Point' kunnen 

worden ingesteld in het menu System en andere parameters in het menu Voice. Raadpleeg de naslaggids voor meer informatie over elke 
instellingsparameter.

• Om het geselecteerde item te resetten naar de standaardwaarde op de CLP-885, CLP-875 en CLP-895GP, houdt u de knop [MENU] ingedrukt 
totdat de waarde wordt gereset. Druk op de CLP-845, CLP-835 en CLP-865GP tegelijkertijd op de knoppen [l] en [r].

Als u op de knop [METRONOME] drukt, wordt de metronoom in- of uitgeschakeld. Met de metronoom kunt 
u oefenen of spelen op een nauwkeurig tempo.
Om het tempo van de metronoom aan te passen, gebruikt u de knoppen [l]/[r] om de waarde te veranderen 
terwijl de display Tempo wordt weergegeven. Als de display Tempo niet wordt weergegeven, drukt u op de knop 
[TEMPO] om deze op te roepen.

OPMERKING
• Het tempo van de metronoom en het ritme (pagina 29) zijn gelijk aan elkaar.

• Als u de maatsoort van de metronoom instelt, wordt de eerste tel geaccentueerd door het belgeluid. De maatsoort en het volume van de metronoom 
kunnen worden ingesteld in het menu Metronome/Rhythm (pagina 51). Raadpleeg de naslaggids voor meer informatie.

Grand 
Expression

Selecteert het type van de Grand Expression Modelling-effecten. Als u op de knop [PLAY/PAUSE] 
drukt terwijl deze display wordt weergegeven, wordt de demo afgespeeld. U kunt naar de demo 
luisteren met 'Dynamic' of 'Static'.
• Dynamic (Dynamisch): U kunt uiterst subtiele nuances in het geluid regelen zoals op een echte 

akoestische piano door uw speelsterkte of aanslag te veranderen.
• Static (Statisch): De nuances blijven over het algemeen behouden, zelfs wanneer 

u uw speelsterkte of aanslag verandert.

Half Pedal Point 
(Half-pedaalpunt)

Bepaalt tot welk punt u het demperpedaal (rechterpedaal) moet indrukken voordat het 
Sustain-effect begint.

Half-pedaaleffect
Met het half-pedaaleffect kunt u halfdempertechnieken gebruiken, waarbij het demperpedaal ergens tussen 
volledig en helemaal niet wordt ingedrukt. In deze positie (op een echte piano) zorgen de dempervilten voor een 
gedeeltelijk dempen van de snaren. Met het half-pedaaleffect op het instrument kunt u op een verfijnde en 
expressieve manier het dempen controleren en subtiele nuances in uw spel aanbrengen, door het punt waarop 
het indrukken van het pedaal invloed heeft op het dempen nauwkeurig te controleren.

De metronoom gebruiken

Optie Omschrijving

885 875 845 835895GP 865GP

Display Tempo Display Tempo

Metronoom aan/uit Metronoom aan/uit

Het tempo 
aanpassen

Het tempo 
aanpassen
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Diverse geluiden spelen (voices)

Naast de opmerkelijk realistische pianogeluiden kunt u ook het geluid van andere muziekinstrumenten selecteren 
en hiermee spelen (voices), zoals een orgel of een strijkinstrument. Zie de 'Voicelijst' op pagina 52 voor meer 
informatie over elke voice.

OPMERKING
Voor sommige voices zijn demo's beschikbaar, zodat u de kenmerken van de voices kunt horen en ervaren. Zie pagina 31 voor instructies voor het 
afspelen van de voicedemo's.

1. Druk op de knop [VOICE] om de lijst met voicecategorieën op te roepen.
Voices worden gecategoriseerd volgens het type instrument.

2. Gebruik de knoppen [u]/[d] om de voicecategorie te selecteren en druk daarna op de 
knop [r] om deze op te roepen.
De voices in de geselecteerde categorie worden in de display weergegeven. Druk op de knop [l] om de 
categorie opnieuw te selecteren.

OPMERKING
Op de CLP-885 en CLP-895GP, kunnen ook XG-voices worden geselecteerd. Omdat de categorie XG een groot aantal voices bevat, is deze 
handig onderverdeeld in subcategorieën. Gebruik de knoppen [u]/[d] om een subcategorie te selecteren en druk daarna op de knop [r] om 
verder te gaan naar de volgende stap. Zie de 'Datalijst' op de website voor een lijst met XG-voices.

3. Gebruik de knoppen [u]/[d] om de gewenste voice te selecteren en druk daarna op de 
knop [r] om deze op te roepen.
De display Voice wordt weergegeven met de huidige voice.

OPMERKING
U kunt tevens de voice wijzigen met behulp van de knoppen [l]/[r] terwijl de display Voice wordt weergegeven. 

4. Bespeel het toetsenbord.

885 875 845 835895GP 865GP

Voicecategorieën
Voicecategorieën

Voicecategorie

Voice 

Display Voice
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Met de Dual-functie kunt u twee verschillende voices in een laag spelen, en met de Split-functie kunt 
u verschillende voices in het rechter- en linkerdeel van het toetsenbord spelen. De Dual- en Split-functies kunnen 
tegelijkertijd worden gebruikt. Door voices te combineren kunt u weelderige instrumenttexturen en handige 
spelcombinaties maken.
Als Split is ingeschakeld, wordt de toets die het toetsenbord verdeeld in het linker- en rechtergedeelte 'splitpunt' 
genoemd en standaard ingesteld op de toets die is aangegeven in de onderstaande afbeelding. De splitpunttoets 
hoort bij het linkerhandbereik.

1. Druk meerdere keren op de knop [DUAL/SPLIT] om de Dual/Split-functie in te schakelen.
Druk één, twee of drie keer op de knop, afhankelijk van de functie die u wilt gebruiken. De weergave verschilt 
afhankelijk van de geactiveerde functie.

Voices combineren om te spelen (Dual/Split)

1

2

L R

R1

R2
L

Dual

Split

Dual + Split

Voice 1

Voice 2

Rechtervoice 1

Rechtervoice 2

RechtervoiceLinkervoice

Linkervoice

Splitpunt (standaard F#2) Centrale 'C' (C3)

885 875 845 835

2

1

2

1

895GP 865GP

Rechtervoice 1

Rechtervoice 2

Rechtervoice

Linkervoice

Linkervoice

Voice 1

Voice 2

Dual: Druk één keer op de knop

Split: Druk twee keer op de knop

Dual + Split: Druk drie keer 
op de knop
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2. Selecteer twee of drie voices.
2-1. Gebruik de knoppen [u]/[d] om het deel (1/2, R/L of R1/R2/L) te selecteren.
2-2. Gebruik de knoppen [l]/[r] om de voice te selecteren.

U kunt de voice ook selecteren door op de knop [VOICE] te drukken om de lijst met voicecategorieën op 
te roepen (pagina 26).

3. Bespeel het toetsenbord.

4. Druk na afloop van uw spel op de knop [DUAL/SPLIT] om de Dual/Split-functie uit 
te schakelen.

Het splitpunt (de grens tussen de gebieden voor de rechter- en linkerhand) 
wijzigen

Houd, terwijl de splitfunctie is ingeschakeld, de knop [DUAL/SPLIT] ingedrukt en druk op de toets die u als splitpunt 
wilt aanwijzen. De toets die wordt aangewezen als splitpunt, hoort bij het linkerhandgebied.

Spelen met twee spelers in hetzelfde octaafbereik (Duo)
Met de Duo-functie kunnen twee verschillende spelers het rechter- en linkergedeelte van het toetsenbord 
bespelen dat bij het splitspunt is verdeeld. Twee spelers kunnen in hetzelfde octaafbereik spelen. U kunt 
deze functie in- of uitschakelen via 'Keyboard' in het menu System (pagina 51). Raadpleeg de naslaggids 
voor meer informatie.

OPMERKING
Als Duo is ingeschakeld, wordt het rechterpedaal het demperpedaal voor de rechterspeler, het linkerpedaal wordt het demperpedaal voor de 
linkerspeler en het middelste pedaal wordt het demperpedaal voor zowel de rechter- als de linkerspeler.

Splitpunt (standaard F#2) Centrale 'C' (C3)

clp885_nl_om.book  Page 28  Friday, January 26, 2024  6:12 PM



29 CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP Gebruikershandleiding

Het toetsenbord bespelen tijdens het afspelen 
van een ritme

Als u de ritmefunctie gebruikt in plaats van de metronoom, speelt u niet alleen met een nauwkeurig tempo, maar 
kunt u ook met meer plezier spelen met dynamische ritmeweergave in het gewenste muziekgenre.

1. Druk op de knop [RHYTHM] om het afspelen van het ritme te starten.
Het afspelen van de intro start, gevolgd door het afspelen van het ritme.

2. Gebruik de knoppen [l]/[r] om het gewenste ritme op te roepen.

3. Bespeel het toetsenbord terwijl een ritme wordt afgespeeld.
De ritmes bestaan uit drum- en basbegeleiding. Het geluid van de basbegeleiding verandert automatisch op 
basis van de akkoorden die op de toetsen worden gespeeld.

Het tempo van het ritme is gelijk aan het tempo ingesteld voor de metronoom (pagina 25). Druk op de knop 
[TEMPO] en gebruik de knoppen [l]/[r] om het tempo aan te passen.

OPMERKING
• Zie commercieel beschikbare akkoordenboeken voor meer informatie over het spelen van akkoorden. 9e, 11e en 13e akkoorden worden 

niet herkend.

• Het volume, basgeluid aan/uit en 'intro' en 'einde' aan/uit kan worden ingesteld in het menu Metronome/Rhythm (pagina 51). Raadpleeg de 
naslaggids voor meer informatie.

4. Druk nogmaals op de knop [RHYTHM] om het afspelen van het ritme te stoppen.
Het ritme stopt automatisch nadat een einde is afgespeeld.

885 875 845 835

1, 4

2

1, 4

2

895GP 865GP

Display Ritme Display Ritme
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Songs zoals vooraf ingestelde songs en 
opgenomen songs afspelen 

Vooraf ingestelde songs, door u opgenomen spel en in de handel verkrijgbare songs die op dit instrument kunnen 
worden afgespeeld, worden in deze handleiding 'songs' genoemd. Naast het luisteren naar deze songs kunt u deze 
songs ook gebruiken om mee te oefenen. 

Er zijn twee soorten songs, zoals hieronder beschreven. 

• MIDI-songs
Een MIDI-song bestaat uit de uitvoeringsgegevens van uw toetsenspel en is geen opname van het werkelijke 
geluid zelf. De performance-informatie heeft betrekking op welke toetsen zijn ingedrukt, met welke timing en 
kracht – net als in een muzieknotatie. Op basis van de opgenomen performance-informatie worden de geluiden 
die in het instrument zijn ingebouwd via de luidsprekers weergegeven. MIDI-songs zijn handig om mee te 
oefenen; u kunt de rechterhand- en de linkerhandpartijen onafhankelijk van elkaar afspelen en u kunt ook het 
gespecificeerde gedeelte van de song herhaaldelijk afspelen.

• Audiosongs
Een audiosong daarentegen, is een opname van het gespeelde geluid zelf. Deze data worden op dezelfde 
manier opgenomen als bij het opnemen van voicerecorders enz.

Songs die op dit instrument kunnen worden afgespeeld
• Vooraf ingestelde MIDI-songs (zie 'Lijst met songs' op pagina 57)

• Op dit instrument opgenomen MIDI-songs/audiosongs (zie pagina 37 voor instructies voor opnemen)

• Commercieel verkrijgbare songs met de volgende opmaak op het USB-stick dat is aangesloten 
op de USB [TO DEVICE]-aansluiting
- MIDI-songs: SMF (Standard MIDI File)
- Audiosongs: WAV (44,1 kHz, 16-bits, stereo)

OPMERKING
Lees eerst 'De USB [TO DEVICE]-aansluiting gebruiken' op pagina 6 voordat u een USB-stick gaat gebruiken.
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1. (Alleen als u een song van een USB-stick wilt afspelen) Sluit het USB-stick aan op de USB [TO 
DEVICE]-aansluiting.

2. Druk op de knop [SONG/DEMO] om de lijst met songcategorieën op te roepen.

OPMERKING
• Zie de 'Lijst met songs' op pagina 57 voor een lijst met vooraf ingestelde songs. Zie de 'Voicelijst' op pagina 52 om te bekijken welke voices 

demo's hebben.

• 'USB' wordt alleen weergegeven wanneer een USB-stick is aangesloten.

• MIDI-songs kunnen van een USB-stick worden gekopieerd of verplaatst naar 'Gebruiker' via 'Bestand' in het menu Song (pagina 51). 
Raadpleeg de naslaggids voor meer informatie.

• Met de Smart Pianist-app (pagina 46) kunt u de bladmuziek van de '50 Classis' en 'Lesson'-songs op uw smartapparaat bekijken.

3. Gebruik de knoppen [u]/[d] om de songcategorie (map) te selecteren en druk daarna 
op de knop [r] om deze op te roepen.
De songs in de geselecteerde map worden weergegeven. Als de map een andere map bevat, herhaal dan 
dezelfde handeling. Om een map opnieuw te selecteren, drukt u op de knop [<] om terug te keren naar 
de lijst met songcategorieën.

Songcategorie Indeling Omschrijving

Demo MIDI
Voicedemo's laten u de kenmerken van de voices ervaren (pagina 26). 
Demo's zijn slechts voor enkele voices beschikbaar.

50 Classics 
(50 klassiekers)

MIDI
De vooraf ingestelde pianosongs uit het muziekboek '50 Classical Music 
Masterpieces', die bij dit instrument worden meegeleverd.

Lesson (Les) MIDI
De vooraf ingestelde songs die uitstekend geschikt zijn om te oefenen, uit 'The 
Virtuoso Pianist' en andere boeken. Lessongs zijn in verschillende mappen 
ingedeeld, afhankelijk van het type albums.

User (Gebruiker) MIDI
Songs die op het instrument zijn opgenomen en opgeslagen met de functie 
Record (pagina 37) en songs die naar het instrument zijn gekopieerd/verplaatst 
met behulp van een USB-flashdrive.

USB
MIDI Songs opgeslagen op het USB-stick dat is aangesloten op de USB 

[TO DEVICE]-aansluiting. De songs die op dit instrument worden opgenomen, 
worden opgeslagen in de map 'USER FILES'.Audio

5

3, 4

2 5

3, 4

2

885 875 845 835895GP 865GP

Songcategorieën
Songcategorieën
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4. Gebruik de knoppen [u]/[d] om de song te selecteren en druk daarna op de 
knop [r] om deze op te roepen.
De display Song wordt weergegeven en u kunt de naam van de huidige geselecteerde song en 
categorienaam zien.

OPMERKING
Wanneer de naam van de song te lang is om te worden weergegeven, drukt u op de knop [d] om de volledige naam te bekijken.

5. Druk op de knop [PLAY/PAUSE] om het afspelen te starten.
De huidige positie voor het afspelen van de song verschijnt op de display. Het huidige maatnummer wordt 
getoond voor MIDI-songs en de verstreken tijd wordt getoond voor audiosongs. De knop [PLAY/PAUSE] 
knippert tijdens het afspelen.

De song stopt automatisch als het einde van de song is bereikt. Om het afspelen van de song te onderbreken, 
drukt u op de knop [PLAY/PAUSE].

Snel vooruitspoelen/Terugspoelen

Druk, terwijl de display Song wordt weergegeven, op de knop [l] om terug te spoelen en druk op de knop [r] om 
snel vooruit te spoelen. De display toont de huidige afspeelpositie (maatnummer/verstreken tijd).

Terugkeren naar het begin van de song

• CLP-885/CLP-875/CLP-895GP: Houd de knop [MENU] ingedrukt terwijl de display Song wordt weergegeven 
totdat de songpositie terugkeert naar het begin.

• CLP-845/CLP-835/CLP-865GP: Druk tegelijkertijd op de knoppen [l] en [r] terwijl de display Song wordt 
weergegeven.

Snel vooruitspoelen/Terugspoelen/Terugkeren naar het begin 
van de song

Songnaam

Display Song (MIDI-song)

Categorienaam

Songnaam

Display Song (Audio-song)

Categorienaam

Display Song (MIDI-song) Display Song (Audio-song)

Huidige positie Maatnummer Huidige positie Verstreken tijd (min.: sec.)
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1. Druk tijdens het afspelen van de song op de knop [TEMPO] om de display Tempo 
op te roepen.
Wanneer een MIDI-song geselecteerd is en de display Song wordt weergegeven, kunt u de display Tempo 
oproepen terwijl de song gestopt is.

2. Gebruik de knoppen [l]/[r] om het tempo te wijzigen.
Voor MIDI-songs verschilt het tempo afhankelijk van de maatsoort van de geselecteerde song. Voor 
audiosongs kan het tempo worden aangepast over een bereik van 75%-125%, waarbij 100% de 
oorspronkelijke snelheid is.

OPMERKING
Wanneer een MIDI-song geselecteerd is, zijn alleen even nummers beschikbaar voor de tempowaarde, afhankelijk van de maatsoort van de 
geselecteerde song. Zie het gedeelte 'Time Signature' in het menu Metronome/Rhythm in de naslaggids voor meer informatie.

Volg de onderstaande instructies om terug te gaan naar het oorspronkelijke tempo.
• CLP-885/CLP-875/CLP-895GP: Houd de knop [MENU] ingedrukt tot het tempo wordt teruggezet op de 

standaardwaarde.
• CLP-845/CLP-835/CLP-865GP: Druk gelijktijdig op de knoppen [l] en [r].

Een volledige song of meerdere songs herhaaldelijk afspelen

U kunt de geselecteerde song of alle songs in de geselecteerde map continu afspelen. 

1. Selecteer een song die u wilt afspelen (pagina 31).

2. Druk enkele keren op de knop [MENU] om het menu Song op te roepen (pagina 51).

3. Gebruik de knoppen [u]/[d] om 'Repeat' te selecteren en druk daarna op de knop [r] 
om de functie op te roepen. 

Het tempo/de snelheid aanpassen

Herhaaldelijk afspelen gebruiken

Display Tempo (MIDI-song) Display Tempo (Audiosong)

Tempowaarde Percentage ten 
opzichte van de 
oorspronkelijke 
snelheid
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4. (Alleen wanneer een MIDI-song is geselecteerd) Gebruik de knoppen [u]/[d] om 'Song' te 
selecteren en druk daarna op de knop [r] om de functie op te roepen.
Wanneer een audiosong is geselecteerd, dan hoeft deze stap niet te worden uitgevoerd.

5. Gebruik de knoppen [u]/[d] om de herhaalfunctie te selecteren.

• Off (uit): Herhaaldelijk afspelen is uitgeschakeld. Het afspelen stopt automatisch als het einde van de song 
is bereikt.

• Single (enkel): Speelt alleen de geselecteerde song herhaaldelijk af.
• All (alle): Speelt alle songs in de map die de geselecteerde song bevat in numerieke volgorde af.
• Random (willekeurig): Speelt alle songs in de map die de geselecteerde song bevat in willekeurige 

volgorde af.

6. Druk op de knop [PLAY/PAUSE] om het afspelen te starten.
Als u de display Song oproept door op de knop [EXIT] te drukken, kunt u de status van het herhaaldelijk 
afspelen controleren.

Het afspelen gaat door totdat u opnieuw op de knop [PLAY/PAUSE] drukt. Om het herhaaldelijk afspelen te 
stoppen, selecteert u 'Off' (Uit) in het scherm van stap 5.

Een bepaald gedeelte van een song herhaaldelijk afspelen 
(A-B Repeat; alleen MIDI-songs)

Een bepaald gedeelte van de geselecteerde MIDI-song kan herhaaldelijk worden afgespeeld. Dit wordt de functie 
A-B Repeat genoemd en hiermee kunt u een deel van een song herhaaldelijk oefenen.

1. Selecteer een MIDI-song die u wilt afspelen (pagina 31).

2. Druk enkele keren op de knop [MENU] om het menu Song op te roepen (pagina 51).

3. Gebruik de knoppen [u]/[d] and [r] om 'Repeat' gevolgd door 'A-B' te selecteren en 
roep display A-B Repeat op te roepen.

Single (enkel)

All (alle)

Random (willekeurig)

Display A-B Repeat
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4. Druk op de knop [PLAY/PAUSE] om het afspelen te starten.
OPMERKING
Om het begin van de song als startpunt (A) te specificeren, gaat u eerst naar stap 5 en start vervolgens het afspelen. Ga hierna verder met stap 6.

5. Druk op de knop [r] aan het beginpunt (A) van het gedeelte dat moet worden herhaald.

6. Druk nogmaals op de knop [r] aan het eindpunt (B).
Na een automatische inleiding (om u te helpen in de frase te komen), wordt het gedeelte van punt A tot punt B 
herhaaldelijk afgespeeld. Druk op de knop [PLAY/PAUSE] om de song op elk gewenst moment te onderbreken. 

OPMERKING
Om het einde van de song als eindpunt (B) te specificeren, speelt u de song af tot het einde. Het punt B wordt automatisch ingesteld zonder dat 
u op een knop hoeft te drukken.

Als u de display Song oproept door op de knop [EXIT] te drukken, wordt het pictogram (  ) rechtsboven in 
de display weergegeven om aan te geven dat de functie A-B Repeat is ingeschakeld.

7. Druk op de knop [r] in de display A-B Repeat terwijl 'Repeat Off' is geselecteerd om 
A-B Repeat uit te schakelen.

Als u een andere song selecteert, wordt A-B herhalen ook uitgeschakeld.

Sommige MIDI-songs, zoals vooraf ingestelde songs in de '50 Classics' en 'Lesson', zijn verdeeld in een partij voor 
de rechterhand en voor de linkerhand. Bij het spelen van deze songdata kunt u het toetsenbord met één hand 
bespelen terwijl u de partij van de andere hand afspeelt, zodat u de partijen afzonderlijk kunt oefenen om moeilijk 
materiaal gemakkelijk onder de knie te krijgen.

1. Selecteer een song die u wilt oefenen (pagina 31).

2. Druk enkele keren op de knop [MENU] om het menu Song op te roepen (pagina 51).

Een andere methode om een herhalingsbereik te 
specificeren 
1. Druk op de knop [u] om het maatnummer te markeren en druk 

vervolgens op de knoppen [l]/[r] om de gewenste maat voor punt 
A te selecteren.

2. Druk op de knop [d] om 'Set A' te markeren en druk daarna op de 
knop [r] om de instelling in te voeren.

3. Geef punt B op dezelfde manier op als punt A. 

Een éénhandspartij oefenen tijdens het afspelen van een song 
(alleen MIDI-songs)

65

2

1
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3. Gebruik de knoppen [u]/[d] om 'L/R' te selecteren en druk daarna op de knop [r] om 
de functie op te roepen.

4. Gebruik de knoppen [u]/[d]/[l]/[r] om het gewenste gedeelte om te oefenen – 'R' 
(rechts) of 'L' (links) – in te stellen op 'Off'.
Het gedeelte dat is ingesteld op 'Uit' wordt gedempt.

OPMERKING
• Gedeelten zonder data worden weergegeven met de markering '---'. 

• Een MIDI-song bestaat uit 16 tracks (gedeelten) en meestal wordt track 1 toegewezen aan 'R', track 2 aan 'L' en tracks 3-16 aan 'Extra'. 

• Als u een andere song selecteert, worden alle gedeelten opnieuw ingesteld op aan.

5. Druk op de knop [PLAY/PAUSE] om het afspelen te starten en het spelen van het 
gedeelte dat u hebt uitgeschakeld te oefenen.
De song stopt automatisch als het einde van de song is bereikt. Om het afspelen van de song te onderbreken, 
drukt u op de knop [PLAY/PAUSE].

Om effectiever te oefenen, kunt u gemakkelijk het tempo aanpassen (pagina 33) en de functie A-B Repeat 
(pagina 34) gebruiken.

De onderstaande extra functies zijn handig voor het afspelen van songs en kunnen worden ingesteld in de display 
Menu (pagina 51). Raadpleeg de naslaggids voor meer informatie.

• Het afspelen starten/onderbreken met een pedaal: Dit kan worden ingesteld via 'Pedal' > 'Play/Pause' in het 
menu System.

• De toonhoogte van een song transponeren: Dit kan worden ingesteld via 'Transpose' in het menu Song.

• De volumebalans tussen uw toetsenspel en het afspelen van de song aanpassen: Dit kan worden ingesteld 
via 'Volume' in het menu Song.

Andere handige functies voor het afspelen van songs

5

3, 4

5

3, 4
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Menu Song Menu Song
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Uw spel opnemen

Dit instrument heeft twee verschillende opnamemethoden die u kunt gebruiken, afhankelijk van uw doeleinden.

• MIDI-opname
Met deze methode wordt opgenomen spel opgeslagen als een SMF (indeling 0) MIDI-song op het instrument of 
een USB-stick. Een MIDI-song gebruikt een kleine hoeveelheid datacapaciteit in vergelijking met een audiosong. 
Met MIDI-opname kunt u elke partij (zoals de rechter- en linkerhandpartij) afzonderlijk opnemen. Aangezien een 
MIDI-song kan worden bewerkt, kunt u deze methode gebruiken als u een specifiek deel opnieuw wilt opnemen 
of parameters zoals Voice wilt wijzigen. Omdat een MIDI-song na opname kan worden geconverteerd naar een 
audiosong, wilt u wellicht eerst MIDI-opname (met overdubben en meerdere partijen) gebruiken om een complex 
arrangement te maken dat u niet live zou kunnen spelen en dit vervolgens naar een audiosong converteren. Op 
dit instrument kunt u ca. 500 KB data per song opnemen.

• Audio-opname
Bij deze methode wordt opgenomen spel als een audiobestand opgeslagen op een USB-stick als een audiosong 
in WAV-indeling (44,1 kHz, 16 bits, stereo). De geluidsinvoer van het aangesloten externe apparaat (computer, 
smartphone, audiospeler enz.) kan ook samen met uw toetsenspel worden opgenomen. Op dit instrument kan tot 
80 minuten per opname worden opgeslagen.

OPMERKING
• In deze handleiding verwijst 'geluidsinvoer' naar audiogegevens die worden ingevoerd naar het instrument vanaf aangesloten externe apparaten met 

behulp van een van deze methoden: USB Audio-interfacefunctie, Bluetooth-audiofunctie (pagina 43), [AUX IN]-aansluiting (pagina 45) of wifi 
(pagina 47). 

• MIDI-songs kunnen worden geconverteerd naar audiosongs via 'File' > 'MIDI to Audio' in het menu Song (pagina 51). Raadpleeg de naslaggids voor 
meer informatie.

In dit gedeelte wordt uitgelegd hoe u een nieuw spel opneemt en opslaat op het instrument als een MIDI-song.

1. Geef de nodige instellingen op, zoals voiceselectie.
Als u functies zoals Dual, Split en metronoom wilt gebruiken, schakelt u ze hier in. 
Als u het ritme wilt afspelen, selecteert u het hier, maar zorg ervoor dat u het afspelen start in stap 3. Als u hier 
het afspelen van het ritme start, wordt het afspelen gestopt als u naar de volgende stap gaat.

OPMERKING
Het geluid van de metronoom wordt niet opgenomen. Het ritme wordt standaard opgenomen, maar u kunt in het menu Recording instellen of het 
ritme al dan niet moet worden opgenomen (pagina 51).

2. Druk op de knop [REC] om de opname op stand-by te zetten.
De display REC verschijnt en de knop [PLAY/PAUSE] knippert.

Opnemen op het instrument (MIDI-opname)
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OPMERKING
Als u de knop [REC] even ingedrukt houdt, verschijnt er een lijst waarmee u de gewenste opnamedoelsong kunt selecteren (stap 3 op pagina 39). 
Selecteer 'New MIDI' in deze lijst.

3. Start de opname en speel op het toetsenbord.
Door op het toetsenbord te spelen wordt de opname automatisch gestart. Als u een stukje stilte wilt opnemen 
aan het begin van de song, drukt u op de knop [PLAY/PAUSE] om de opname te starten. Tijdens het opnemen 
loopt het maatnummer op het scherm vooruit.
Als u wilt opnemen terwijl met ritmeweergave, drukt u op de knop [RHYTHM] op het moment dat u het 
afspelen van het ritme wilt starten. Druk op de knop [RHYTHM] om de opname en het afspelen van het ritme 
tegelijkertijd te starten.

4. Als u klaar bent met uw spel, drukt u opnieuw op de knop [REC] om de opname te stoppen.

5. Gebruik in de display 'Confirm' de knoppen [u]/[d] om 'Save' te selecteren en druk 
daarna op de knop [r] om de gegevens op te slaan.
Als u opnieuw wilt opnemen, selecteert u 'Retry' en keert u terug naar stap 3.
Als u de gegevens niet wilt opslaan en dit scherm wilt afsluiten, selecteert u 'Cancel'.

Nadat de bewerking is voltooid, verschijnt het bericht 'Save Completed' en keert u terug naar de display Song. 
De opgenomen song heeft de naam 'USERSONG***' (***: nummer) en wordt opgeslagen in de categorie 
'User' (pagina 31).

LET OP
De opgenomen song gaat verloren als u overschakelt naar een andere song of als u het instrument uitschakelt zonder eerst 
op te slaan.

OPMERKING
U kunt de songnaam desgewenst wijzigen via 'File' in het menu Song (pagina 51). Raadpleeg de naslaggids voor meer informatie.

6. Druk op de knop [PLAY/PAUSE] om het opgenomen spel af te spelen.

885 875 845 835895GP 865GP

Knippert Knippert

Display REC
Display REC

Maatnummer
Maatnummer
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In dit gedeelte wordt uitgelegd hoe u een nieuw spel opneemt en opslaat op het USB-stick als een MIDI-song of een 
audiosong.

OPMERKING
Lees eerst 'De USB [TO DEVICE]-aansluiting gebruiken' op pagina 6 voordat u een USB-stick gaat gebruiken.

1. Sluit het USB-stick aan op de USB [TO DEVICE]-aansluiting.

2. Geef de nodige instellingen op, zoals voiceselectie.
Als u functies zoals Dual, Split en metronoom wilt gebruiken, schakelt u ze hier in.
Als u het ritme wilt afspelen, selecteert u het hier, maar zorg ervoor dat u het afspelen start in stap 6. Als u hier het 
afspelen van het ritme start, wordt het afspelen gestopt als u naar de volgende stap gaat.

OPMERKING
Het geluid van de metronoom wordt niet opgenomen. Het ritme wordt standaard opgenomen, maar u kunt in het menu Recording instellen of het 
ritme al dan niet moet worden opgenomen (pagina 51).

3. Houd de knop [REC] een seconde ingedrukt om een lijst met opnamedoelsongs op te roepen.

4. Gebruik de knoppen [u]/[d] om 'New MIDI (USB)' of 'New Audio (USB)' te selecteren.
• New MIDI (USB) (Nieuwe MIDI [USB]): Voor het opnemen van een nieuwe MIDI-song en deze op te slaan op 

het USB-stick.
• New Audio (USB) (Nieuwe audio [USB]): Voor het opnemen van een nieuwe audiosong en deze op te slaan 

op het USB-stick.

OPMERKING
• 'New MIDI (USB)' en 'New Audio (USB)' kan alleen worden geselecteerd wanneer het USB-stick is aangesloten op de USB [TO DEVICE]-aansluiting.
• 'New MIDI' is voor het opnemen van een nieuwe MIDI-song en deze op te slaan op het instrument (hetzelfde als stap 2 op pagina 37).

5. Druk op de knop [r] om de opname op stand-by te zetten.
De display REC verschijnt en de knop [PLAY/PAUSE] knippert.

6. Voer dezelfde handelingen uit als in stap 3-6 op pagina 38.
De opgenomen song krijgt de naam 'USERSONG***.mid' voor MIDI-songs en 'USERAUDIO***.wav' voor audiosongs 
(***: nummer) en wordt opgeslagen in de map 'USER FILES' van het USB-stick. 

Opnemen op een USB-stick (MIDI-opname/audio-opname)

3
3

4, 5
4, 5

885 875 845 835895GP 865GP

Opnamedoellijst
Opnamedoellijst

clp885_nl_om.book  Page 39  Friday, January 26, 2024  6:12 PM



Uw spel opnemen

40 CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP Gebruikershandleiding

Met MIDI-opname kunt u rechterhand- en linkerhandpartijen onafhankelijk van elkaar opnemen en opslaan als een 
enkele song. Hiermee kunt u een stuk maken dat live moeilijk te spelen zou zijn met beide handen tegelijkertijd. 
Dit kan ook handig zijn om kinderen te laten oefenen, bijvoorbeeld door de uitvoering van een ouder of leerkracht 
op te nemen en het kind een handpartij te laten spelen terwijl tegelijkertijd de modelpartij wordt afgespeeld.

1. Geef de nodige instellingen op, zoals voiceselectie.
Als u de opgenomen gegevens op een USB-stick wilt opslaan, sluit u een USB-stick aan op de USB [TO 
DEVICE]-aansluiting.

2. Druk op de knop [REC] om de opname op stand-by te zetten.
De display REC verschijnt en de knop [PLAY/PAUSE] knippert. 

OPMERKING
Om op te nemen op het USB-stick, houdt u de knop [REC] ingedrukt tot de lijst met opnamedoelsongs (stap 3 op pagina 39) verschijnt en 
selecteert u vervolgens 'New MIDI (USB)'.

3. Gebruik de knoppen [l]/[r] om het eerste gedeelte voor opname te selecteren: 'R' 
(rechterhand) of 'L' (linkerhand).

4. Start de opname en speel op het toetsenbord.
Door op het toetsenbord te spelen wordt de opname automatisch gestart. Als u een stukje stilte wilt opnemen 
aan het begin van de song, drukt u op de knop [PLAY/PAUSE] om de opname te starten.

5. Als u klaar bent met uw spel, drukt u opnieuw op de knop [REC] om de opname te stoppen.

6. Gebruik in de display 'Confirm' de knoppen [u]/[d] om 'Save' te selecteren en druk 
daarna op de knop [r] om de gegevens op te slaan.
Als u opnieuw wilt opnemen, selecteert u 'Retry' en keert u terug naar stap 3.
Als u de gegevens niet wilt opslaan en dit scherm wilt afsluiten, selecteert u 'Cancel'.

Nadat de bewerking is voltooid, verschijnt het bericht 'Save Completed' en keert u terug naar de display Song. 
De opgenomen song krijgt de naam 'USERSONG***' (***: nummer) en wordt opgeslagen in de categorie 
'User' (pagina 31).

LET OP
De opgenomen song gaat verloren als u overschakelt naar een andere song of als u het instrument uitschakelt zonder eerst 
op te slaan.

7. Druk op de knop [PLAY/PAUSE] om het opgenomen spel af te spelen.

8. Houd de knop [REC] een seconde ingedrukt om een lijst met opnamedoelsongs 
op te roepen.

De rechter- en linkerhandpartijen onafhankelijk van elkaar 
opnemen (MIDI-opname)

Display REC

Opnamepartij

clp885_nl_om.book  Page 40  Friday, January 26, 2024  6:12 PM



Uw spel opnemen

41 CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP Gebruikershandleiding

9. Gebruik de knop [d] om de MIDI-song te selecteren (onderaan de lijst) die is 
opgeslagen in stap 6 en druk daarna op de knop [r].

10.Gebruik de knoppen [l]/[r] om het tweede gedeelte voor opname te selecteren: 
'R' (rechterhand) of 'L' (linkerhand).

LET OP
Houd er rekening mee dat bij het opnemen van uw spel op een partij (track) die data bevat, de eerder opgenomen data wordt 
overschreven.

11. Volg dezelfde handelingen als in stap 4-6 en overschrijf de opgenomen data.
Tijdens het opnemen wordt de eerder opgenomen partij afgespeeld.
Druk na het opslaan van de data op de knop [PLAY/PAUSE] om het opgenomen spel te beluisteren.

OPMERKING
• Als u een partij opnieuw wilt opnemen nadat u de data hebt opgeslagen, begint u bij stap 8. Als uw gewenste song niet wordt weergegeven 

in stap 9, drukt u op de knop [SONG] en selecteert u de gewenste song en begint u opnieuw vanaf stap 8. Selecteer in stap 10 de partij die 
u opnieuw wilt opnemen.

• Om de data van een partij te verwijderen, selecteert u de gewenste partij (track) in 'Edit' > 'Track Delete' in het menu Song (pagina 51). 
'R' is hetzelfde als track 1, en 'L' hetzelfde als track 2. Raadpleeg de naslaggids voor meer informatie.

Overdubben van meerdere partijen (opname van meerdere tracks)

Met MIDI-opname kunt u een MIDI-song maken met in totaal 16 tracks door uw spel track voor track op te nemen. 
Zoals in het gedeelte hierboven is beschreven, werd de rechterhandpartij opgenomen op 'R' (track 1) en vervolgens 
werd de linkerhandpartij opgenomen op 'L' (track 2). In stap 3 of 10 kan een andere track van 'Track3' – 'Track16' 
worden geselecteerd, zodat u opnamedata kunt toevoegen aan extra tracks en alles samen kunt opslaan als een 
song. Op deze manier kunt u een duetsong alleen opnemen, maar u kunt ook nog complexere songs maken.

• Als Dual/Split/Duo is ingeschakeld (pagina 27), wordt alleen het spel van rechtervoice 1 (voor Dual) en de 
rechtervoice (voor Split/Duo) opgenomen op de geselecteerde track. De rechtervoice 2 (voor Dual) wordt 
opgenomen op het tracknummer dat 6 plus de geselecteerde track is, en de linkervoice (voor Split/Duo) wordt 
opgenomen op het tracknummer dat 3 plus de geselecteerde track is. Als het tracknummer boven de 16 komt, 
begint de tracktelling opnieuw vanaf het begin. 

• Bij het opnemen van het ritme (pagina 29) kunnen de gewenste tracks niet vrij gekozen worden. De drumpartij 
wordt opgenomen op track 9 en 10 en de baspartij wordt opgenomen op track 11.

LET OP
Als u uw spel opneemt op een track die al data bevat, worden de eerder opgenomen data overschreven. Let goed op wanneer Dual, 
Split of Duo is ingeschakeld, want dan worden de opnametracks automatisch toegewezen. Om te zien welke track data bevat, 
controleert u de display REC (stap 10 hierboven).

OPMERKING
De gegevens van elke track kunnen afzonderlijk worden afgespeeld via 'Others' > 'Play Track' in het menu Song (pagina 51). Raadpleeg de naslaggids 
voor meer informatie.

Opnamepartij (track)

Status van trackdata

 : Bevat data

 : Bevat geen data

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16Voorbeeld van 
opnametracks

Rechterhandpartij

Linkerhandpartij

Rechtervoice 
2 in Dual

Ritme  
(baspartij)

Ritme 
(drumpartij)
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U kunt songs verwijderen die zijn opgenomen en opgeslagen op het instrument of het USB-stick. U kunt de 
geselecteerde songs één voor één verwijderen, of alle songs van de categorie 'User' van het instrument 
verwijderen, of alle songs in de map 'USER FILES' van het aangesloten USB-stick verwijderen.

OPMERKING
De songs in de map 'USER FILES' van het USB-stick worden niet verwijderd.

1. Selecteer de song (pagina 31) die u wilt verwijderen.
Om alle songs in de categorie 'User' van het instrument te verwijderen of om alle songs in de map 'USER 
FILES' te verwijderen, selecteert u één van de songs in de map.

2. Druk enkele keren op de knop [MENU] om het menu Song op te roepen (pagina 51).

3. Gebruik de knoppen [u]/[d] om 'File' te selecteren en druk daarna op de knop [r] om 
de functie op te roepen.

4. Gebruik de knoppen [u]/[d] om 'Delete' of 'Delete All' te selecteren en druk daarna op 
de knop [r] om het daadwerkelijk te selecteren.

5. Gebruik de knoppen [u]/[d] om 'Execute' te selecteren en druk daarna op de knop [r] 
om de bewerking uit te voeren.
Het bericht 'Executing' wordt weergegeven. Nadat de bewerking is voltooid, verschijnt het bericht 'Completed' 
en keert u terug naar de display voor songselectie.

LET OP
Zet het instrument niet uit en koppel het USB-stick niet los terwijl 'Executing' in de display wordt weergegeven. Hierdoor kan 
de data worden beschadigd.

OPMERKING
Om de data van elke partij (track) te verwijderen, selecteert u 'Edit' > 'Track Delete' in het menu Song (pagina 51). Raadpleeg de naslaggids voor meer 
informatie.

Opgenomen data voor MIDI-songs

Data voor afzonderlijke partijen
• Nootdata (toetsenspel)
• Voiceselectie
• Pedaalbewerkingen (demper, soft, sostenuto)
• Grand Expression Modelling-data
• De volgende instellingen kunnen worden ingesteld in het menu Voice 

(pagina 51)
- Voice Edit (Voice bewerken)  

Octave (Octaaf), Volume, Reverb Depth (Galmdiepte), Chorus Depth 
(Chorusdiepte), Effect, Effect depth (Effectdiepte), Pan, Harmonic Content 
(Harmonische inhoud), Brightness (Helderheid), Touch

- Balance (Balans)  
Detune (Ontstemming) (alleen wanneer Dual is ingeschakeld)

Data voor alle partijen
• Stemschaal
• Tempo
• Maatsoort
• Reverbtype
• Chorustype

De opgenomen songs verwijderen

3 4 5

Menu Song
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Verbinding maken met andere apparaten

Door externe apparaten aan te sluiten op dit instrument beschikt u over nog meer spelopties. Zie 'Bedieningspaneel 
en aansluitingen' op pagina 12 voor informatie over de locatie van deze aansluitingen.

VOORZICHTIG
Schakel alle apparaten uit voordat u het instrument aansluit op andere elektrische apparaten. Zorg er tevens voor dat u alle 
volumeniveaus op het minimum (0) instelt, voordat u apparaten aan- of uitzet. Anders kunnen de apparaten beschadigd raken 
of kan zich een elektrische schok of zelfs blijvend gehoorverlies voordoen.

LET OP
Leg apparaten niet op een instabiel oppervlak neer. Wanneer u dat wel doet, kan het apparaat vallen en beschadigd raken.

Als u een audiospeler zoals een smartphone of tablet aansluit op het instrument, kunt u audio van dat aangesloten 
apparaat uitvoeren via de luidsprekers van het instrument. De audiospeler kan worden aangesloten via de 
Bluetooth-audiofunctie, de [AUX IN]-aansluiting of de USB [TO HOST]-aansluiting.

Via Bluetooth koppelen (Bluetooth-audiofunctie)

Een met Bluetooth uitgeruste audiospeler kan worden aangesloten via de Bluetooth-audiofunctie. De audioweergave 
van het aangesloten apparaat wordt uitgevoerd vanaf de ingebouwde luidsprekers van het instrument.

OPMERKING
• Het instrument beschikt mogelijk niet over de functie, afhankelijk van het land waarin u het product (pagina 21) kocht.

• Om de Bluetooth-functie via draadloze communicatie te gebruiken, moet de audiospeler uitgerust zijn voor het verzenden van audiogegevens. Voor 
een juiste werking moet het apparaat compatibel zijn met A2DP (Advanced Audio Distribution Profile - Geavanceerd audiodistributieprofiel). 

• Aangezien dit instrument geen audiogegevens kan verzenden naar externe apparaten via Bluetooth, kunnen Bluetooth-hoofdtelefoons of -
luidsprekers niet worden aangesloten.

Om te koppelen via Bluetooth, moet de Bluetooth-functie van dit instrument ingeschakeld zijn. De Bluetooth-functie 
is standaard ingeschakeld, maar kan worden in- of uitgeschakeld via 'Bluetooth' in het menu System (pagina 51). 
Raadpleeg de naslaggids voor meer informatie.

Luisteren naar het afspelen van een audiospeler via de 
luidsprekers van het instrument

Lees 'Bluetooth' op pagina 7 voordat u de Bluetooth-functie gebruikt.

Instrument
Met Bluetooth uitgeruste 

audiospeler

Bluetooth-audio
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1. (CLP-885/CLP-875/CLP-895GP) Houd de knop [ ] (Bluetooth) 3 seconden ingedrukt.  
(CLP-845/CLP-835/CLP-865GP) Houd de knop [MENU] 3 seconden ingedrukt.
Er verschijnt een bericht dat aangeeft dat het instrument in stand-by staat voor het koppelen (registreren) van 
het met Bluetooth uitgeruste apparaat.

Druk op de knop [EXIT] om het koppelen te annuleren.

2. Schakel de Bluetooth-functie op de audiospeler in en selecteer 'CLP-*** (modelnaam) 
AUDIO' in de lijst met verbindingen.
Raadpleeg de gebruikershandleiding van de audiospeler voor meer informatie. Na het koppelen wordt de 
status op de display getoond.

OPMERKING
• Voltooi de instellingen op de audiospeler binnen 5 minuten.

• Er kunnen tot 8 smart-apparaten met dit instrument worden gekoppeld, maar u kunt slechts één smart-apparaat tegelijk op dit instrument 
aansluiten. Wanneer de koppeling met het 9e smart-apparaat tot stand is gebracht, worden de koppelingsdata voor het apparaat met de 
oudste koppelingsdatum verwijderd.

• Als u een sleutel moet invoeren, voert u de cijfers '0000' in.

3. Speel audiodata af op de audiospeler om te controleren of de luidsprekers van het 
instrument audiogeluid kunnen uitvoeren.
Wanneer u het instrument de volgende keer inschakelt, maakt de laatst verbonden audiospeler automatisch 
verbinding met het instrument als de Bluetooth-functie van de audiospeler en het instrument is ingeschakeld. 
Als niet automatisch verbinding wordt gemaakt, selecteert u nogmaals de modelnaam van het instrument in 
de lijst met verbindingen op de audiospeler.

885 875 845 835895GP 865GP

Geeft aan dat audiogegevens 
kunnen worden ontvangen
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Met een audiokabel ([AUX IN]-aansluiting) aansluiten

U kunt de hoofdtelefoonaansluiting van een audiospeler aansluiten op de [AUX IN]-aansluiting van het instrument 
met behulp van een audiokabel. De audioweergave van het aangesloten apparaat wordt uitgevoerd vanaf de 
ingebouwde luidsprekers van het instrument.

LET OP
Om schade aan de apparaten te voorkomen, dient u eerst het externe apparaat en vervolgens het instrument in te schakelen. 
Als u de voeding wilt uitschakelen, dient u eerst het instrument en daarna pas het externe apparaat uit te schakelen.

OPMERKING
Gebruik audiokabels en adapterpluggen zonder weerstandwaarde.

Aansluiten met een USB-kabel (USB [TO HOST]-aansluiting)

Door een USB-kabel en een USB-conversieadapter te gebruiken, kunt u een audiospeler (of smartapparaat zoals 
smartphone) aansluiten op de USB [TO HOST]-aansluiting van het instrument. Met deze aansluiting kan het 
instrument worden gebruikt als een USB audio-interface, waardoor audiogegevens kunnen worden verzonden en 
ontvangen tussen het instrument en het aangesloten apparaat. Zie pagina 48 voor meer informatie.

LET OP
Gebruik een USB-kabel van het type AB die niet langer is dan 3 meter. U kunt geen USB 3.0-kabel gebruiken.

Instrument

Telefoonstekker (stereo mini) Telefoonstekker (stereo mini)

Audiospeler

Audiokabel

Hoofdtelefoonaansluiting

Audiosignaal

Voorbeeld
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Door verbinding te maken met een smartapparaat, zoals een smartphone of tablet, en Smart Pianist te gebruiken, 
heeft u toegang tot een aantal uitzonderlijk handige functies, zoals het bekijken van bladmuziek en het opnemen 
van uw spel op het apparaat. De intuïtieve visuele interface helpt u ook om de huidige instellingen van het 
instrument te bevestigen. 

Ga voor meer informatie over de app en compatibele apparaten naar de onderstaande website 
en bekijk de pagina 'Smart Pianist'.

https://yamaha.com/kbdapps/

Nadat u de Smart Pianist-app op uw smartapparaat heeft geïnstalleerd, sluit u dit instrument aan op het apparaat 
via USB-kabels, Bluetooth of een draadloos netwerk (wifi). Raadpleeg de 'Smart Pianist User Guide 
(Gebruikershandleiding Smart Pianist)' voor instructies over het aansluiten van het apparaat en het gebruik van de app.

LET OP
Alle instellingen op het instrument worden vervangen door de instellingen op Smart Pianist als het instrument is gekoppeld met 
Smart Pianist.

OPMERKING
Wanneer Smart Pianist is gekoppeld, kunt u het bedieningspaneel op het instrument niet gebruiken. Gebruik Smart Pianist om het instrument te 
bedienen. Om de verbinding met Smart Pianist te verbreken, sluit u Smart Pianist op het smartapparaat of drukt u op de knop [EXIT] op het instrument. 

Via Bluetooth koppelen

Om het instrument en een smartapparaat via Bluetooth te kunnen koppelen, moet u Bluetooth MIDI en Bluetooth-
audio afzonderlijk instellen. Om Smart Pianist te kunnen gebruiken, is een Bluetooth MIDI-verbinding nodig. Om vanaf 
het instrument naar audiogegevens op het slimme apparaat te luisteren, is ook een Bluetooth-audioverbinding vereist. 
Zodra de Bluetooth-verbinding tot stand is gebracht, verschijnt de verbindingsstatus op het scherm. 

OPMERKING
• Het instrument beschikt mogelijk niet over de functie, afhankelijk van het land waarin u het product (pagina 21) kocht.

• Wanneer het apparaat gekoppeld is via Bluetooth, kunt u geen opnames maken in audio-indeling met Smart Pianist. Sluit aan via USB-kabel 
(pagina 47) of wifi (pagina 47) om audio-opname mogelijk te maken.

1. Koppel het instrument en het smartapparaat via Bluetooth-audio (pagina 44).

Wanneer de koppeling tot stand is gebracht, kunnen audiogegevens worden ontvangen op het instrument. 
Hiermee kunt u luisteren naar audioweergave op het smartapparaat via de luidspreker van het toestel.

De handige Smart Pianist-app gebruiken

Lees 'Bluetooth' op pagina 7 voordat u de Bluetooth-functie gebruikt.

Geeft aan dat MIDI-gegevens kunnen 
worden verzonden/ontvangen

Geeft aan dat MIDI-gegevens kunnen 
worden verzonden/ontvangen en dat 
audiogegevens kunnen worden ontvangen

Instrument

Smartapparaat

Bluetooth-audio
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2. Door de Smart Pianist-app te gebruiken, koppelt u het instrument en het smartapparaat 
via Bluetooth MIDI.
Raadpleeg de 'Smart Pianist User Guide (Gebruikershandleiding Smart Pianist)' voor meer informatie over het 
aansluiten. Zorg ervoor dat u 'CLP-*** (modelnaam) MIDI' selecteert voor het koppelen.

Wanneer de verbinding tot stand is gebracht, kunnen MIDI-gegevens worden verzonden/ontvangen tussen 
het instrument en het smartapparaat. Hiermee kunt u uw toetsenspel in MIDI-indeling opnemen op het 
smartapparaat of luisteren naar de MIDI-song die op het smartapparaat wordt afgespeeld via de luidspreker 
van het instrument.

Aansluiten met een USB-kabel (USB [TO HOST]-aansluiting)

Door een USB-kabel en een USB-conversieadapter te gebruiken, kunt u een smartapparaat aansluiten op de USB 
[TO HOST]-aansluiting op het instrument. Raadpleeg de 'Smart Pianist User Guide (Gebruikershandleiding Smart 
Pianist)' voor instructies over het aansluiten.

LET OP 
Gebruik een USB-kabel van het type AB die niet langer is dan 3 meter. U kunt geen USB 3.0-kabel gebruiken.

Verbinding maken via een draadloos netwerk (wifi) met behulp van de 
UD-WL01 (afzonderlijk verkrijgbaar)

Om een wifi verbinding tot stand te brengen, is de afzonderlijk verkrijgbare UD-WL01 USB draadloze netwerkadapter 
vereist. Sluit de draadloze USB netwerkadapter aan op de USB [TO DEVICE]-aansluiting. Lees eerst 'De USB 
[TO DEVICE]-aansluiting gebruiken' op pagina 6 voordat u de draadloze USB-netwerkadapter gaat gebruiken.
Raadpleeg de 'Smart Pianist User Guide (Gebruikershandleiding Smart Pianist)' voor instructies over het aansluiten.

LET OP
Verbind dit product niet direct met een openbare wifi- en/of internetdienst. Verbind dit product alleen via een sterk beveiligde router 
met het internet. Raadpleeg de producent van de router voor informatie over optimale beveiligingsmaatregelen.

Bluetooth MIDI

Instrument

Smartapparaat

Instrument

Smartapparaat

USB-kabel

USB-conversieadapter

Voorbeeld

MIDI-gegevens/audiogegevens

Toegangspunt 
(router)

Draadloze USB-
netwerkadapter (UD-WL01)

Instrument

Smartapparaat

Voorbeeld

Draadloos 
netwerk

Draadloos 
netwerk
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Het instrument kan rechtstreeks via wifi worden verbonden zonder dat er een toegangspunt nodig is. In deze 
situatie wordt internettoegang echter uitgeschakeld op uw smartapparaat en kunnen sommige functies van Smart 
Pianist (zoals gegevens exporteren/importeren van en naar online opslag, firmware-update) niet worden gebruikt.

OPMERKING
• De draadloze USB-netwerkadapter (UD-WL01) is mogelijk niet beschikbaar, afhankelijk van uw regio.

• Een 'toegangspunt' verwijst naar een apparaat dat fungeert als basisstation wanneer gegevens worden verzonden/ontvangen via een draadloze 
USB-netwerkadapter. Sommige toegangspunten worden gecombineerd met router- of modemfuncties.

Door een computer aan te sluiten op de USB [TO HOST]-aansluiting met een USB-kabel, kunt u het instrument 
gebruiken als een USB-audio/MIDI-interface voor het zenden/ontvangen van MIDI-gegevens en audiogegevens 
tussen het instrument en de computer. Tot de verschillende mogelijkheden behoren de mogelijkheid om het 
instrument te bespelen en performancegegevens op te nemen met behulp van de computer, of muziekgegevens 
af te spelen op de computer en deze te beluisteren op het instrument.

LET OP
• Gebruik een USB-kabel van het type AB die niet langer is dan 3 meter. U kunt geen USB 3.0-kabel gebruiken.
• Als u een DAW-toepassing (digital audio workstation) gebruikt met dit instrument, stelt u de Audio loopback-functie in op 'off' 

(pagina 49). Als u dat niet doet, kunnen er harde geluiden ontstaan, afhankelijk van de instellingen van de computer.

OPMERKING
• Als u het instrument via een USB-kabel aansluit op uw computer, maakt u directe verbindingen zonder een USB-hub te gebruiken.

• Kort nadat de USB-verbinding tot stand is gebracht, begint het instrument met zenden.

• Als u MIDI-berichten verwant aan het Grand Expression Modelling-effect op een computer bewerkt, kunnen onverwachte geluiden (pagina 25) 
voorkomen.

Audiogegevens verzenden/ontvangen (USB-audio-interfacefunctie)

Door een computer of een smartapparaat via een USB-kabel aan te sluiten op de USB [TO HOST]-aansluiting, 
kunnen digitale audiogegevens worden verzonden/ontvangen. Deze USB-audio-interfacefunctie biedt de volgende 
voordelen:

• Audiogegevens worden weergegeven met een hoge geluidskwaliteit.
Dit geeft een direct, helder geluid waarbij minder ruis en verval van geluidskwaliteit optreedt dan bij de 
[AUX IN]-aansluiting.

• Muziekspel op het instrument kan worden opgenomen als audiogegevens met behulp 
van opnamesoftware of muziekproductiesoftware.
De opgenomen audiogegevens kunnen worden afgespeeld op de computer of het smartapparaat.

OPMERKING
• Afhankelijk van het model of het besturingssysteem van de computer en het smartapparaat kan er ruis optreden of is deze functie mogelijk niet 

beschikbaar.

• Als u audiosignalen verzendt of ontvangt via een computer met Windows en de werking is onstabiel of er treden vertragingen op, gebruik dan de 
'Yamaha Steinberg USB Driver'. Zoek op de onderstaande website naar 'Yamaha Steinberg USB Driver' en installeer deze op de computer. 
Raadpleeg de installatiehandleiding bij het downloadbestand voor instructies over het installeren van de driver.  
https://download.yamaha.com/

Interfacing met een computer

Instrument

Computer

USB-kabel

Voorbeeld

USB-aansluiting

clp885_nl_om.book  Page 48  Friday, January 26, 2024  6:12 PM

https://download.yamaha.com/
https://download.yamaha.com/


Verbinding maken met andere apparaten

49 CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP Gebruikershandleiding

Audio Loopback aan/uit zetten

Hiermee kunt u instellen of audio-ingangsgeluid vanuit een aangesloten computer of smartapparaat al dan niet 
vermengd wordt met het op het instrument gespeelde spel dat uitgevoerd wordt naar een computer of smartapparaat. 
Stel Audio Loopback in op 'On' om het ingevoerde geluid uit te voeren. Als u bijvoorbeeld het audio-ingangsgeluid 
samen met het op het instrument gespeelde geluid wilt opnemen met de aangesloten computer of het smartapparaat, 
stelt u dit in op 'On'. Als u met behulp van de computer of het smartapparaat alleen het geluid wilt opnemen dat op het 
instrument wordt gespeeld, stelt u dit in op 'Off'. 
Dit is standaard ingesteld op 'On'; de instelling kan echter worden gewijzigd via 'Utility' > 'Audio Loopback' in het 
menu System (pagina 51).

OPMERKING
• In deze handleiding verwijst 'geluidsinvoer' naar audiogegevens die worden ingevoerd naar het instrument vanaf aangesloten externe apparaten met 

behulp van een van deze methoden: USB Audio-interfacefunctie, Bluetooth-audiofunctie (pagina 43), [AUX IN]-aansluiting (pagina 45) of wifi (pagina 47).

• Het geluid kan niet worden uitgevoerd naar een apparaat dat via Bluetooth of de [AUX IN]-aansluiting is aangesloten.

• Met audio-opname op dit instrument (pagina 39) wordt het audio-invoergeluid van het externe apparaat opgenomen als dit is ingeschakeld, terwijl het 
geluid niet wordt opgenomen als dit is uitgeschakeld. Als de apparaten echter zijn aangesloten via Bluetooth-audio of de [AUX IN]-aansluiting, worden 
de invoergeluiden altijd opgenomen, ongeacht of Audio Loopback is in- of uitgeschakeld.

Een USB-stick kan worden aangesloten op de USB [TO DEVICE]-aansluiting, zodat u gegevens die u hebt 
opgenomen op het instrument kunt opslaan op het USB-stick (pagina 39) of gegevens op het USB-stick kunt afspelen 
vanaf het instrument (pagina 31). Lees eerst 'De USB [TO DEVICE]-aansluiting gebruiken' op pagina 6 voordat u de 
USB [TO DEVICE]-aansluiting gaat gebruiken. 

Wanneer er een bericht op het scherm verschijnt dat aangeeft dat het USB-stick niet is geformatteerd, formatteert u 
het via 'Utility' > 'USB Format' in het menu System (pagina 51).

LET OP
• Formatteren verwijdert alle data die zijn opgeslagen op het USB-stick. Sla belangrijke data op een computer of op een ander 

opslagapparaat op.
• Controleer bij het uitschakelen van het instrument of het instrument GEEN gebruik maakt van het USB-stick door afspelen/

opnemen of bestandsbeheer (zoals opslaan, kopiëren, verwijderen en formatteren). Anders kunnen het USB-stick en de data 
beschadigd raken.

OPMERKING
Hoewel u USB-apparaten 2.0 of 3.0 op dit instrument kunt gebruiken, kan de hoeveelheid tijd nodig om data op te slaan op of te laden van een 
USB-apparaat verschillen afhankelijk van het type data of de status van het instrument.

Een USB-stick aansluiten

Instrument

USB-stick
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U kunt luidsprekers aansluiten op de AUX OUT [L/L+R]/[R]-aansluitingen met behulp van audiokabels om het geluid 
dat op het instrument wordt afgespeeld uit te voeren naar de aangesloten apparaten.

LET OP
• Om eventuele schade te voorkomen, dient u eerst het instrument en daarna pas het externe apparaat in te schakelen. Als u de 

voeding wilt uitschakelen, dient u eerst het externe apparaat en daarna pas het instrument uit te schakelen. Omdat dit instrument 
automatisch kan worden uitgeschakeld via de automatische uitschakelfunctie (pagina 17), moet u het externe apparaat 
uitschakelen of de automatische uitschakelfunctie uitzetten als u het instrument enige tijd niet gaat gebruiken. 

• Sluit de AUX OUT-aansluitingen nooit aan op de [AUX IN]-aansluiting. Als u dit wel zou doen, wordt het ingevoerde signaal bij de 
[AUX IN]-aansluiting uitgevoerd via de AUX OUT-aansluitingen. Deze aansluitingen zouden resulteren in een terugkoppeling 
(rondzingen), wat normale weergave onmogelijk zou maken en de apparatuur zelfs kan beschadigen.

OPMERKING
• Gebruik alleen de [L/L+R]-aansluiting voor het aansluiten van een monoapparaat.

• Als u het geluid dat wordt uitgevoerd via de AUX OUT-aansluitingen beluistert met een hoofdtelefoon die op het instrument is aangesloten, adviseren 
we u om Binaural uit te schakelen via 'Sound' > 'Binaural' in het menu System (pagina 51). Raadpleeg de naslaggids voor meer informatie.

Het geluid van het instrument uitvoeren naar externe luidsprekers

A
U

X
 O

U
T

L
/L

+
R

R

Instrument Luidsprekers met versterker

Telefoonstekker (standaard)

Telefoonstekker (standaard)

Audiokabel

Audiosignaal

Voorbeeld
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Verschillende instellingen uitvoeren in 
de display Menu

Door op de knop [MENU] te drukken wordt de display Menu opgeroepen. De display Menu bevat vijf menu's 
waarmee u instellingen kunt maken met betrekking tot Voice, Song, Metronome/Rhythm, Recording en System 
(algemene instellingen voor het instrument). In dit gedeelte wordt uitleg gegeven over de basisbediening van 
de display Menu. Raadpleeg de naslaggids voor meer informatie over elk menu.

Voor de onderstaande bewerkingen moet u extra instellingen maken voordat u de display Menu opent.

• Wanneer u voice-gerelateerde parameters wilt bewerken:
Selecteer een voice. Als u voices in Dual/Split/Duo wilt bewerken, schakelt u de gewenste functie in. 

• Wanneer u song-gerelateerde parameters wilt bewerken:
Selecteer een song:

1. Druk enkele keren op de knop [MENU] om het gewenste menu te selecteren.
Door herhaaldelijk op de knop te drukken, schakelt u tussen de menu's. De menunaam bovenaan het scherm en het 
pictogram links geven het geselecteerde menu aan.

2. Gebruik de knoppen [u]/[d]/[l]/[r] om de gewenste parameter te selecteren.

3. Gebruik de knoppen [l]/[r] om de instelling te wijzigen of de bewerking uit te voeren.
Om het geselecteerde item te resetten naar de standaardwaarde op de CLP-885, CLP-875 en CLP-895GP, 
houdt u de toets [MENU] ingedrukt totdat de waarde wordt gereset. Druk op de CLP-845, CLP-835 en CLP-865GP 
tegelijkertijd op de knoppen [l] en [r].

4. Druk op de knop [EXIT] om de display Menu te verlaten.

Menu Voice Voor het maken van instellingen voor toetsenspel (pedaalfunctie, volumebalans in Dual/
Split/Duo, transponeren enz.) en voor het bewerken van voices.

Menu Song
Voor het maken van afspeelinstellingen voor songs (herhaald afspelen, volume, transponeren 
enz.), voor het bewerken van songs en voor het verwerken van songbestanden.

Menu Metronome/Rhythm 
(Metronoom/ritme)

Voor het aanpassen van het metronoom- en ritmevolume, het instellen van de maatsoort 
van de metronoom en het maken van ritmegerelateerde instellingen.

Menu Recording 
(Opname)

Voor het maken van MIDI-opname-instellingen.

Menu System 
(Systeem)

Voor het maken van instellingen voor het hele instrument (stemmen, geluid, audio 
uitschakelen, helderheid display enz.), het formatteren van een USB-stick 
en het maken van een back-up van de instellingen van het instrument.

885 875 845 835

41
2, 3

2, 3
4

1

895GP 865GP

Menunaam
Menunaam

Menupictogrammen
Menupictogrammen
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Appendix

De beschikbare vooraf ingestelde voices verschillen van model tot model. De rijen modelnamen geven aan of het 
model overeenkomstige vooraf ingestelde voices heeft.
: Ja (met voicedemo)
: Ja (zonder voicedemo)
–: Nee

Voicelijst

CLP-885
CLP-895GP

CLP-875
CLP-845
CLP-835

CLP-865GP

Voice 
Categorie

Voicenaam Omschrijving
Ste-

reosam-
pling

Aan-
slagge-
voeli-
gheid

Toets-
los-
sam-
pling

VRM

  PIANO CFX Grand De klanken van de concertvleugel CFX van 
Yamaha, met een breed dynamisch bereik voor 
maximale expressieve controle. Geschikt voor het 
spelen in alle muziekgenres en stijlen. Wanneer 
deze voice is geselecteerd, wordt het geluid van 
binauraal samplen automatisch ingeschakeld door 
de aansluiting van de hoofdtelefoon.

   

  Bösendorfer De befaamde klanken van de in Wenen gemaakte 
Bösendorfer Imperial-concertvleugel. Zijn 
ruimtelijke geluid roept de grootte van het 
instrument op en is ideaal voor de expressie van 
emotie in composities. Wanneer deze voice is 
geselecteerd, wordt het geluid van binauraal 
samplen automatisch ingeschakeld door de 
aansluiting van de hoofdtelefoon.

   

  Upright Piano 
(Staande piano)

Gesampled geluid van een staande piano, de Yamaha 
SU7. Geniet van de unieke tooneigenschappen en een 
lichter, meer informeel gevoel.

  – 

 – Studio Grand De klanken van de vleugel C7 van Yamaha, die 
vaak wordt gebruikt in opnamestudio's. Zijn heldere 
geluid is geschikt voor popmuziek.

   

 – Ballad Grand Geluid van een vleugel met een zachte, warme 
klank. Geschikt voor ballades.

   

  Jazz Grand Pianoklank met unieke tooneigenschappen. 
Geschikt voor jazzstijlen.

   

  Rock Grand Een helder klinkende piano. Ideaal voor rockstijlen.    

  Warm Grand Warme en zachte pianoklank. Geschikt voor 
ontspannende muziek.

   

  Bright Grand Heldere pianoklank. Geschikt voor heldere 
expressie en goede hoorbaarheid bij samenspel 
met andere instrumenten in een ensemble.

   –

  Chill out Piano Een zwaar bewerkt pianogeluid met diepe nagalm. 
Geschikt voor ontspannende muziek.

   –

  Lo-Fi Piano Een warm pianogeluid dat typisch is voor vintage 
vinylplaten. Goed voor stijlen als vroege rock-'n-roll 
of klassieke rock.

   –

  HonkyTonk Pf Een piano met een honky-tonkstijl. Geniet van het 
typische karakter van de klankkleur die nogal 
afwijkt van die van een vleugel.

  – 

 – FORTE 
PIANO

Scarlatti Piano Het geluid van een piano die in de vroege 18e eeuw 
door een instrumentenbouwer in Firenze werd 
gebouwd. De bouwer is beroemd als uitvinder van de 
piano. Aangenomen wordt dat Scarlatti de piano van 
deze bouwer gebruikte. Het geluid is helder en briljant.

   –

  Mozart Piano Het geluid van een piano die in de late 18e eeuw 
door een instrumentenbouwer in Wenen werd 
gebouwd. Mozart en Beethoven speelden op de 
piano van deze bouwer en waardeerden het 
instrument erg. Het geluid ervan is helder en licht.

  – –

: Ja, –: Nee
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 – FORTE 
PIANO

Beethoven 
Piano

Het geluid van een piano die in de vroege 19e eeuw 
door een instrumentenbouwer in Londen werd 
gebouwd. Haydn en Beethoven componeerden vele 
meesterwerken geïnspireerd door de piano's van 
deze bouwer. Het heeft een rijke bas, sprankelende 
hoogten en een krachtig fortissimo.

   –

  Chopin Piano Het geluid van een piano die in de 19e eeuw door 
een instrumentenbouwer in Parijs werd gebouwd. 
Chopin hield van de piano's van deze bouwer 
omdat ze goed reageerden op zijn gevoelige 
aanslagen. Het geluid ervan is als een zangstem, 
soms weelderig, soms triest.

  – –

  E.PIANO Stage E.Piano Het geluid van een elektrische piano die gebruikmaakt 
van hamers die op metalen 'staafjes' slaan. Zachte 
klank wanneer er licht wordt gespeeld en een 
agressieve klank wanneer er hard wordt gespeeld.

–   –

  DX E.Piano Een elektronisch pianogeluid geproduceerd door 
een FM-synthesizer. De klank verandert als u uw 
toetsaanslag verandert. Ideaal voor popmuziek.

–  – –

  Vintage EP Het geluid van een elektrische piano die 
gebruikmaakt van hamers die op metalen 'staafjes' 
slaan. Veel gebruikt in rock- en popmuziek.

–   –

  Soft EP Een elektronische piano met een karakteristiek 
panningeffect. Geschikt voor rustige ballades.

–   –

  Phaser EP Een karakteristiek phaser-effect maakt dit bijzonder 
geschikt voor fusionstijlen.

–   –

  DX Bright Een variatie van elektronisch pianogeluid 
geproduceerd door een FM-synthesizer. Zijn heldere 
en sprankelende geluid geeft de muziek meer pit.

–  – –

  Tremolo Vintage Inclusief tremolo, ideaal voor Vintage EP. Vaak 
gebruikt in rockmuziek.

–   –

 – ORGAN 
(Orgel)

Organ GrandJeu 
(Orgel Grand 
Jeu)

Een registratiegeluid dat typisch is voor Franse 
orgelcomposities. Dit dramatische geluid is ideaal 
voor het beëindigen van een performance.

 – – –

  Organ Principal 
(Orgel principal)

Deze voice beschikt over de combinatie van pijpen 
(8'+4'+2') van een hoofdorgel (koperinstrument). 
Het is geschikt voor barokke kerkmuziek.

 – – –

  Organ Tutti 
(Orgel tutti)

Deze voice beschikt over het volle geluid van een 
pijporgel, zoals dat gebruikt wordt in 'Toccata en 
fuga' van Bach.

 – – –

  Jazz Organ 1 
(Jazz orgel 1)

Het geluid van een elektrisch orgel dat vaak te 
horen is in jazz- en rockthema's. Een iets helderder 
geluid waarbij het Rotary-effect is ingesteld op een 
lage snelheid.
* U kunt de snelheid van het Rotary-effect schakelen tussen 

langzaam en snel door het linker pedaal in te drukken.

– – – –

  Jazz Organ 2 
(Jazz orgel 2)

Het geluid van een elektrisch orgel dat vaak te 
horen is in jazz- en rockthema's. Het Rotary-effect 
is ingesteld op een hoge snelheid.
* U kunt de snelheid van het Rotary-effect schakelen tussen 

langzaam en snel door het linker pedaal in te drukken.

– – – –

  Rock Organ 
(Rockorgel)

Helder en scherp elektrisch orgelgeluid. Optimaal 
voor rockmuziek.

– – – –

 – Organ Flute 1 
(Orgelfluit 1)

Een pijporgelgeluid dat een fluittype (houtblazer) 
register met verschillende toonhoogtes (8' + 4') 
combineert. Dit is een vriendelijk geluid dat ideaal 
is voor het begeleiden van kerkgezang.

 – – –

 – Organ Flute 2 
(Orgelfluit 2)

Een pijporgelgeluid dat een fluittype (houtblazer) 
register met verschillende toonhoogtes 
(8' + 4' + 1-1/3') combineert. Dit is helderder 
dan Organ Flute 1 en is geschikt voor solo's.

 – – –

CLP-885
CLP-895GP

CLP-875
CLP-845
CLP-835

CLP-865GP

Voice 
Categorie

Voicenaam Omschrijving
Ste-

reosam-
pling

Aan-
slagge-
voeli-
gheid

Toets-
los-
sam-
pling

VRM
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  STRINGS 
(Snaren)

Strings (Snaren) Grootschalig strijkersensemble met realistische 
nagalm. Combineer deze voice eens met piano 
in Dual.

  – –

  Slow Strings 
(Trage snaren)

Het geluid van een strijkersensemble met een 
langzame aanslag. Geschikt voor gebruik in Dual 
met piano of elektronische piano.

  – –

  Choir (Koor) Een grote, ruimtelijke voice van een koor. Perfect 
voor het scheppen van rijke harmonieën in 
langzame stukken.


(Alleen 
CLP-
885/
CLP-

895GP)

 – –

  Slow Choir 
(Traag koor)

Een warm strijkersensemble. Geniet van 
tooneigenschappen die afwijken van Strings.

 – –

 – Mellow Strings 
(Mellow snaren)

Een warm strijkersensemble. Geniet van 
tooneigenschappen die afwijken van Strings.

  – –

 – Dark Pad 
(Donker blok)

Een warm en ruimtelijk synthesizergeluid. Ideaal 
voor aanhoudende partijen op de achtergrond van 
een ensemble of voor gebruik in Dual met piano en 
elektronische piano.

–  – –

 – Lite Pad 
(Licht blok)

Een helder en ruimtelijk synthesizergeluid. Ideaal 
voor aanhoudende partijen op de achtergrond van 
een ensemble of voor gebruik in Dual met piano en 
elektronische piano.

–  – –

 – Bell Pad 
(Bellenblok)

Synthesizergeluid met een helder bel-achtig geluid. 
Ideaal voor het gebruik in Dual met een piano of 
elektrisch pianogeluid, maar produceert zelf ook 
een helder, schitterend geluid.

  – –

–  Synth Pad 
(Synthesizerblok)

Een warm, zacht en ruimtelijke synthesizergeluid. 
Ideaal voor aanhoudende partijen op de 
achtergrond van een ensemble of voor gebruik in 
Dual met piano en elektronische piano.

–  – –

  BASS 
(Bas)

Acoustic Bass 
(Akoestische 
bas)

Het geluid van een met de vinger geplukte staande 
bas. Wordt regelmatig gebruikt in jazzmuziek en 
Latin-muziek.

–  – –

  Bass & Cymbal 
(Bas en 
cimbaal)

Het geluid van een cimbaal gecombineerd met dat 
van de bas. Effectief bij gebruik voor lopende 
baslijnen in jazz.

–  – –

  Electric Bass 
(Elektrische 
bas)

Het geluid van een elektronische bas. Wordt 
regelmatig gebruikt in jazz-, rock- en popmuziek.

–  – –

  Fretless Bass 
(Fretloze bas)

Het geluid van een fretloze bas. Geschikt voor 
stijlen zoals jazz en fusion.

–  – –

 – Vintage Bass 
(Vintage bas)

Een ander type elektrische bas met een zacht en 
warm geluid.

–  – –

  OTHERS 
(Overige)

Harpsichord 8' 
(Klavecimbel 8') 

Het geluid van het instrument dat vaak in barokmuziek 
wordt gebruikt. Variaties in de toetsaanslag hebben 
geen invloed op het volume en er klinkt een 
karakteristiek geluid als u de toets loslaat.

 –  –

  Harpsi. 8'+4' 
(Klavecimbel 
8'+4')

Een klavecimbel met een toegevoegd hoger octaaf. 
Geeft een helderder geluid.

 –  –

 – Harp Dit geluid is gesampled van een concertharp. Dit 
geluid, met een heldere aanslag, is ideaal voor het 
spelen van prachtige frasen.

–  – –

  Vibraphone 
(Vibrafoon)

Een vibrafoon met een ruimtelijke en heldere klank. 
Ideaal voor popmuziek. Met het linker pedaal 
schakelt u Vibrato in en uit.

  – –

 – Marimba Een marimbageluid, in stereo gesampled voor een 
ruimtelijk en authentiek geluid.

  – –

 – Celesta Het geluid van een celesta (een percussie-instrument 
waarbij hamers op metalen staafjes slaan om geluid 
te maken). Dit instrument is zeer bekend geworden 
door de 'Dans van de suikerfee' uit de 
'Notenkrakersuite' van Tsjaikovski.

  – –
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• Toets-los-sampling: Samples van de zeer delicate geluiden die ontstaan als toetsen worden losgelaten.

• VRM (Virtual Resonance Modeling): Gesimuleerd snaarresonantiegeluid met fysieke modellering wanneer het demperpedaal wordt ingedrukt of 
toetsen worden ingedrukt. Grand Expression Modelling is effectief voor VRM-voices. Effecten kunnen niet worden toegepast op de VRM-voices.

Lijst met voicedemo's
De onderstaande voicedemo's zijn korte, opnieuw gearrangeerde fragmenten van de originele composities. Alle andere demosongs zijn 
origineel van Yamaha (© Yamaha Corporation).

  OTHERS 
(Overige)

Nylon Guitar 
(Gitaar met 
nylon snaren)

In stereo gesamplede gitaar met nylon snaren en 
realistisch geluid. Geschikt voor alle muziekstijlen.

  – –

  Steel Guitar 
(Gitaar met 
stalen snaren)

Het heldere geluid van een gitaar met stalen 
snaren. Ideaal voor popmuziek.

–  – –

 – Scat U kunt genieten van jazz 'scatting' met deze voice. 
Afhankelijk van hoe hard en in welk nootbereik 
u speelt, worden verschillende geluiden geproduceerd.

–  – –

 – XG – Zie de 'Datalijst' op de website voor meer informatie 
over XG-voices.

–  – –

CLP-885
CLP-895GP

CLP-875
CLP-845
CLP-835

CLP-865GP

Voice
Categorie

Voicenaam Titel Componist

  PIANO CFX Grand Ungarische rhapsodie “Preludio” E-Dur F. Liszt

  Bösendorfer Widmung S.566 R.253 F. Liszt / R. Schumann

  Upright Piano 
(Staande piano)

Sonatine F dur Anh.5(2) 1st mov.  
(Sonatine F dur Anh.5(2) 1e deel)

L. v. Beethoven

 – FORTE 
PIANO

Scarlatti Piano Sonata G dur K.14 L.387 G. D. Scarlatti

  Mozart Piano Sontata No.15 C dur K.545 1st mov. 
(Sonata No.15 C dur K.545 1e deel)

W. A. Mozart

 – Beethoven Piano Für Elise a moll L. v. Beethoven

  Chopin Piano Nocturne op.27-2 Des dur F. F. Chopin

  ORGAN 
(Orgel)

Organ Principal 
(Orgel principal)

Herr Christ, der ein'ge Gottes-Sohn BWV 601 J. S. Bach

  OTHERS 
(Overige)

Harpsichord 8' 
(Klavecimbel 8')

Concerto a cembalo obbligato, 2 violini, viola 
e continuo No.7 g moll BWV 1058 1st mov. 
(Concerto a cembalo obbligato, 2 violini, viola 
e continuo No.7 g moll BWV 1058 1e deel )

J. S. Bach
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Lijst met ritmen

Nr. Naam

Pop en Rock

1 8Beat

2 16Beat

3 Shuffle1

4 Shuffle2

5 Shuffle3

6 Gospel

7 8BeatBallad

8 6-8SlowRock

Jazz

9 FastJazz

10 SlowJazz

11 Swing

12 JazzWaltz

Latin

13 Samba

14 BossaNova

15 Rumba

16 Salsa

Kinderen en vakantie

17 KidsPop

18 6-8March

19 ChristmasSwing

20 Christmas3-4
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50 Classics (50 klassiekers) 

Lessongs 

*De lessongs zijn originele composities.

Lijst met songs

Nr. Songtitel Componist

Arrangementen

1 Canon D dur J. Pachelbel

2 Air On the G String (Air op de G-snaar) J. S. Bach

3 Jesus, Joy of Man’s Desiring 
(Jesus bleibet meine Freude)

J. S. Bach

4 Twinkle, Twinkle, Little Star Traditional

5 Piano Sonate op.31-2 “Tempest” 3rd mov. 
(Piano Sonate op.31-2 'Der Sturm' 3e deel)

L. v. Beethoven

6 Ode to Joy (An die Freude) L. v. Beethoven

7 Wiegenlied op.98-2 F. P. Schubert

8 Grande Valse Brillante F. F. Chopin

9 Polonaise op.53 “Héroïque” F. F. Chopin

10 La Campanella F. Liszt

11 Salut d'amour op.12 E. Elgar

12 From the New World A. Dvořák

13 Sicilienne G. U. Fauré

14 Clair de lune C. A. Debussy

15 Jupiter (The Planets) G. Holst

Duetten

16 Menuett (Eine kleine Nachtmusik K.525) W. A. Mozart

17 Menuett G dur L. v. Beethoven

18 Marcia alla Turca L. v. Beethoven

19 Piano Concerto No.1 op.11 2nd mov. 
(Piano Concerto No.1 op.11 2e deel)

F. F. Chopin

20 The Nutcracker Medley 
(De Notenkraker-medley)

P. I. Tsjaikovski

Originele composities

21 Prelude (Wohltemperierte Klavier I No.1) J. S. Bach

22 Menuett G dur BWV Anh.114 J. S. Bach

23 Piano Sonate No.15 K.545 1st mov. 
(Pianosonate nr.15 K.545 1e deel)

W. A. Mozart

24 Turkish March (Turkse mars) W. A. Mozart

25 Piano Sonate op.13 “Pathétique” 2nd mov. 
(Pianosonate op.13 'Pathétique' 2e deel)

L. v. Beethoven

26 Für Elise L. v. Beethoven

27 Piano Sonate op.27-2 “Mondschein” 1st mov. 
(Pianosonate op.27-2 'Mondschein' 1e deel)

L. v. Beethoven

28 Impromptu op.90-2 F. P. Schubert

29 Frühlingslied op.62-6 J. L. F. Mendelssohn

30 Fantaisie-Impromptu F. F. Chopin

31 Etude op.10-3 “Chanson de l’adieu” F. F. Chopin

32 Etude op.10-12 “Revolutionary” F. F. Chopin

33 Valse op.64-1 “Petit chien” F. F. Chopin

34 Nocturne op.9-2 F. F. Chopin

35 Nocturne KK4a-16/BI 49 [Posth.] F. F. Chopin

36 Träumerei R. Schumann

37 Barcarolle P. I. Tsjaikovski

38 La prière d'une Vierge T. Badarzewska

39 Liebesträume No.3 F. Liszt

40 Blumenlied G. Lange

41 Humoresque A. Dvořák

42 Arietta E. H. Grieg

43 Tango (España) I. Albéniz

44 The Entertainer S. Joplin

45 Maple Leaf Rag S. Joplin

46 La Fille aux Cheveux de Lin C. A. Debussy

47 Arabesque No.1 C. A. Debussy

48 Cakewalk C. A. Debussy

49 Je te veux E. Satie

50 Gymnopédies No.1 E. Satie

Albumtitel Nr./Songtitel Componist

Vorschule im 
Klavierspiel op.101

1–106 F. Beyer

25 Etudes faciles et 
progressives op.100

1 La candeur J. F. Burgmüller

2 Arabesque

3 Pastorale

4 Petite réunion

5 Innocence 

6 Progrès

7 Courant limpide

8 La gracieuse 

9 La chasse 

10 Tendre fleur 

11 La bergeronnette

12 Adieu

13 Consolation 

14 La styrienne 

15 Ballade 

16 Douce plainte 

17 Babillarde

18 Inquiétude 

19 Ave Maria 

20 Tarentelle

21 Harmonie des anges

22 Barcarolle 

23 Retour

24 L'hirondelle

25 La chevaleresque

100 Übungsstücke 
op.139

1–100 C. Czerny

30 Etudes de 
mécanisme op.849 

1–30 C. Czerny

The Virtuoso Pianist 1–20 1-Variation. 1–22 C-L. Hanon

De duetsongs 
De hieronder vermelde songs zijn duetsongs.
• Nos. 16-20 of '50 Classics'
• Nr. 1–11 van de Vorschule im Klavierspiel op.101 van 'Lesson Songs' 

alsook 32–34, 41–44, 63–64 en 86–87
De 'R' (rechterhand)partij is voor de rechterhand van de eerste speler, de 
'L' (linkerhand)partij is voor de linkerhand van de eerste speler en de 
'extra' partij is voor beide handen van de tweede speler.

Nr. Songtitel Componist
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Bepaalde berichtendisplays kunnen geopend blijven. Als dit gebeurt, drukt u op de knop [EXIT] om de 
berichtendisplay te sluiten. 

Berichtenlijst

Berichten Omschrijving

Access error (Toegangsfout) De bewerking is mislukt. Dit kan de volgende oorzaken hebben. 
• De bestandsbewerking klopt niet. Volg de instructies in de naslaggids, het gedeelte 

'File' in het menu Song of het gedeelte 'Backup' in het menu System.
• Het aangesloten USB-apparaat is niet compatibel met dit instrument. Gebruik een 

apparaat waarvan de compatibiliteit door Yamaha is bevestigd (pagina 6).
• Het bestand kan beschadigd zijn.

Bluetooth pairing... (Bezig met 
koppelen via Bluetooth...)

Het instrument is klaar voor koppeling via Bluetooth. Zie pagina 44 voor meer informatie.

Cannot be executed (Kan niet 
worden uitgevoerd)

Dit kan de volgende oorzaken hebben.
• Dit bericht wordt weergegeven wanneer u probeert een bestandsbewerking uit te 

voeren naar een vooraf ingestelde song of een audiosong. Raadpleeg het hoofdstuk 
Menu Song in de naslaggids voor meer informatie over de beperkingen van de 
bestandsbewerking. 

• De knop [PIANO ROOM] is ingedrukt terwijl er een voice is geselecteerd die het 
gebruik van de functie Piano Room niet toestaat. Selecteer 'CFX Grand', 'Bösendorfer' 
of een andere categorie PIANO-voices met VRM-effecten (pagina 52) om de 
instellingen toe te passen.

Change to Current Tempo 
(Wijzigen naar huidig tempo)

Het tempo van de geselecteerde MIDI-song wordt gewijzigd in het huidige tempo en 
overschreven. Raadpleeg het hoofdstuk Menu Song in de naslaggids voor meer informatie.

Change to Current Voice (Wijzigen 
naar huidige voice)

De voice van de geselecteerde MIDI-song wordt gewijzigd in de huidige voice en 
overschreven. Raadpleeg het hoofdstuk Menu Song in de naslaggids voor meer informatie.

Completed (Voltooid) De bewerking is voltooid. Ga naar de volgende stap.

Completed (Voltooid)
Restart now (Nu opnieuw opstarten)

Het terugzetten is voltooid. Het instrument wordt automatisch opnieuw opgestart.

Convert canceled 
(Converteren geannuleerd)

De conversie van MIDI-song naar audiosong is geannuleerd.

Convert completed to USB/
USERFILES/ (Converteren naar 
USB/USERFILES/ voltooid)

De MIDI-song is geconverteerd naar een audiosong en opgeslagen in de map 'USER 
FILES' op het USB-stick.

Convert to Audio 
(Converteer naar audio)

De MIDI-song wordt geconverteerd naar een audiosong. 

Copy completed to USB/
USERFILES/ (Kopiëren naar USB/
USERFILES/ voltooid)

De song in de 'User'-locatie op het instrument is gekopieerd naar de map 'USER FILES' 
op het USB-stick.

Copy completed to User 
(Kopiëren naar gebruiker voltooid)

De song op het USB-stick is gekopieerd naar de 'User'-locatie op dit instrument.

Device busy (Apparaat bezig) De bewerking, zoals het afspelen/opnemen van een audiosong of de conversie van 
MIDI naar audio, is mislukt. Dit bericht wordt weergegeven als u een USB-stick probeert 
te gebruiken waarop opname-/verwijderbewerkingen zijn herhaald. Formatteer het  
USB-stick nadat u hebt gecontroleerd of er geen belangrijke gegevens op staan en 
probeer het opnieuw. Om het USB-stick te formatteren, voert u 'Utility' > 'USB Format' 
uit in het menu System (pagina 51).

Device removed 
(Apparaat verwijderd)

Het USB-stick is verwijderd uit de USB [TO DEVICE]-aansluiting.
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Duplicate name (Dubbele naam) Dit bericht geeft aan dat er al een bestand met deze naam bestaat. Wijzig de naam van 
het bestand.

Executing (Bezig met uitvoeren) De bewerking wordt uitgevoerd. Wacht tot het bericht verdwijnt en ga dan naar de 
volgende stap.

Factory reset completed (De 
fabrieksinstellingen zijn hersteld)
Restart (Start opnieuw op)

De fabrieksinstellingen zijn hersteld. Het instrument wordt opnieuw opgestart.

Factory reset executing 
(Terugzetten naar 
fabrieksinstellingen wordt 
uitgevoerd)
Memory Song excluded 
(Songgeheugen uitgesloten)

Het instrument wordt nu teruggezet naar de standaardinstellingen. De songs in de 'User' 
(pagina 31) en Bluetooth-koppelingsinformatie (pagina 44) worden niet gewist.

Incompatible device 
(Niet-compatibel apparaat)

Er is een niet-compatibel USB-apparaat aangesloten. Gebruik een apparaat waarvan de 
compatibiliteit door Yamaha is bevestigd (pagina 6).

Internal hardware error 
(Interne hardwarefout)

Er heeft zich een probleem voorgedaan in het instrument. Neem contact op met uw 
Yamaha-leverancier of een erkende Yamaha-distributeur.

Last power off invalid 
(Laatste uitschakeling niet correct)
Checking memory 
(Controle van geheugen)

Dit bericht wordt weergegeven wanneer het instrument wordt aangezet nadat het is 
uitgezet tijdens een bewerking op een songfile of tijdens het opslaan van een 
back-upbestand. Het interne geheugen wordt gecontroleerd terwijl dit bericht wordt 
weergegeven. Als de interne instellingen beschadigd zijn, worden de standaardinstellingen 
hersteld. Als de songs in de locatie 'User' beschadigd zijn, worden deze verwijderd. Wacht 
tot het bericht verdwijnt en gebruik dan het instrument.

Maximum no. of devices exceeded 
(Maximumaantal apparaten 
overschreden)

Het aantal apparaten overschrijdt het maximale aantal. Er kan slechts één 
USB-apparaat worden aangesloten op de USB [TO DEVICE]-aansluiting.

Memory full (Geheugen vol) De bewerking kan niet worden voltooid omdat de capaciteit en het aantal bestanden in 
de map 'User' te groot is of het USB-stick vol is. Verwijder een aantal overbodige songs 
(pagina 42) en probeer het opnieuw.

Move completed to USB/
USERFILES/ (Verplaatsen naar 
USB/USERFILES/ voltooid)

De song in 'User' op dit instrument is verplaatst naar de map 'USER FILES' op het 
USB-stick.

Move completed to User 
(Verplaatsen naar gebruiker 
voltooid)

De song op het USB-stick is verplaatst naar de 'User'-locatie op dit instrument.

No device (Geen apparaat) Er is geen USB-stick aangesloten op de USB [TO DEVICE]-aansluiting. Sluit een  
USB-stick aan en voer de bewerking opnieuw uit.

No response from USB device 
(Geen respons van USB-stick)

Het instrument kan niet communiceren met het aangesloten USB-apparaat. Breng de 
verbinding opnieuw tot stand. Als dit bericht niet verdwijnt, is het USB-apparaat mogelijk 
beschadigd.

Please wait (Even wachten a.u.b.) De data worden verwerkt. Wacht tot het bericht verdwijnt en ga dan naar de volgende stap.

Protected device 
(Beschermd apparaat)

U probeert de gegevens op te nemen of op te slaan op een USB-stick met 
schrijfbeveiliging. Schakel indien mogelijk de schrijfbeveiliging uit en probeer het 
opnieuw. Als u dit bericht nog steeds ziet, is het USB-stick intern beveiligd. U kunt geen 
gegevens naar een dergelijk station schrijven.

Read-only file 
(Alleen-lezenbestand)

U probeert een bestandsbewerking uit te voeren op een alleen-lezenbestand. Schakel 
de alleen-lezen markering van het bestand uit en probeer het opnieuw.

Remaining space on drive is low 
(Te weinig vrije ruimte op schijf)

Het geheugen van de map 'User' of het USB-stick is bijna vol. Verwijder overbodige 
bestanden (pagina 42) voordat u gaat opnemen.

Berichten Omschrijving
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Same file name exists 
(Deze bestandsnaam bestaat al)

Dit bericht wordt weergegeven als er al een bestand met dezelfde naam bestaat bij het 
uitvoeren van een bestandsbewerking (kopiëren/verplaatsen/MIDI naar audio). 
Selecteer om het bestand te overschrijven of om de bewerking te annuleren.

Song error (Songfout) Er is een probleem gevonden met de songdata. Selecteer de song opnieuw en probeer 
de song nogmaals af te spelen. Als het bericht nog steeds wordt weergegeven, zijn de 
songdata mogelijk beschadigd.

Song too large (Song te groot) Dit kan de volgende oorzaken hebben.
• De grootte van de geselecteerde song overschrijdt de limiet. De limiet voor afspelen is 

ongeveer 500 KB (MIDI) of 80 minuten (audio).
• De limiet voor de grootte van de song werd bereikt tijdens het opnemen. De limiet voor 

opnemen is ongeveer 500 KB (MIDI) of 80 minuten (audio). De opname wordt 
automatisch beëindigd waarbij alle opgenomen data voor het einde worden opgeslagen.

• De limiet voor de grootte van de song werd bereikt tijdens conversie van een MIDI-song 
naar een audiosong. De limiet is 80 minuten (audio).

System limit (Systeemlimiet) Dit bericht wordt weergegeven als het aantal bestanden en mappen de systeemlimiet 
overschrijdt. Het maximale aantal bestanden en mappen dat in een map kan worden 
opgeslagen is 250. Verwijder of verplaats de overbodige bestanden en probeer het opnieuw.

This data format is not supported 
(Deze data-indeling wordt niet 
ondersteund)

De indeling van de geselecteerde song is niet compatibel met dit instrument. Raadpleeg 
pagina 30 voor informatie over songs die op dit instrument kunnen worden gespeeld.

Unformatted device 
(Niet-geformatteerd apparaat)

Het USB-stick is niet geformatteerd. Formatteer het via 'Utility' > 'USB Format' in het 
menu System (pagina 51).

Unsupported device 
(Niet-ondersteund apparaat)

Er is een niet-ondersteund USB-apparaat aangesloten. Gebruik een apparaat waarvan 
de compatibiliteit door Yamaha is bevestigd (pagina 6).

USB device overcurrent error 
(Overspanningsfout 
USB-apparaat)

De communicatie met het USB-apparaat is verbroken vanwege een ongewone 
spanningspiek naar het apparaat. Koppel het USB-apparaat los van de USB 
[TO DEVICE]-aansluiting en zet het instrument uit en weer aan.

USB hub cannot be used 
(USB-hub kan niet worden gebruikt)

Sluit een USB-apparaat rechtstreeks aan op het instrument zonder een USB-hub te 
gebruiken.

USB power consumption 
exceeded (Stroomverbruik 
USB overschreden)

Het stroomverbruik van het aangesloten USB-apparaat heeft de limiet overschreden. 
Gebruik een apparaat waarvan de compatibiliteit door Yamaha is bevestigd (pagina 6).

Wrong device (Verkeerd apparaat) De bestandsbewerking kan niet worden uitgevoerd op het aangesloten USB-stick. 
Dit kan de volgende oorzaken hebben.
• Het USB-stick is niet geformatteerd. Formatteer het via 'Utility' > 'USB Format' in het 

menu System (pagina 51). 
• Het aantal bestanden overschrijdt de systeemlimiet. Het maximale aantal bestanden 

en mappen dat in een map kan worden opgeslagen is 250. Verwijder of verplaats de 
overbodige bestanden en probeer het opnieuw.

Wrong name (Verkeerde naam) Dit bericht wordt weergegeven tijdens het wijzigen van de naam van een songbestand 
en kan de volgende oorzaken hebben. Geef de song een juiste naam. Zie het gedeelte 
'Bestand' in het menu Song in de naslaggids voor meer informatie. 
• Er is geen teken ingevoerd.
• U hebt een punt of spatie gebruikt aan het begin of einde van een songnaam.

Berichten Omschrijving
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Als er een bericht wordt weergegeven, raadpleegt u de 'Berichtenlijst' (pagina 58) om het probleem op te lossen.
Raadpleeg de naslaggids voor meer informatie over de instellingen van de display Menu (pagina 51).

Problemen oplossen

Probleem Mogelijke oorzaak en oplossing

Het instrument gaat niet aan. Het instrument is niet goed aangesloten. Sluit de netadapter stevig aan op de DC 
IN-aansluiting op het instrument en op het stopcontact (pagina 16).

Het instrument wordt automatisch 
uitgeschakeld.

Dit is normaal en is het gevolg van de automatische uitschakelfunctie. Schakel indien 
nodig de functie Automatisch uitschakelen uit (pagina 17).

Mechanisch geluid is hoorbaar 
tijdens het spel.

Het toetsenbordmechanisme van dit instrument simuleert het toetsenbordmechanisme 
van een echte piano. Mechanisch geluid is ook hoorbaar op een piano.

Er is ruis te horen uit de 
luidsprekers van het instrument.

Er kan ruis hoorbaar zijn als er een mobiele telefoon in de buurt van het instrument wordt 
gebruikt of als de telefoon overgaat. Zet de mobiele telefoon uit of gebruik deze op 
grotere afstand van het instrument.

Er komt ruis uit de luidsprekers van 
het instrument of de hoofdtelefoon 
als u het instrument samen met 
het smartapparaat gebruikt.

Als u het Instrument samen met de app op uw smartapparaat gebruikt, adviseren we u om 
de 'vliegtuigmodus' op dat apparaat in te schakelen, om bijgeluiden als gevolg van 
communicatie te vermijden. Als u een smartapparaat draadloos verbindt met dit product, 
moet u ervoor zorgen dat de wifi- of Bluetooth-instelling op het apparaat is ingeschakeld.

Het totale volume is laag of er is 
geen geluid te horen.

• Het mastervolume is mogelijk te laag ingesteld. Stel het in op een geschikt niveau met 
de [VOLUME]-schuif (pagina 18).

• De functie Volume Limiter is ingesteld op 'On'. Stel de volumebegrenzer in op 'Off' via 
'Sound' > 'Volume Limiter' in het menu System (pagina 51).

• Het volumeniveau voor het toetsenspel is te laag ingesteld. Pas de balans aan om het 
toetsenbordvolume te verhogen via 'Volume' > 'Song - Keyboard' in het menu Song 
(pagina 51). 

• De hoofdtelefoon is aangesloten. Koppel de hoofdtelefoon en de adapterstekker los.
• De luidsprekerinstelling is 'Off' (uit). Stel de luidspreker in op 'Normaal' of 'On' via 

'Utility' > 'Speaker' in het menu System (pagina 51).
• Local Control is ingesteld op 'Off'. Zet Local Control op 'On' via 'MIDI' > 'Local Control' 

in het menu System (pagina 51).

De luidsprekers worden niet 
uitgeschakeld als er een 
hoofdtelefoon is aangesloten 
op de [PHONES]-aansluiting.

Speaker is ingesteld op 'On'. Stel de luidspreker in op 'Normaal' via 'Utility' > 'Speaker' in 
het menu System (pagina 51).

De pedalen doen het niet. Het pedaalsnoer is mogelijk niet goed aangesloten op de [PEDAL]-aansluiting. Steek de 
stekker van het pedaalsnoer helemaal in de aansluiting tot het metalen gedeelte van de 
stekker niet meer zichtbaar is (pagina 19).

Het toetsenbordvolume is lager 
dan het songafspeelvolume.

Het volumeniveau voor het toetsenspel is te laag ingesteld. Pas de balans aan om het 
toetsenbordvolume te verhogen via 'Volume' > 'Song - Keyboard' in het menu Song 
(pagina 51). 

De knoppen reageren niet. • Terwijl een functie wordt gebruikt, kunnen sommige knoppen die geen verband houden 
met de functie uitgeschakeld zijn. Stop het afspelen als er een song wordt afgespeeld. 
In een andere situatie drukt u op de knop [EXIT] om terug te keren naar de display 
Voice of Song en voert u vervolgens de gewenste bewerking uit.

• Terwijl Smart Pianist is aangesloten op het instrument, kan er geen bewerking worden 
uitgevoerd op het instrument. Bedien het instrument met behulp van Smart Pianist. 
Druk op de knop [EXIT] om Smart Pianist te ontkoppelen.

De pitch en/of toon van de 
pianovoices klinken in bepaalde 
bereiken niet goed.

Dit is normaal en geen storing. De pianovoice is ontworpen om het originele geluid van 
de piano zoveel mogelijk te reproduceren. Hierdoor kunnen de harmonische tonen meer 
uitgesproken zijn in bepaalde toonbereiken, waardoor de toonhoogte of het bereik van 
het geluid een beetje ongewoon lijkt.
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* Het instrument beschikt mogelijk niet over Bluetooth, afhankelijk van het land waarin u het product kocht. Zie pagina 21 voor informatie over de 
beschikbaarheid van de Bluetooth-functie.

Raadpleeg voor meer informatie de 'Veelgestelde vragen (FAQ)' op de onderstaande website:

https://faq.yamaha.com/s/

* Beschikbaar in het Engels, Duits, Frans, Spaans en enkele andere talen. 

Hogere en lagere noten klinken 
niet goed als Transpose of Octave 
is ingesteld.

Dit instrument heeft een bereik van C -2 tot G8 wanneer u Transpose of Octave inschakelt. 
Als u een lagere noot dan C-2 speelt, wordt het geluid een octaaf hoger weergegeven. Als 
u een hogere noot dan G8 speelt, wordt het geluid een octaaf lager weergegeven.

Het spel in Dual/Split/Duo wordt 
niet opgenomen of partijdata gaan 
onverwacht verloren.

Het schakelen naar Dual/Split/Duo halverwege een song kan niet worden opgenomen. 
Bovendien wordt de opnamepartij voor voice 2 (Dual) of de linkervoice (Split/Duo) 
automatisch toegewezen (pagina 41). Als de toegewezen partij al data bevat, worden 
deze data overschreven door de opname.

Het toetsenbordgeluid in Duo 
wordt mogelijk via slechts één 
luidspreker uitgevoerd.

De reden hiervoor is dat de standaardpaninstelling verschilt afhankelijk van de voice. 
Stel 'Duo Type' in op 'Balanced' in het menu System (pagina 51) of wijzig de instelling 
'Pan' in 'Voice Edit' in het menu Voice (pagina 51).

De songtitel klopt niet. De instelling 'Language' kan anders zijn dan de instelling die werd gebruikt toen een naam 
werd gegeven aan de song. Ook als de song op een ander instrument is opgenomen, kan 
de titel verkeerd worden weergegeven. Wijzig de instelling van 'Utility' > 'Language' > 
'Song' in het menu System (pagina 51). Als de song echter is opgenomen op een ander 
instrument, is het mogelijk dat het probleem niet kan worden opgelost door de instelling 
van 'Language' te wijzigen.

De menu-display kan niet worden 
opgeroepen.

Wanneer een song wordt afgespeeld, kunnen enkel de menudisplay 'Voice' en 'Song' 
worden weergegeven. Bovendien wordt tijdens het opnemen alleen het menu Recording 
weergegeven. Stop het afspelen of opnemen van songs voordat u het gewenste 
menu oproept.

Het ritme start niet. De functie Synchro Start is ingeschakeld, wat betekent dat u op een toets moet drukken 
om het afspelen te starten. Om het afspelen te starten door op de knop [RHYTHM] te 
drukken, zet u 'SynchStart' uit in het menu Metronome/Rhythm (pagina 51).

Metronoom, MIDI-song of ritme 
loopt enigszins uit de maat wanneer 
u op het toetsenbord speelt.

Dit komt onregelmatig voor wanneer Grand Expression Modelling is ingesteld op 
'Dynamic'. Wanneer dit gebeurt, stelt u Grand Expression Modelling in op 'Static' 
(pagina 25).

De inhoud van het draadloze 
netwerk wordt niet weergegeven 
op de display, zelfs als de 
draadloze USB-netwerkadapter 
is aangesloten.

Koppel de draadloze USB-netwerkadapter los en sluit deze opnieuw aan.

De met Bluetooth uitgeruste 
audiospeler kan niet worden 
gekoppeld of verbinding maken 
met het instrument.

Controleer of de Bluetooth-functie van de audiospeler is ingeschakeld. Om de 
audiospeler en het instrument met elkaar verbinding te laten maken via Bluetooth, 
moeten beide apparaten ingeschakeld zijn.

De audiospeler en het instrument moeten worden gekoppeld om via Bluetooth 
verbinding te maken met elkaar (pagina 43).

Als zich een apparaat (magnetron, draadloos netwerkapparaat enz.) in de buurt bevindt 
dat signalen uitvoert in de frequentieband van 2,4 GHz, verplaatst u dit instrument best 
uit de buurt van het apparaat dat radiofrequentiesignalen uitzendt.

Probleem Mogelijke oorzaak en oplossing
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Voorzorgsmaatregelen voor montage

VOORZICHTIG
• (CLP-885, CLP-875, CLP-845, CLP-835) De montage moet door 

ten minste twee personen worden uitgevoerd.
• (CLP-895GP, CLP-865GP) De montage moet door ten minste vier 

personen worden uitgevoerd.
• Zet het instrument in elkaar op een harde en vlakke ondergrond 

met voldoende ruimte.
• Zorg ervoor dat u de juiste onderdelen in de juiste richting 

gebruikt en zet het instrument in elkaar volgens de hier 
beschreven volgorde.

• Houd kleine onderdelen (zoals schroeven) buiten het bereik van 
kleine kinderen. Kinderen kunnen ze per ongeluk inslikken.

• Gebruik alleen de meegeleverde schroeven met de juiste 
afmetingen. Gebruik geen andere schroeven. Door het gebruik van 
onjuiste schroeven kan het instrument beschadigd of defect raken.

• Zorg ervoor dat u alle schroeven goed vastdraait bij het 
voltooien van de montage van het apparaat.

• Wanneer u het instrument na de montage verplaatst en plaatst, 
raadpleegt u 'Het verplaatsen en plaatsen van het instrument' op 
pagina 8.

• Voor demontage van het apparaat draait u de onderstaande 
volgorde om. Als u dit niet doet, kan dit leiden tot schade 
aan het instrument of lichamelijk letsel.

De Clavinova monteren

Montage van de CLP-885

Haal alle onderdelen uit de verpakking en controleer 
of u alle onderdelen hebt.

Mogelijk wordt het netsnoer en de netadapter in uw regio niet meegeleverd of 
ziet deze er anders uit dan in de bovenstaande afbeelding. Neem hiervoor 
contact op met uw Yamaha-dealer.

De Clavinova monteren

Zorg dat u een kruiskopschroevendraaier (+) van het juiste formaat 
bij de hand hebt.

Naslagpagina

CLP-885 pagina 63

CLP-875 pagina 67

CLP-845 pagina 69

CLP-835 pagina 69

CLP-895GP pagina 71

CLP-865GP pagina 75

Checklist na montage
 Er zijn geen ongebruikte onderdelen.
 Het instrument is stabiel, zelfs als u eraan schudt.
 Zowel het pedaalsnoer als het netsnoer is goed 

aangesloten op de juiste aansluitingen.

 Als een van de bovenstaande punten niet is voldaan, 
controleer dan de montageprocedure en corrigeer 
eventuele fouten. 

VOORZICHTIG
Als het apparaat een krakend geluid maakt of wankel 
aanvoelt als u op het toetsenbord speelt, raadpleegt u de 
montageschema's en draait u alle schroeven steviger vast.

Styreenschuim beschermblokken
Verwijder de styreenschuim beschermblokken uit de verpakking, 
positioneer ze op de vloer en plaats A erbovenop. Leg de blokken zo 
neer dat ze de aansluitingen aan de onderkant van A niet blokkeren.

Aansluit-
paneel

De pedalen zijn bij levering bedekt met kunststof 
hoezen. Verwijder de hoes van het demperpedaal 
voordat u met de montage start.

4 schroeven met ronde kop van 6 × 20 mm

10 schroeven met platte kop van 6 × 20 mm

10 schroeven met ronde kop van 4 × 14 mm Netsnoer

2 kabelhouders

2 dunne schroeven van 4 × 10 mm

Netadapter

Ophangbeugel voor 
de hoofdtelefoon

* Zie pagina 18 voor instructies voor het 
bevestigen van de beugel.

clp885_nl_om.book  Page 63  Friday, January 26, 2024  6:12 PM



Appendix

64 CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP Gebruikershandleiding

1. Bevestig E en F aan D.

1-1. Verwijder het kabelbindertje van het 
samengebonden pedaalsnoer.
Gooi het kabelbindertje niet weg. U hebt dit later 
nodig in stap 6.

1-2. Duw langs buiten tegen het onderste deel 
van E en F en bevestig D met vier schroeven 
met ronde kop van 6 × 20 mm.

2. Bevestig B.

2-1. Plaats B tussen E en F zoals aangegeven in 
de afbeelding en houd B vervolgens op 
5 cm afstand van D.

2-2. Laat B langzaam zakken en haak 
vervolgens de schroeven aan de rechter- 
en linkerkant van B vast aan de inkepingen 
van de beugels van E en F.

2-3. Zet het midden tijdelijk vast met twee 
schroeven met ronde kop van 4 × 14 mm.

2-4. Zet de omliggende delen tijdelijk vast met 
twee schroeven met platte kop van 
6 × 20 mm.

3. Plaats A.
Houd bij het plaatsen van het hoofdapparaat uw 
handen minstens 15 cm van de uiteinden.

VOORZICHTIG
• Let goed op dat u het hoofdapparaat niet laat vallen en dat 

uw vingers niet bekneld raken.
• Houd het hoofdapparaat uitsluitend vast zoals hierboven 

beschreven.

1-2

1-1

2-1
2-1

2-2

2-2

Juiste manier om 
B vast te houden

2-4

2-3

Breng de schroefgaten op één lijn.

Minstens 15 cm
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4. Bevestig A.

4-1. Plaats A zo dat A van achteren gezien aan 
weerszijden evenveel uitsteekt buiten E en F.

4-2. Zet A vanaf de voorkant vast met vier 
schroeven met platte kop van 6 × 20 mm.

4-3. Zet A vanaf de achterkant vast met twee 
schroeven met platte kop van 6 × 20 mm.

4-4. Draai de schroeven van de bovenste delen 
die u in stap 2-3 en 2-4 hierboven (montage 
B) tijdelijk hebt vastgezet, stevig aan.

5. Sluit het luidsprekersnoer aan.
Steek de stekker van het luidsprekersnoer zo in de 
aansluiting dat het nokje naar de voorkant wijst, 
gezien vanaf de achterkant.

6. Steek de DC-stekker van de netadapter 
in de DC IN-aansluiting.

6-1. Steek de pedaalsnoerstekker in de 
[PEDAL]-aansluiting.

6-2. Bevestig de kabelhouders op het instrument 
en klik het snoer vast in de houders. 
Controleer nu of het pedaalsnoer tussen de 
stekker en de kabelhouder niet loshangt.

6-3. Gebruik een kabelbindertje om het 
pedaalsnoer bij elkaar te binden.

4-3

4-2

4-1

4-4
Steek het pedaalsnoer stevig in 
de juiste richting totdat het 
metalen deel van de stekker niet 
meer zichtbaar is. Anders werkt 
het pedaal mogelijk niet goed. 

6-2

6-1

6-3
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6-4. Sluit het ene eind van het netsnoer aan op 
de netadapter.

6-5. Steek de DC-stekker van de netadapter in 
de DC IN-aansluiting.

7. Bevestig C (twee stuks).
Zet de twee C-stukken vast met acht schroeven met 
ronde kop van 4 × 14 mm.

8. Bevestig G en H.
Bevestig G aan de voorkant en H aan de achterkant 
door ze tegen het instrument te drukken.

6-5

Controleer na de montage de checklist op pagina 63.
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Montage van de CLP-875

Haal alle onderdelen uit de verpakking en controleer of 
u alle onderdelen hebt.

Mogelijk wordt het netsnoer en de netadapter in uw regio niet meegeleverd of 
ziet deze er anders uit dan in de bovenstaande afbeelding. Neem hiervoor 
contact op met uw Yamaha-dealer.

1. Bevestig C aan D en E. 

1-1. Maak het opgerolde pedaalsnoer los en leg 
het uit. Gooi het kunststof bindertje niet weg. 
Dit hebt u bij stap 5 nodig.

1-2. Steek de uitstekende delen in de gaten in de 
beugels en bevestig dan D en E tegen C door 
de vier dikke schroeven van 6 × 20 mm vast 
te draaien.

2. Bevestig B.
Afhankelijk van het model van de digitale piano die 
u hebt aangeschaft, kan de kleur van het oppervlak 
aan één kant van B anders zijn dan de kleur aan de 
andere kant. In dat geval plaatst u B zo dat de kant met 
de kleur die overeenkomt met D en E in de richting van 
de speler wijst. 

2-1. Lijn de schroefgaten aan de bovenkant van B 
uit met de klampgaten op D en E en bevestig 
vervolgens de bovenhoeken van B aan D en 
E door twee dunne schroeven van 4 × 12 mm 
met de hand aan te draaien.

2-2. Bevestig de onderkant van B met vier 
zelftappende schroeven van 4 × 20 mm.

2-3. Draai de schroeven aan de bovenkant van B, 
die u in stap 2-1 hebt aangebracht, goed vast.

A

B

C

D E

Styreenschuim beschermblokken
Verwijder de styreenschuim beschermblokken uit de verpakking, 
positioneer ze op de vloer en plaats A erbovenop. Leg de blokken 
zo neer dat ze het aansluitpaneel en de luidsprekerbox aan de 
onderkant van A niet blokkeren.

Opgerold pedaalsnoer 
(binnenin) De pedalen zijn bij levering bedekt 

met kunststof hoezen. Verwijder de 
hoes van het demperpedaal voordat 
u met de montage start.

Aansluitpaneel

10 dikke schroeven van 6 × 20 mm

2 dunne schroeven van 4 × 12 mm

4 zelftappende schroeven van 4 × 20 mm Netsnoer

2 kabelhouders

2 dunne schroeven van 
4 × 10 mm

Ophangbeugel voor 
de hoofdtelefoon

Netadapter

* Zie pagina 18 voor instructies voor het 
bevestigen van de beugel.

1-2

1-1

1-2

1-2

2-1, 2-3

2-2

D

B
E
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3. Plaats A.
Houd bij het plaatsen van het hoofdapparaat uw 
handen minstens 15 cm van de uiteinden. 

VOORZICHTIG
• Let goed op dat u het hoofdapparaat niet laat vallen en dat 

uw vingers niet bekneld raken.
• Houd het hoofdapparaat uitsluitend vast zoals hierboven 

beschreven.

4. Zet A vast. 

4-1. Plaats A zo dat A van voren af gezien aan 
weerszijden evenveel uitsteekt buiten D en E.

4-2. Zet A vast door de zes dikke schroeven van 
6 × 20 mm vanaf de voorzijde aan te draaien.

5. Sluit het pedaalsnoer en de 
netadapter aan. 

5-1. Steek de stekker van het pedaalsnoer in de 
[PEDAL]-aansluiting.

5-2. Bevestig de snoerhouders op het 
achterpaneel zoals afgebeeld en klik 
vervolgens het snoer vast in de houders.

5-3. Gebruik een kunststof bindbandje om 
eventueel overtollig pedaalsnoer samen 
te binden.

5-4. Sluit het ene eind van het netsnoer aan op 
de netadapter.

5-5. Steek de DC-stekker van de netadapter in 
de DC IN-aansluiting.

AA

Minstens 15 cm

Breng de schroefgaten op één lijn.

4-1

4-2

AA

AA

Steek het pedaalsnoer stevig in 
de juiste richting totdat het 
metalen deel van de stekker niet 
meer zichtbaar is. Anders werkt 
het pedaal mogelijk niet goed. 

Controleer na de montage de checklist op pagina 63.

5-15-1

5-3

5-2

5-5
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Montage van de CLP-845, CLP-835

Haal alle onderdelen uit de verpakking en controleer of 
u alle onderdelen hebt.

Mogelijk wordt het netsnoer en de netadapter in uw regio niet meegeleverd of 
ziet deze er anders uit dan in de bovenstaande afbeelding. Neem hiervoor 
contact op met uw Yamaha-dealer.

1. Bevestig C aan D en E. 

1-1. Maak het opgerolde pedaalsnoer los en leg 
het uit. Gooi het kunststof bindertje niet weg. 
Dit hebt u bij stap 5 nodig.

1-2. Steek de uitstekende delen in de gaten in de 
beugels en bevestig dan D en E tegen C door 
de vier dikke schroeven van 6 × 20 mm vast te 
draaien.

2. Bevestig B.
Afhankelijk van het model van de digitale piano die u hebt 
aangeschaft, kan de kleur van het oppervlak aan één kant 
van B anders zijn dan de kleur aan de andere kant. In dat 
geval plaatst u B zo dat de kant met de kleur die 
overeenkomt met D en E in de richting van de speler wijst. 

2-1. Lijn de schroefgaten aan de bovenkant van 
B uit met de klampgaten op D en E en 
bevestig vervolgens de bovenhoeken van 
B aan D en E door twee dunne schroeven 
van 4 × 12 mm met de hand aan te draaien.

2-2. Bevestig de onderkant van B met vier 
zelftappende schroeven van 4 × 20 mm.

2-3. Draai de schroeven aan de bovenkant van B, 
die u in stap 2-1 hebt aangebracht, goed vast.

Styreenschuim beschermblokken
Verwijder de styreenschuim beschermblokken uit de verpakking, 
positioneer ze op de vloer en plaats A erbovenop. Leg de blokken 
zo neer dat ze het aansluitpaneel en de luidsprekerbox aan de 
onderkant van A niet blokkeren.

Opgerold pedaalsnoer 
(binnenin) De pedalen zijn bij levering bedekt 

met kunststof hoezen. Verwijder de 
hoes van het demperpedaal voordat 
u met de montage start.

Aansluitpaneel

10 dikke schroeven van 6 × 20 mm

2 dunne schroeven van 4 × 12 mm

4 zelftappende schroeven van 4 × 20 mm Netsnoer

2 kabelhouders

2 dunne schroeven 
van 4 × 10 mm

Ophangbeugel voor 
de hoofdtelefoon

Netadapter

* Zie pagina 18 voor instructies voor het 
bevestigen van de beugel.

1-2

1-2

1-2

1-1

2-1, 2-3

2-2
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3. Plaats A.
Houd bij het plaatsen van het hoofdapparaat uw 
handen minstens 15 cm van de uiteinden.

VOORZICHTIG
• Let goed op dat u het hoofdapparaat niet laat vallen en dat 

uw vingers niet bekneld raken.
• Houd het hoofdapparaat uitsluitend vast zoals hierboven 

beschreven.

4. Zet A vast.

4-1. Plaats A zo dat A van voren af gezien aan 
weerszijden evenveel uitsteekt buiten D en E.

4-2. Zet A vast door de zes dikke schroeven van 
6 × 20 mm vanaf de voorzijde aan te draaien.

5. Sluit het pedaalsnoer en de 
netadapter aan. 

5-1. Steek de stekker van het pedaalsnoer in de 
[PEDAL]-aansluiting.

5-2. Bevestig de snoerhouders op het 
achterpaneel zoals afgebeeld en klik 
vervolgens het snoer vast in de houders.

5-3. Gebruik een kunststof bindbandje om 
eventueel overtollig pedaalsnoer samen 
te binden.

5-4. Sluit het ene eind van het netsnoer aan op 
de netadapter.

5-5. Steek de DC-stekker van de netadapter in 
de DC IN-aansluiting.

A

Minstens 15 cm

Breng de schroefgaten op één lijn.

A4-1

4-2

Steek het pedaalsnoer stevig in 
de juiste richting totdat het 
metalen deel van de stekker niet 
meer zichtbaar is. Anders werkt 
het pedaal mogelijk niet goed. 

Controleer na de montage de checklist op pagina 63.

5-1

5-3

5-2

5-5
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Montage van de CLP-895GP

Haal alle onderdelen uit de verpakking en controleer of 
u alle onderdelen hebt.

Hoofdapparaat
Plaats het hoofdapparaat op de piepschuimen beschermblokken om schade aan de 
connectorpanelen aan de onderkant van het hoofdapparaat te voorkomen. Zorg er ook 
voor dat de beschermblokken de connectorpanelen niet raken. 

Mogelijk wordt het netsnoer en de netadapter in uw regio niet meegeleverd of ziet 
deze er anders uit dan in de bovenstaande afbeelding. Neem hiervoor contact op 
met uw Yamaha-dealer.

1. Zet het hoofdapparaat tegen de muur 
zoals hieronder afgebeeld.

VOORZICHTIG
Let erop dat uw vingers niet beklemd raken. 

1-1. Spreid een groot zacht kleed, zoals een 
deken, uit om de vloer en de muur te 
beschermen (zoals aangegeven).

1-2. Kantel het hoofdapparaat met de toetsenklep 
dicht en de toetsen naar beneden gericht 
tegen de muur.Pedalenconsole

Beschermblokken

Kabelhouder

Netsnoer

Bevat opgerold pedaalsnoer.
De pedalen zijn bij levering bedekt 
met kunststof hoezen. Verwijder de 
hoes van het demperpedaal voor 
optimaal gebruik van het GP 
Responsive-demperpedaaleffect.

Poten

Pootbalken

Lierbeugels

Bevestigingsschroeven van 6 × 20 mm 
(4 st.)

Bevestigingsschroeven van 6 × 40 mm 
(12 st.)

Dunne schroeven van 4 × 16 mm 
(4 st.)

Dunne schroeven van 4 × 10 mm 
(12 st.)

Aansluitpaneel

Netadapter

Dunne schroeven van 4 × 10 mm 
(4 st.)

Adapterhouders

Ophangbeugel 
voor de 
hoofdtelefoon

Dunne schroeven van 4 × 10 mm 
(2 st.)

* Zie pagina 18 voor instructies voor het bevestigen van de beugel.

Plaats de kant van het 
toetsenbord naar beneden.

Onjuist

LET OP
Plaats het instrument niet zoals weergegeven in de afbeelding.

Onjuist

Onjuist
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2. Bevestig de drie poten en de drie 
pootbalken.
Raadpleeg de tekening voor de juiste richting 
van de poten.

2-1. Plaats in elke poot 4 schroeven en maak 
deze vast. Begin met een van de voorpoten.

2-2. Plaats in elke poot 4 schroeven en maak 
deze vast. Begin met een van de voorpoten.

2-3. Schuif de pootbalken over de poten en 
bevestig ze aan elk van de poten met behulp 
van vier dunne schroeven (4 × 10 mm).
Zorg ervoor dat de geleidelijk hellende zijde van de 
pootbalken naar de binnenkant van het apparaat is 
gericht, zoals weergegeven.

3. Bevestig de lierbeugels.

3-1. Bevestig de lierbeugels met de vier dunne 
schroeven (4 × 16 mm).

4. Zet het apparaat op de poten.
Gebruik de voorpoten als steun bij het rechtop zetten.

Achterpoot

Voorpoot Voorpoot

Bevestigingsschroeven van 6 × 40 mm

Dunne schroeven 
van 4 × 10 mm

De geleidelijk 
hellende kant is 
naar binnen gericht.

3-1

Dunne schroeven 
van 4 × 16 mm
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5. Plaats de pedalenconsole.

5-1. Verwijder het kabelbindertje en plakband 
waarmee het pedaalsnoer aan het bovenste 
gedeelte van de pedalenconsole vastzit.

5-2. Bevestig de voorkant van de 
pedalenconsole aan de onderkant 
van het apparaat door de twee 
bevestigingsschroeven (6 × 20 mm) 
met de hand aan te draaien.

5-3. Steek de lierbeugels in de uitsparingen van 
de pedalenconsole en zorg ervoor dat ze 
stevig op hun plaats zitten.

5-4. Lijn het snoer uit met de groef op het 
apparaat en bevestig de achterkant van de 
pedalenconsole met behulp van de twee 
bevestigingsschroeven (6 × 20 mm) en 
draai vervolgens de twee schroeven van de 
voorkant van de pedalenconsole die u in 
stap 5-2 hebt bevestigd, stevig vast.

5-5. Draai de vier schroeven los die in stap 
3 waren bevestigd en draai vervolgens de 
vier schroeven weer stevig vast terwijl u de 
lierbeugels in de richting van de pijlen 
duwt, zoals afgebeeld.

Plakband Bindertje

Bevestigingsschroeven 
van 6 × 20 mm

Bevestigingsschroeven van 6 × 20 mm
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5-6. Steek de pedaalsnoerstekker in de 
[PEDAL]-aansluiting. Steek de stekker erin 
met de pijl naar voren (in de richting van 
het toetsenbord).
Als de stekker er niet makkelijk ingaat, forceer deze 
dan niet. Controleer of u de stekker goed vasthoudt 
en probeer het nogmaals.

5-7. Bevestig de kabelhouder aan de onderkant 
van het hoofdapparaat zoals afgebeeld en 
klem de houder vervolgens rond de kabel.

6. De netadapter aansluiten.

6-1. Sluit het ene eind van het netsnoer aan op 
de netadapter.

6-2. Steek de DC-stekker van de netadapter in 
de DC IN-aansluiting.

7. Indien gewenst kan de netadapter aan 
de onderkant van de unit bevestigd 
worden met behulp van de 
adapterhouders.
Raadpleeg de ingesloten informatie bij de 
adapterhouders voor specifieke instructies. 

VOORZICHTIG
Voor de demontage van het apparaat draait u de volgorde 
om. Als u dit niet doet, kan dit leiden tot schade aan het 
instrument of lichamelijk letsel. In het bijzonder, als u het 
hoofdapparaat neerlegt zonder de pedalenconsole los te 
maken, zullen de pedalen breken.

5-7

5-6

Steek het pedaalsnoer stevig in de juiste 
richting totdat het metalen deel van de stekker 
niet meer zichtbaar is. Anders werkt het 
pedaal mogelijk niet goed.

Controleer na de montage de checklist op pagina 63.

Netadapter

Dunne 
schroeven van 
4 × 10 mm
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Montage van de CLP-865GP

Haal alle onderdelen uit de verpakking en controleer of 
u alle onderdelen hebt.

Mogelijk wordt het netsnoer en de netadapter in uw regio niet meegeleverd of 
ziet deze er anders uit dan in de bovenstaande afbeelding. Neem hiervoor 
contact op met uw Yamaha-dealer.

1. Zet het instrument tegen de muur 
zoals hieronder afgebeeld.

VOORZICHTIG
Let erop dat uw vingers niet beklemd raken.

1-1. Spreid een groot zacht kleed, zoals een 
deken, uit om de vloer en de muur te 
beschermen (zoals aangegeven).

1-2. Kantel het hoofdapparaat met de 
toetsenklep dicht en de toetsen naar 
beneden gericht tegen de muur.

Poten Pedalenconsole

12 bevestigingsschroeven van 
6 × 40 mm

Kabelhouder

4 bevestigingsschroeven van 
6 × 20 mm

Netsnoer

Bevat opgerold pedaalsnoer.
De pedalen zijn bij levering 
bedekt met kunststof hoezen. 
Verwijder de hoes van het 
demperpedaal voordat u met 
de montage start.

Aansluitpaneel

Hoofdapparaat
Plaats het hoofdapparaat op de piepschuimen beschermblokken om 
schade aan de connectorpanelen aan de onderkant van het hoofdapparaat 
te voorkomen. Zorg er ook voor dat de beschermblokken de 
connectorpanelen niet raken.

Ophangbeugel voor 
de hoofdtelefoon 2 dunne schroeven van

4 × 10 mm

Netadapter

4 dunne schroeven van
4 × 10 mmAdapterhouders

Beschermblokken

* Zie pagina 18 voor instructies voor het bevestigen van de beugel.

Plaats de kant van het 
toetsenbord naar beneden.

Onjuist

LET OP
Plaats het instrument niet zoals weergegeven in de 
afbeelding.

Onjuist

Onjuist
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2. Bevestig twee voorpoten en een 
achterpoot.
Raadpleeg de tekening voor de juiste richting 
van de poten.

2-1. Plaats in elke poot 4 schroeven en maak 
deze vast. Begin met een van de voorpoten.

3. Plaats de pedalenconsole.

3-1. Verwijder het kabelbindertje waarmee het 
pedaalsnoer aan het bovenste gedeelte van 
de pedalenconsole vast zit.

3-2. Breng het snoer op één lijn met de 
uitsparing in het apparaat en bevestig de 
pedalenconsole met vier schroeven.

3-3. Steek de pedaalsnoerstekker in de 
[PEDAL]-aansluiting. Steek de stekker erin 
met de pijl naar voren (in de richting van 
het toetsenbord). Als de stekker er niet 
makkelijk ingaat, forceer deze dan niet. 
Controleer of u de stekker goed vasthoudt 
en probeer het nogmaals.

3-4. Bevestig de kabelhouder aan de onderkant 
van het hoofdapparaat zoals afgebeeld en 
klem de houder vervolgens rond de kabel.

Achterpoot

Voorpoot Voorpoot

Bevestigingsschroeven van 6 × 40 mm

BindertjePlakband

Bevestigingsschroeven van 6 × 20 mm

3-3

3-4

Steek het pedaalsnoer stevig in de juiste 
richting totdat het metalen deel van de 
stekker niet meer zichtbaar is. Anders 
werkt het pedaal mogelijk niet goed.
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4. Zet het apparaat op de poten.
Gebruik de voorpoten als steun bij het rechtop zetten.

VOORZICHTIG
Let erop dat uw vingers niet beklemd raken. Als u het instrument 
rechtop zet, houd het dan niet vast bij de toetsenklep.

5. De netadapter aansluiten.

5-1. Sluit het ene eind van het netsnoer aan 
op de netadapter.

5-2. Steek de DC-stekker van de netadapter in 
de DC IN-aansluiting.

6. Indien gewenst kan de netadapter 
aan de onderkant van de unit 
bevestigd worden met behulp 
van de adapterhouders.
Raadpleeg de ingesloten informatie bij de 
adapterhouders voor specifieke instructies. 

VOORZICHTIG
Voor de demontage van het apparaat draait u de volgorde om. 
Als u dit niet doet, kan dit leiden tot schade aan het 
instrument of lichamelijk letsel. In het bijzonder, als u het 
hoofdapparaat neerlegt zonder de pedalenconsole los te 
maken, zullen de pedalen breken.

Controleer na de montage de checklist op pagina 63.

Netadapter

Dunne 
schroeven van 
4 × 10 mm
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Specificaties (CLP-885, CLP-875, CLP-845, CLP-835)
Raadpleeg pagina 81 voor specificaties van de CLP-895GP en CLP-865GP. 

Specificaties

CLP-885 CLP-875 CLP-845 CLP-835

Productnaam Digitale piano

Grootte/
gewicht

Breedte
[Voor modellen met gepolijste afwerking]

1461 mm
[1467 mm]

1450 mm
[1455 mm]

Hoogte
[Voor modellen 
met gepolijste 
afwerking]

Met gesloten 
muziekstandaard 1027 mm

[1029 mm]

967 mm
[970 mm]

927 mm
[930 mm]

Met opgezette 
muziekstandaard

1130 mm
[1131 mm]

1091 mm
[1092 mm]

1083 mm
[1084 mm]

Diepte
[Voor modellen met gepolijste afwerking]

494 mm
[494 mm]

465 mm
[465 mm]

460 mm
[460 mm]

Gewicht
[Voor modellen met gepolijste afwerking]

87 kg
[90 kg]

71 kg
[74 kg]

60 kg
[63 kg]

57 kg
[60 kg]

Bedieningsin-
terface

Toetsenbord

Aantal toetsen 88

Type
GrandTouch-toetsenbord: houten toetsen 

(alleen wit), toetsbedekking van synthetisch 
ebbenhout en ivoor, echappement

GrandTouch-S 
toetsenbord: houten 
toetsen (alleen wit), 
toetsbedekking van 

synthetisch 
ebbenhout en ivoor, 

echappement

GrandTouch-S 
toetsenbord: 

toetsplaatjes van 
synthetisch 

ebbenhout en ivoor, 
echappement

Aanslaggevoeligheid Hard2, Hard1, Medium, Soft1, Soft2, Fixed

88-toetsen Linear 
Graded Hammers

Ja –

Contragewicht Ja –

Pedaal

Aantal pedalen 3: Demper (met half-pedaaleffect), Sostenuto, Soft

GrandTouch-pedalen Ja (met GP Response-demper) Ja

Toewijsbare functies
Sustain (Switch), Sustain Continuously, Sostenuto, Soft, Pitch Bend Up, Pitch Bend Down, 

Rotary Speed, Vibe Rotor, Song Play/Pause

Display
Type Full Dot LCD

Language (taal) Engels, Japans

Paneel
Type Touch sensoren Knoppen

Language (taal) Engels

Kast
Type toetsenklep Scharnierend Schuivend

Muziekstandaard Ja (met muzieksteunen)

Voices

Toongenerator

Pianogeluid Yamaha CFX, Bösendorfer Imperial

Binaural Sampling Ja (alleen 'CFX Grand' en 'Bösendorfer')

VRM (Virtual 
Resonance Modeling)

Ja

Grand Expression 
Modelling

Ja

Polyfonie (max.) 256

Voorinstelling Aantal voices
53 voices + 480 XG 
voices + 14 Drum/

SFX-kits
38 voices

Compatibiliteit

XG (GM), GS (voor 
het afspelen van 

songs), GM2 (voor het 
afspelen van songs)

–

Effecten Typen

Reverb 7 typen

Chorus 3 typen

Helderheid 7 typen + User

Invoegeffect 12 typen

Intelligente 
akoestische regeling 
(IAC)

Ja

Stereofonische 
optimizer

Ja

clp885_nl_om.book  Page 78  Friday, January 26, 2024  6:12 PM



Appendix

79 CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP Gebruikershandleiding

Effecten Functies

Dual Ja

Split Ja

Duo Ja

Songs 

Voorinstelling
Aantal vooraf 
ingestelde songs

27 voicedemo +
50 klassiekers +

303 lessongs
23 voicedemo + 50 klassiekers + 303 lessongs

MIDI-opname

Aantal songs 250

Aantal tracks 16

Datacapaciteit Ca. 500 KB/song (ca. 22.000 noten)

Audio-opname 
(USB-stick)

Opnametijd (max.) 80 minuten/song

Compatibele 
data-indeling

Afspelen SMF (indeling 0, indeling 1), WAV (44,1 kHz, 16-bits, stereo)

Opnemen SMF (indeling 0), WAV (44,1 kHz, 16-bits, stereo)

Functies

Piano Room Ja

Ritme Aantal Ritmen 20

Totaalregelaars

Metronoom Ja

Tempobereik 5 – 500

Transponeren -12 – 0 – +12

Stemmen 414,8 – 440,0 – 466,8 Hz (stappen van ongeveer 0,2 Hz)

Toonladdertypen 7 typen

USB Audio-interface 44,1 kHz, 24-bits, stereo

Bluetooth
(Beschikt 
mogelijk niet 
over de functie, 
afhankelijk van 
het land waarin 
u het product 
kocht).

Audio Ondersteund profiel: A2DP, compatibele codec: SBC

MIDI Conform Bluetooth Low Energy MIDI specificatie

Bluetooth-versie 5,0 

Draadloze uitvoer Bluetooth klasse 2

Maximale 
communicatieafstand

Ca. 10 m

Radiofrequentie 2401 – 2481 MHz

Maximum 
uitgangsvermogen 
(EIRP)

4 dBm

Type modulatie GFSK

Opslag en 
aansluitingen

Opslag
Intern geheugen Ca. 1,4 MB

Externe stations  USB-stick

Aansluitingen

Hoofdtelefoon Standaardaansluiting voor stereohoofdtelefoon (× 2)

AUX IN Stereo mini-aansluiting

AUX OUT Standaard hoofdtelefoonaansluiting (L/L+R, R)

USB TO DEVICE Type A

USB TO HOST Type B

DC IN 24 V 16 V

Versterkers en 
luidsprekers

Versterkers
(45 W + 30 W + 40 W) 

× 2
(45 W + 25 W + 40 W) 

× 2
(45 W + 45 W) × 2 30 W × 2

Luidsprekers

(16 cm met diffuser + 
8 cm met diffuser + 
2,5 cm (dome) met 

bidirectionele hoorn) 
× 2, luidspreker van 

sparrenhout

(16 cm + 8 cm met 
diffuser + 2,5 cm 

(dome) met 
bidirectionele

hoorn) × 2

(16 cm met diffuser + 
8 cm met diffuser) × 2

16 cm met diffuser × 2

Spannings-
voorziening

Netadapter PA-500 PA-300C

Uitvoer DC 24 V, 2,5 A DC 16 V, 2,4 A

Polariteit

Stroomverbruik
55 W

(Bij het gebruik van 
PA-500 netadapter)

55 W
(Bij het gebruik van 
PA-500 netadapter)

30 W
(Bij het gebruik van 
PA-500 netadapter)

18 W
(Bij het gebruik van 

PA-300C netadapter)

CLP-885 CLP-875 CLP-845 CLP-835
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De inhoud van deze handleiding geldt voor de meest recente specificaties op de datum dat de handleiding werd gepubliceerd. Voor de meest recente 
handleiding gaat u naar de website van Yamaha, waar u het bestand met de handleiding kunt downloaden. Aangezien specificaties, apparatuur en 
afzonderlijk verkochte accessoires kunnen verschillen per gebied, kunt u het beste contact opnemen met uw Yamaha-leverancier.

Meegeleverde accessoires

• Gebruikershandleiding
• Muziekboek '50 Classical Music Masterpieces'
• Online Member Product Registration (Online productregistratie)
• Kruk*
• Netsnoer*, netadapter*: (CLP-885/CLP-875/CLP-845) PA-500, (CLP-835) PA-300C

*Wordt mogelijk niet meegeleverd in uw regio. Neem hiervoor contact op met uw Yamaha-dealer.

Afzonderlijk verkrijgbare accessoires
(Beschikbaarheid verschilt per regio.)

• Hoofdtelefoon: HPH-150, HPH-100, HPH-50
• Pedaaleenheid: FC35
• Netadapter: (CLP-885/CLP-875/CLP-845) PA-500, (CLP-835) PA-300C
• Draadloze USB-netwerkadapter: UD-WL01

CLP-885 CLP-875 CLP-845 CLP-835
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Specificaties (CLP-895GP, CLP-865GP)
Raadpleeg pagina 78 voor specificaties van de CLP-885, CLP-875, CLP-845 en CLP-835. 

CLP-895GP CLP-865GP

Productnaam Digitale piano

Grootte/
gewicht

Breedte 1430 mm

Hoogte

Met gesloten 
muziekstandaard

932 mm

Met opgezette 
muziekstandaard

1094 mm

Hoogte met klep omhoog 1577 mm 1400 mm

Diepte 1237 mm 1146 mm

Gewicht 135 kg 106 kg

Bedienings-
interface

Toetsenbord

Aantal toetsen 88

Type
GrandTouch-toetsenbord: houten toetsen 

(alleen wit), toetsbedekking van synthetisch 
ebbenhout en ivoor, echappement

GrandTouch-S toetsenbord: toetsplaatjes van 
synthetisch ebbenhout en ivoor, echappement

Aanslaggevoeligheid Hard2, Hard1, Medium, Soft1, Soft2, Fixed

88-toetsen Linear 
Graded Hammers

Ja –

Contragewicht Ja –

Pedaal

Aantal pedalen 3: Demper (met half-pedaaleffect), Sostenuto, Soft

GrandTouch-pedalen Ja (met GP Response-demper) Ja

Toewijsbare functies
Sustain (Switch), Sustain Continuously, Sostenuto, Soft, Pitch Bend Up, Pitch Bend Down, 

Rotary Speed, Vibe Rotor, Song Play/Pause

Display
Type Full Dot LCD

Language (taal) Engels, Japans

Paneel
Type Touch sensoren Knoppen

Language (taal) Engels

Kast
Type toetsenklep Schuivend

Muziekstandaard Ja (met muzieksteunen)

Voices

Toongenerator

Pianogeluid Yamaha CFX, Bösendorfer Imperial

Binaural Sampling Ja (alleen 'CFX Grand' en 'Bösendorfer')

VRM (Virtual 
Resonance Modeling)

Ja

Grand Expression 
Modelling

Ja

Polyfonie (max.) 256

Voorinstelling Aantal voices
53 voices+ 480 XG-voices + 

14 drum/SFX-kits
38 voices

Compatibiliteit
XG (GM), GS (voor het afspelen van songs),

 GM2 (voor het afspelen van songs)
–

Effecten

Typen

Reverb 7 typen

Chorus 3 typen

Helderheid 7 typen + User

Invoegeffect 12 typen

Intelligente 
akoestische regeling 
(IAC)

Ja

Stereofonische 
optimizer

Ja

Functies

Dual Ja

Split Ja

Duo Ja

Songs

Voorinstelling
Aantal vooraf 
ingestelde songs

27 voicedemo + 50 klassiekers + 
303 lessongs

23 voicedemo + 50 klassiekers + 
303 lessongs

MIDI-opname

Aantal songs 250

Aantal tracks 16

Datacapaciteit Ca. 500 KB/song (ca. 22.000 noten)
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De inhoud van deze handleiding geldt voor de meest recente specificaties op de datum dat de handleiding werd gepubliceerd. Voor de meest recente 
handleiding gaat u naar de website van Yamaha, waar u het bestand met de handleiding kunt downloaden. Aangezien specificaties, apparatuur en 
afzonderlijk verkochte accessoires kunnen verschillen per gebied, kunt u het beste contact opnemen met uw Yamaha-leverancier.

Songs

Audio-opname 
(USB-stick) 

Opnametijd (max.) 80 minuten/song

Compatibele 
data-indeling

Afspelen SMF (indeling 0, indeling 1), WAV (44,1 kHz, 16-bits, stereo)

Opnemen  SMF (indeling 0), WAV (44,1 kHz, 16-bits, stereo)

Functies

Piano Room Ja

Ritme Aantal Ritmen 20

Totaalregelaars

Metronoom Ja

Tempobereik 5 – 500

Transponeren -12 – 0 – +12

Stemmen 414,8 – 440,0 – 466,8 Hz (stappen van ongeveer 0,2 Hz)

Toonladdertypen 7 typen

USB Audio-interface 44,1 kHz, 24-bits, stereo

Bluetooth
(Beschikt 
mogelijk niet 
over de functie, 
afhankelijk van 
het land waarin 
u het product
kocht).

Audio Ondersteund profiel: A2DP, compatibele codec: SBC

MIDI Conform Bluetooth Low Energy MIDI specificatie

Bluetooth-versie 5,0 

Draadloze uitvoer Bluetooth klasse 2

Maximale 
communicatieafstand

Ca. 10 m

Radiofrequentie 2401 – 2481 MHz

Maximum 
uitgangsvermogen 
(EIRP)

4 dBm

Type modulatie GFSK

Opslag en 
aansluitingen

Opslag
Intern geheugen Ca. 1,4 MB

Externe stations  USB-stick

Aansluitingen

Hoofdtelefoon Standaardaansluiting voor stereohoofdtelefoon (× 2)

AUX IN Stereo mini-aansluiting

AUX OUT Standaard hoofdtelefoonaansluiting (L/L+R, R)

USB TO DEVICE Type A

USB TO HOST Type B

DC IN 24 V

Versterkers en 
luidsprekers

Versterkers (45 W + 45 W + 45 W) × 2 (45 W + 35 W) × 2

Luidsprekers
(16 cm + 8 cm met golfgeleider + 2,5 cm 

(dome) met golfgeleider) × 2, 
Luidspreker van sparrenhout

(16 cm met diffuser + 5 cm) × 2

Spannings-
voorziening

Netadapter PA-500

Uitvoer DC 24 V, 2,5 A

Polariteit

Stroomverbruik
60 W

(Bij het gebruik van PA-500 netadapter)
55 W

(Bij het gebruik van PA-500 netadapter)

Meegeleverde accessoires

• Gebruikershandleiding
• Muziekboek '50 Classical Music Masterpieces'
• Online Member Product Registration (Online productregistratie)
• Kruk*
• Netsnoer*, netadapter*: PA-500

*Wordt mogelijk niet meegeleverd in uw regio. Neem hiervoor contact op met uw Yamaha-dealer.

Afzonderlijk verkrijgbare accessoires
(Beschikbaarheid verschilt per regio.)

• Hoofdtelefoon: HPH-150, HPH-100, HPH-50
• Pedaaleenheid: FC35
• Netadapter: PA-500 
• Draadloze USB-netwerkadapter: UD-WL01

CLP-895GP CLP-865GP
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A
Aanslagsterkte ...............................24

A-B Repeat ....................................34

Afspelen (ritme) .............................29

Afspelen (song) .............................30

App ................................................46

Audio Loopback .............................49

Audio-opname ...............................37

Audiosong .....................................30

Automatisch uitschakelen ..............17

[AUX IN]-aansluiting ......................45

B
Bedieningspaneel ..........................20

Berichtenlijst ..................................58

Bluetooth .......................7, 21, 43, 46

C
Computer .......................................48

D
Datalijst ..........................................10

Demo .......................................31, 55

Dempergeluid ................................24

Demperresonantie .........................24

Draadloos netwerk ........................47

Dual ...............................................27

Duo ................................................28

Duplexscalingresonantie ...............24

F
Fabrieksinstellingen herstellen ......22

Formatteren (USB-stick) ................49

G
Grand Expression Modelling .........25

H
Half-pedaal ....................................25

Helderheid .....................................24

Herhaaldelijk afspelen ...................33

Hoofdstemming .............................24

Hoofdtelefoon ................................18

I
Initialiseren 
(fabrieksinstellingen herstellen) .....22

Invoer ............................................43

K
Klankkastresonantie ......................24

Klep .........................................15, 24

Koppelen .......................................44

L
Lijst met ritmen ............................. 56

Lijst met songs .............................. 57

M
Menu ............................................. 51

Menu Metronome/Rhythm ............ 51

Menu Recording ........................... 51

Menu Song ................................... 51

Menu System ................................ 51

Menu Voice ................................... 51

Metronoom ................................... 25

MIDI-opname ................................ 37

MIDI-song ..................................... 30

Montage ........................................ 63

Muziekstandaard .......................... 15

N
Naslaggids .................................... 10

O
Opname van meerdere tracks ...... 41

Opnemen ...................................... 37

Overdubben .................................. 41

P
Partij (afspelen) ............................ 35

Partij (opname) ....................... 40, 41

Pedaal .......................................... 19

Piano Room .................................. 23

Pitch .............................................. 24

Problemen oplossen ..................... 61

R
Resetten ....................................... 22

Reverb .......................................... 24

Ritme ............................................ 29

S
Smart Pianist ................................ 46

Smart Pianist User Guide 
(Gebruikershandleiding  
Smart Pianist) ............................... 10

Smartapparaat .............................. 46

Snaarresonantie ........................... 24

Snel vooruitspoelen ...................... 32

Snelheid ........................................ 33

Song ............................................. 30

Split ............................................... 27

Splitpunt ........................................ 28

Stemmen ...................................... 24

T
Tempo ............................... 25, 29, 33

Terugspoelen ................................ 32

Toetsenklep .................................. 14

Track (afspelen) ............................ 35

Track (opname) ....................... 40, 41

Transponeren ................................ 36

U
Uitvoer ........................................... 50

USB Audio-interface ..................... 48

USB [TO DEVICE]-aansluiting ...... 47

USB [TO HOST]-aansluiting ... 45, 47

USB-stick ...................................... 49

V
Verwijderen ................................... 42

Voeding ................................... 16, 17

Voice ............................................. 26

Voicedemo .............................. 31, 55

Voicelijst ........................................ 52

Volume .......................................... 18
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W
Wifi ................................................ 47

X
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Voor de Europese Unie en het Verenigd Koninkrijk

(559-M01 RED DoC URL 03)

EN SIMPLIFIED EU DECLARATION OF CONFORMITY / 
SIMPLIFIED UK DECLARATION OF CONFORMITY

Hereby, Yamaha Corporation declares that the radio equipment type [CLP-
885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] is in 
compliance with Directive 2014/53/EU and the radio equipment regulations 
of UK. The full texts of the EU declaration of conformity and the UK 
declaration of conformity are available at the following internet address:
https://europe.yamaha.com/en/support/compliance/doc.html

FR DECLARATION UE DE CONFORMITE SIMPLIFIEE
Le soussigné, Yamaha Corporation, déclare que l'équipement radioélectrique du 
type [CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] est 
conforme à la directive 2014/53/UE. Le texte complet de la déclaration UE de 
conformité est disponible à l'adresse internet suivante :
https://europe.yamaha.com/en/support/compliance/doc.html

DE VEREINFACHTE EU-KONFORMITÄTSERKLÄRUNG
Hiermit erklärt Yamaha Corporation, dass der Funkanlagentyp [CLP-885, 
CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] der Richtlinie 2014/
53/EU entspricht. Der vollständige Text der EU-Konformitätserklärung ist 
unter der folgenden Internetadresse verfügbar:
https://europe.yamaha.com/en/support/compliance/doc.html

SV FÖRENKLAD EU-FÖRSÄKRAN OM ÖVERENSSTÄMMELSE
Härmed försäkrar Yamaha Corporation att denna typ av radioutrustning 
[CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] 
överensstämmer med direktiv 2014/53/EU. Den fullständiga texten till EU-
försäkran om överensstämmelse finns på följande webbadress:
https://europe.yamaha.com/en/support/compliance/doc.html

IT DICHIARAZIONE DI CONFORMITÀ UE SEMPLIFICATA
Il fabbricante, Yamaha Corporation, dichiara che il tipo di apparecchiatura 
radio [CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] è 
conforme alla direttiva 2014/53/UE. Il testo completo della dichiarazione di 
conformità UE è disponibile al seguente indirizzo Internet:
https://europe.yamaha.com/en/support/compliance/doc.html

ES DECLARACIÓN UE DE CONFORMIDAD SIMPLIFICADA
Por la presente, Yamaha Corporation declara que el tipo de equipo 
radioeléctrico [CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-
865GP] es conforme con la Directiva 2014/53/UE. El texto completo de la 
declaración UE de conformidad está disponible en la dirección Internet 
siguiente:
https://europe.yamaha.com/en/support/compliance/doc.html

PT DECLARAÇÃO UE DE CONFORMIDADE SIMPLIFICADA
O(a) abaixo assinado(a) Yamaha Corporation declara que o presente tipo 
de equipamento de rádio [CLP-885, CLP-875, CLP-845, CLP-835, CLP-
-895GP, CLP-865GP] está em conformidade com a Diretiva 2014/53/UE. O 
texto integral da declaração de conformidade está disponível no seguinte 
endereço de Internet:
https://europe.yamaha.com/en/support/compliance/doc.html

NL VEREENVOUDIGDE EU-CONFORMITEITSVERKLARING
Hierbij verklaar ik, Yamaha Corporation, dat het type radioapparatuur [CLP-
885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] conform is 
met Richtlijn 2014/53/EU. De volledige tekst van de EU-
conformiteitsverklaring kan worden geraadpleegd op het volgende 
internetadres:
https://europe.yamaha.com/en/support/compliance/doc.html

BG ОПРОСТЕНА ЕС ДЕКЛАРАЦИЯ ЗА СЪОТВЕТСТВИЕ
С настоящото Yamaha Corporation декларира, че този тип 
радиосъоръжение [CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, 
CLP-865GP] е в съответствие с Директива 2014/53/ЕС. Цялостният 
текст на ЕС декларацията за съответствие може да се намери на 
следния интернет адрес:
https://europe.yamaha.com/en/support/compliance/doc.html

CS ZJEDNODUŠENÉ EU PROHLÁŠENÍ O SHODĚ
Tímto Yamaha Corporation prohlašuje, že typ rádiového zařízení [CLP-885, 
CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] je v souladu se 
směrnicí 2014/53/EU. Úplné znění EU prohlášení o shodě je k dispozici na 
této internetové adrese:
https://europe.yamaha.com/en/support/compliance/doc.html

DA FORENKLET EU-OVERENSSTEMMELSESERKLÆRING
Hermed erklærer Yamaha Corporation, at radioudstyrstypen [CLP-885, 
CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] er i 
overensstemmelse med direktiv 2014/53/EU. EU-
overensstemmelseserklæringens fulde tekst kan findes på følgende 
internetadresse:
https://europe.yamaha.com/en/support/compliance/doc.html

ET LIHTSUSTATUD ELI VASTAVUSDEKLARATSIOON
Käesolevaga deklareerib Yamaha Corporation, et käesolev raadioseadme 
tüüp [CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] 
vastab direktiivi 2014/53/EL nõuetele. ELi vastavusdeklaratsiooni täielik 
tekst on kättesaadav järgmisel internetiaadressil:
https://europe.yamaha.com/en/support/compliance/doc.html

EL ΑΠΛΟΥΣΤΕΥΜΕΝΗ ΔΗΛΩΣΗ ΣΥΜΜΟΡΦΩΣΗΣ ΕΕ
Με την παρούσα ο/η Yamaha Corporation, δηλώνει ότι ο ραδιοεξοπλισμός 
[CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] πληροί 
την οδηγία 2014/53/ΕΕ. Το πλήρες κείμενο της δήλωσης συμμόρφωσης ΕΕ 
διατίθεται στην ακόλουθη ιστοσελίδα στο διαδίκτυο:
https://europe.yamaha.com/en/support/compliance/doc.html

HR POJEDNOSTAVLJENA EU IZJAVA O SUKLADNOSTI
Yamaha Corporation ovime izjavljuje da je radijska oprema tipa [CLP-885, 
CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] u skladu s 
Direktivom 2014/53/EU. Cjeloviti tekst EU izjave o sukladnosti dostupan je 
na sljedećoj internetskoj adresi:
https://europe.yamaha.com/en/support/compliance/doc.html

LV VIENKĀRŠOTA ES ATBILSTĪBAS DEKLARĀCIJA
Ar šo Yamaha Corporation deklarē, ka radioiekārta [CLP-885, CLP-875, 
CLP-845, CLP-835, CLP-895GP, CLP-865GP] atbilst Direktīvai 2014/53/ES. 
Pilns ES atbilstības deklarācijas teksts ir pieejams šādā interneta vietnē:
https://europe.yamaha.com/en/support/compliance/doc.html

LT SUPAPRASTINTA ES ATITIKTIES DEKLARACIJA
Aš, Yamaha Corporation, patvirtinu, kad radijo įrenginių tipas [CLP-885, CLP-
875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] atitinka Direktyvą 2014/53/
ES. Visas ES atitikties deklaracijos tekstas prieinamas šiuo interneto adresu:
https://europe.yamaha.com/en/support/compliance/doc.html

HU EGYSZERŰSÍTETT EU-MEGFELELŐSÉGI NYILATKOZAT
Yamaha Corporation igazolja, hogy a [CLP-885, CLP-875, CLP-845, CLP-
835, CLP-895GP, CLP-865GP] típusú rádióberendezés megfelel a 2014/53/
EU irányelvnek. Az EU-megfelelőségi nyilatkozat teljes szövege elérhető a 
következő internetes címen:
https://europe.yamaha.com/en/support/compliance/doc.html

PL UPROSZCZONA DEKLARACJA ZGODNOŚCI UE
Yamaha Corporation niniejszym oświadcza, że typ urządzenia radiowego 
[CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] jest 
zgodny z dyrektywą 2014/53/UE. Pełny tekst deklaracji zgodności UE jest 
dostępny pod następującym adresem internetowym:
https://europe.yamaha.com/en/support/compliance/doc.html

RO DECLARAȚIA UE DE CONFORMITATE SIMPLIFICATĂ
Prin prezenta, Yamaha Corporation declară că tipul de echipamente radio 
[CLP-885, CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] este în 
conformitate cu Directiva 2014/53/UE. Textul integral al declarației UE de 
conformitate este disponibil la următoarea adresă internet:
https://europe.yamaha.com/en/support/compliance/doc.html

SK ZJEDNODUŠENÉ EÚ VYHLÁSENIE O ZHODE
Yamaha Corporation týmto vyhlasuje, že rádiové zariadenie typu [CLP-885, 
CLP-875, CLP-845, CLP-835, CLP-895GP, CLP-865GP] je v súlade so 
smernicou 2014/53/EÚ. Úplné EÚ vyhlásenie o zhode je k dispozícii na tejto 
internetovej adrese:
https://europe.yamaha.com/en/support/compliance/doc.html

SL POENOSTAVLJENA IZJAVA EU O SKLADNOSTI
Yamaha Corporation potrjuje, da je tip radijske opreme [CLP-885, CLP-875, 
CLP-845, CLP-835, CLP-895GP, CLP-865GP] skladen z Direktivo 2014/53/
EU. Celotno besedilo izjave EU o skladnosti je na voljo na naslednjem 
spletnem naslovu:
https://europe.yamaha.com/en/support/compliance/doc.html

FI YKSINKERTAISTETTU EU-VAATIMUSTENMUKAISUUSVAKUUTUS
Yamaha Corporation vakuuttaa, että radiolaitetyyppi [CLP-885, CLP-875, 
CLP-845, CLP-835, CLP-895GP, CLP-865GP] on direktiivin 2014/53/EU 
mukainen. EU-vaatimustenmukaisuusvakuutuksen täysimittainen teksti on 
saatavilla seuraavassa internetosoitteessa:
https://europe.yamaha.com/en/support/compliance/doc.html

TR BASİTLEŞTİRİLMİŞ AVRUPA BİRLİĞİ UYGUNLUK BİLDİRİMİ
İşbu belge ile, Yamaha Corporation, radyo cihaz tipinin [CLP-885, CLP-875, 
CLP-845, CLP-835, CLP-895GP, CLP-865GP], Direktif 2014/53/ AB'ye 
uygunluğunu beyan eder. AB uyumu beyanının tam metni aşağıdaki internet 
adresinden edinilebilir:
https://europe.yamaha.com/en/support/compliance/doc.html
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